MacDraw, the Mac's Electronic Drafting Set

MacDraw enables architects, engineers, and designers to create professional-looking graphics without the aid of pencils, rulers, or mechanical drafting tools.

Meet the Macintosh Game Wizards

The Imagewriter and Beyond

Chart and Multiplan Team Up

Enter the $22,000 Macworld Art Contes
The end is near!

For homeless printers. Dangling disk drives. Misplaced manuals. And runaway mice.

Because on November 19, we will introduce a Macintosh accessory unlike any other.

One that will organize you. Conserve precious desk space. And protect your valuable investment in hardware and software.

While making you wonder how you ever used a Macintosh without it.

It's the perfect Christmas gift for your favorite Mac owner.

Which might very well be you!

By the way, we've saved the best news for last: You can take one home for just $95*

After November 19th, that is.

Until then, we're keeping our newest accessory under wraps. But if you'd like to reserve a copy of our free brochure, just call:

1-800-547-3000, Dept. 201
(In Oregon or outside USA: Call 1-503-684-3000, Dept. 201)

Mac Station

* This is our suggested retail price. 2000 dealers nationwide set the actual selling price.

Macintosh and Mac are trademarks of Apple Computer, Inc.
Tecmar Sweetens Macintosh® with Hard Disk Power

Mac Drive™

Tecmar’s Mac Drive gives you a 10 megabyte fixed hard disk or a 5 megabyte removable hard disk. You can add a 5 megabyte removable hard disk to either of the above.

With Tecmar’s Mac Drive . . .

• Your Macintosh runs much faster than with the built-in floppy.
• Mac Drive will provide up to 38 times more storage than floppies.
• You can minimize the use of floppies.
• You can access files and save time by loading programs from Mac Drive.
• You can take your removable Mac Drive cartridge with you for added security.

Tecmar Inc. 6225 Cochran Road  Solon (Cleveland), Ohio 44139-3377  Phone:(216)349-0600  Telex: 466692

Circle 14 on reader service card
Getting Started

32 The Mac's Special Keys
Daniel Farber
A look at the keyboard options that help you perform unusual operations and bypass the mouse for choosing commands.

42 Get Info
Lon Poole
Macworld's tutor answers questions from readers about the Mac.

Review

50 The Electronic Drafting Set
Danny Goodman
A thorough examination of MacDraw, the new program that adapts the Mac's graphics capabilities to structured drawing.

60 Three Faces of the Mac
Bill Grout
Three new products compete for the right to handle your business information and communications.

68 Macware News
Edited by Erfert Nielsen
Announcements of the latest developments in Macintosh software, hardware, and accessories.

State of the Art

76 The Imagewriter and Beyond
Edited by Daniel Farber and Adrian Mello
An interview with Owen Densmore, who helped design the Mac's first printer and is working on the further evolution of Mac printing.

What does this Yanhara Teiga Kogane have to do with the Mac? Find out in "Macworld View" on page 24.
Hands On

88 Making a Case with Multiplan and Chart
Steve Lambert
Spreadsheet and charting programs team up to prevent a costly court battle.

101 The Mouse Will Play
Mitchell Waite
Presenting an action game, created on the Mac in Microsoft BASIC, that you can type in and play yourself.

106 Panda Kong Agonistes
Mick Wiggins
A legendary monster rises from the MacPaint palette; here's how to bring him into your world.

114 Open Window
Edited by Daniel Farber
An exchange of Macintosh discoveries.

Columns

9 The Key to Great Mac Software
David Bunnell

14 Note Pad
Michael McGrath
Getting Down to Business

17 Letters

24 Macworld View
Edited by Janet McCandless
News and notes for the Macintosh community.

Index

136 Advertisers Index

Photo/illustration credits
David Bishop, 60-61; Ed Kasbi, cover (inset), 34, 42, 76-77, 121-127; George Steinmetz, 9, 14; Fred Stimson, 26, 32-33, 88-89; Mick Wiggins, 24-25, 27, 107.

Take a tour of games being prepared for the Mac and see this "Mage" character from Wizardry (above) and his clever creators, Andrew Greenberg and Robert Woodhead (below), in "The Wizards Behind the Screen" on page 120.
Circle 55 on reader service card

MACWORLD

Editorial
Editor-in-Chief: Andrew Fluegelman
Editor: Kerneyn Riemann
Associate Editors: Daniel Farber
Assistant Editor: Adrian Nello
Editorial Manager: Janet McCandless
Editorial Assistant: Erlent Niobson
Copy Editor: Jeffrey Bartlett
Contributing Editors: Lon Peale
Jeffrey N. Young

Art & Production
Associate Publisher: Jacqueline Poitier
Designer: Marjorie Spiegelman
Art Director: Bruce Charni
Senior Production Manager: Frances Mann
Production Manager: Lee R. Trevis
Editorial Production Manager: Ellyn Hamnet
Associate Designers: Dennis McLeod, Monica Therese
Design Associates: Tarcy Blake, Molly Windsor-McLeod, Donna Sharee
Advertising Traffic: Claire Bouey

Publishing & Sales
Publisher: David Bunnell
Ad Director: Rod Conklin
National Sales Manager: Penny Rhyd
Executive Account Manager: Vincent Ivey

Circulation
Associate Publisher: Cheryll Woodard
Director Single Copy Sales: George Clark
Promotions Manager: Carma Windham-Hayes
Single Copy Sales Manager: Bill Cox
Dealer Sales Manager: Mary Ruth Kristoff

Communications
Manager: Noreen A. Browning

Special Projects
Director: Susan Keller

Administration
Director: James McGinnis

Corporate
PC World Communications, Inc.
David Bunnell Chairman
Bartlett R. Rhoades President
Andrew Fluegelman Vice President
Jacqueline Poitier Vice President
Cheryll Woodard Vice President

Volume 1, Number 6
September/October, 1984
Macworld® (ISSN 0741-8647) is published 6 times a year: February, May/June, July/August, September/ October, November, and December by PC World Communications, Inc., 555 De Haro St., San Francisco, CA 94107. Effective November 1984 Macworld will be published monthly. Subscription rates for the U.S. and Canada are $50 for 24 issues, and $70 for 36 issues. Canadian orders must be paid in U.S. funds.


Printed in the United States of America
©1984 PC World Communications, Inc.
How can you get your Macintosh™ to print with a daisywheel, letter quality printer?

By using the new Mac· Daisywheel· Connection™!

From the team who wrote MacWrite™ comes a powerful application program that allows you to print your text with any popular daisywheel, letter quality printer. The new Mac Daisywheel Connection comes with the interface cable you'll need, the software program and a quick start-up guide. The application program is straightforward and maintains the visual fidelity of your file even when you mix text and graphics. The Mac Daisywheel Connection supports MacWrite and Multiplan™ and other Macintosh software products. The Mac Daisywheel Connection is as easy to use as your Macintosh mouse. Just point and print!

The MAC· DAISYWHEEL· CONNECTION is now available through your local Apple Computer Dealer. List price $99.

Or call toll-free: 1-800-MAC-5464
In California, toll-free: 1-800-421-0243
In Canada, direct-dial: 619-243-7993

Other quality products available from Assimilation Process:
• Ten-Pack of blank 3½" diskettes for your Macintosh $55.
• 3½" diskette hanging file holder $6.50.
Apple's new baby has

It's called Macintosh. And it has a lot of our personality. We're called Microsoft. And our part of Macintosh is five new programs that are bright, intuitive, outgoing, understanding and born to perform.

Our pride, your joy.

Taking advantage of Macintosh's mouse and rich graphics, we've designed software that works like you, even thinks like you.

All our programs share the same plain English commands. So what once took days to learn, now takes hours or minutes to learn with Macintosh.

Meet the family.

Our financial whiz is MULTIPLAN, an electronic spreadsheet that actually remembers how you work. Even offers suggestions on spreadsheet set-up.

When it comes to writing, nothing will travel faster than
our best features.

our WORD, available this Fall. Using the mouse, it will let you select commands faster than you can say "cheese."

Our most artistic child will be CHART. Available late this Summer.

It gives you 42 presentation-quality chart and graphic styles to choose from.

Later this year, we'll offer our most manageable child, FILE, an advanced personal record management program.

And BASIC, the language spoken by nine out of ten microcomputers worldwide, is the granddaddy of them all.

Now enhanced to take full advantage of the Macintosh mouse, windows and graphics.

So call 800-426-9400 (in Washington State, Alaska and Hawaii call 206-828-8088) for the name of your nearest Microsoft dealer.
Make Your Macintosh the Master of Ceremonies

TRIVIA FOR THE MACINTOSH™
Entertainment Software from Mirage Concepts

Over 5000 TRIVIA questions and answers are packed into this dynamic new application of the world’s most popular parlor game. With TRIVIA by Mirage Concepts, your Macintosh becomes quiz master, score keeper and final authority...the perfect master of ceremonies for your next party.

Available Now...at Apple Dealers and Software Stores Nationwide for Just $49.95

PROGRAM HIGHLIGHTS
• Over 5,000 Questions and Answers
• 5 Categories — 3 Difficulty Levels
• Special “Genius” Section
• Variable Length Game
• Use of Macintosh “Mouse” for Ease of Operation
• Screen Clock to Time Answers
• Store Incomplete Games for Future Play

For Information
(800) 641-1441
In California, Call:
(800) 641-1442

A Product of Mirage Concepts, Inc.
4055 W. Shaw, #108 • Fresno, CA 93711 • Ph. (209) 227-8369

TM: Macintosh is a trademark of Apple Computer, Inc.
Circle 70 on reader service card
The wave of software that will establish the Macintosh as the next personal computer standard is building up on the horizon. The element of suspense depends not on when it arrives but on the force and content of this concentrated introduction of application programs. A significant number of programmers and software publishers is preparing software for the Mac, but a common complaint is that it is more complicated to write software for the Mac than for first-generation personal computers such as the Apple II, CP/M machines, and IBM standard personal computers.

While much of the problem lies in the technical aspects of dealing with the 68000 microprocessor's idiosyncracies, the Macintosh ROM, and the lack of development software (such as a C compiler), the Mac's new kind of user interface poses a creative problem as well. Its icons, pull-down menus, windows, and mouse represent a departure from the way most computers interact with people. When the IBM PC was introduced, much of the CP/M-based software could easily be transported to run on the PC. With the Mac interface, recording existing software is not so straightforward.

Obviously, the technical problems are not insignificant, but the real challenge facing software authors is the deeper understanding of the software audience that the Mac demands from programmers. Just as the Mac brings out the artist in people who use it, the computer requires people who program it to be artists first, and technical wizards second.

I recently read a book which should become the bible of Macintosh software authors. Disregarding bits and bytes, The Elements of Friendly Software Design makes many wonderful suggestions about how to transfer the techniques of established communication arts, such as film and writing, to the new communication art of software design. The book's author is Paul Heckel, who first became famous for developing the handheld Craig Language Translator. It is the first computing book I've ever read nonstop from cover to cover.

The main reason I endorse The Elements of Friendly Software Design so enthusiastically is that it's one of the few books I've read on any topic that actually delivers what it promises: in this case, the secrets of writing successful software. "Writing easy-to-use software is a communication craft," Heckel says. "The successful software developer will learn the techniques and thought processes of writers, filmmakers, salesmen, teachers,
David Bunnell

journalists, and other professional communicators. He will change from practicing an engineering craft to practicing an artistic one. . . . The general reader need not be afraid that this book is too technical for him. Indeed, he has a distinct advantage over computer experts. He has less to unlearn.

In his first chapter, Heckel identifies the problem facing most personal computer software authors. Although they are experts at communicating with computers, this is an "ability substantially different from communicating with people." He then turns his attention to filmmaking, which he sees as the most appropriate communication art for software authors to learn from, because it began as an engineering discipline and gradually converted to an artistic one.

Heckel points out that Thomas Edison, who virtually controlled filmmaking in its early days, "stubbornly fought" people like Edwin S. Porter, who wanted to make narrative films. As engineers lost control, movies flourished. Porter finally got his way in 1903 when he created The Great Train Robbery, the first film to tell a complete story. In Birth of a Nation (1914), the pioneer D. W. Griffith became the first to use many of the basic techniques of filmmaking as we know it today—techniques such as the close-up, the moving shot, the fade, the cutaway, and the dissolve.

Heckel goes on to compare this filmmaking evolution to the processes used in VisiCalc, the first breakthrough software program. By creating a program in which the results of an action are instantly flashed on the screen, Dan Bricklin and Bob Frankston will someday be seen as the D. W. Griffiths of software.

Instant recalculation isn't the only virtue of VisiCalc, just as filmmaking isn't the only communication art from which to develop a programming style. VisiCalc's visual effects indicate that its manufacturer Software Arts was aware that good salespeople and writers constantly use a variety of visual communicators such as photographs, drawings, and charts. Faced with visual communication that describes rather than judges, people become less defensive and gain a greater sense of control. People don't want to be penalized for making mistakes, and they don't want to feel helpless. Software is the key to giving power to the people—not to the computer.

The Mac gives software authors a tool for creating programs that are not only much more visual than those of the past but also much more interactive. Paul Heckel's book is "must" reading for Mac software authors, particularly those who aspire to write "the next VisiCalc." For my money, it is probably more beneficial than attending Apple Computer's MacCollege—though it wouldn't hurt to do both. As Heckel reports, it was Albert Einstein who said, "Imagination is more important than knowledge."
A Springboard For Your Imagination...

Practical...inventive...and loads of fun...MacWork/MacPlay is a gallery of ideas for home and business use on your Apple Macintosh. Lon Poole, author of the best-selling Apple II User's Guide and a leading authority on Apple technology, provides you with an inspired assortment of applications for today's popular Mac software: MacWrite, MacPaint and Microsoft Multiplan.

MacWork/MacPlay gives flight to your imagination with this collection of over 20 original ideas. Included are projects for your 9 to 5 day: sales commission schedule, travel and entertainment ledger, report writing and net worth statement. Plus more for after 5: greeting card and letterhead design, landscaping diagram and mortgage prepayment plan.

MacWork/MacPlay...serious fun and amusing labor! $18.95 at book and computer stores everywhere.

Microsoft Press
10700 Northup Way
Bellevue, Washington 98004
The reviews are in and everyone agrees. There’s never been a personal computer that’s easier or more fun to use than the Macintosh. Especially with terrific programs like MacWrite™ and MacPaint™ to get you started.

But if you really want to take full advantage of your Mac’s tremendous abilities, you’ll need to go a step further than just writing letters and painting pictures. You’ll need some serious business tools to make you more productive.

And the first one to purchase is Habadex.

Desktop management has arrived.

Habadex is pioneering an entirely new category in computer software—desktop management. It’s the only program that lets you do on your Mac what you now do on your desk. So you can put your address and phone directory, appointment calendar, things-to-do list—and any other paperwork that clutters your desk and your mind—right into your Mac.

And because Habadex was designed specifically for the Macintosh, it incorporates all of the same graphic capabilities that have made Apple’s new computer so incredible. And incomparable.

A data base based on your own needs.

Habadex lets you create and sort hundreds of records. You can arrange the large number of fields however you choose. By first name, last name, company, category, zip code, etc. You can even rename fields, and rearrange or change information easily for complete flexibility.

You’ve found your calling.

Habadex lets you create and arrange an entire phone directory within your data base. It dials direct and long-distance calls, automatically inserting your O.C.C. like Sprint or MCI. It has a quick-dial feature for storing commonly-called personal or emergency numbers. And it works with the inexpensive HabaDialer or your current modem.
OK Mac.
down to business.

It gets you through the day. Every day.
Habadex is also one of the most complete calendars you’ll ever need. It provides monthly overviews and day-at-a-glance scheduling, through December 1985. Lets you keep track of all your appointments and automatically updates them throughout each day. Even leaves room for valuable travel and expense information.

It also features a things-to-do list which is automatically updated when you check items off. Plus complete area code and zip code directories with ranges for all cities in the United States and Canada.

Print it your way.
Habadex also prints mailing labels and custom lists in any format and size of your choosing. It mail merges form letter text with your data base and prints them for any or all of your records—in virtually any order, arrangement or quantity. And in your choice of fonts.

Are you ready to get more from your Mac than just words and pictures? Then you’re ready for Habadex. It’s the serious business tool that still lets you have some serious fun.
Getting Down to Business

Concerning the Mac's entry into the business community

More people than ever before are asking me about computers. As soon as a new acquaintance finds out that my job involves personal computers, our conversation turns to the merits of various combinations of software and hardware. In the past, I didn't really endorse any of my suggestions. Although my advice flowed freely and caused intelligent people to part with thousands of hard-earned dollars, I never imagined spending my own money on a computer. Deep down, I despised the machines. I resented having to read volumes of obscure techno-babble and memorize arcane keystroke combinations.

That was before the Macintosh. As soon as I saw the new marvel, I knew it was for me. Here was a computer that could inspire me to spend several thousand dollars on a piece of machinery.

The Mac also had a profound impact on the kind of advice I gave. In fact, my enthusiasm for the Mac was so great that I spoke of little else. I became blind to many practical considerations. When someone pressed me about the availability of software or more memory, I just assured them that it would be well worth the wait, and I was sure that there would be plenty of software by this summer.

Then one day I got a phone call from my father. Dad was stuck with his Apple III and hoping I could lead him to the promised land of user-friendliness. Finally, after all this time of giving advice I had to get serious. Here was the guy who knew the answer to every question I'd ever asked him, and now he was soliciting my advice. It was as if one of my English professors had asked me what book to read. I suppose I had finally arrived—my father was looking up to me and my "computer literacy."

Dad has always been a corporate man. Blue suits and IBM are as natural to him as black coffee and the Wall Street Journal. He bought his Apple III in the pre-IBM PC days and has probably regretted it ever since. His friends talk about PC-DOS and the XT. They give him blank stares when he mentions SOS.

Despite his regrets, he has a lot of respect for Apple Computer. He didn't quite get the gist of the "1984" TV ad, but he still thinks they know their stuff, digitally speaking. That's why I wasn't surprised when he asked, "What about this new Macintosh, Michael? You seem to talk about nothing else these days. Should I buy one?"

"Well, Dad, what are you going to do with it?" I asked.

"Oh, you know," he responded, "the usual. I want a data base manager for my customer records and a spreadsheet for my budgets. A decent word processor and some sort of graphics program for sales presentations. Your brother wants to play games, and who knows, I might even buy several Macs to network together and share a letter quality printer. Now that I think of it, I'm really going to..."
teach myself to program this year, maybe in Pascal. And don't forget, I need a hard disk and I'll probably be running 1-2-3."

I didn't want to ask the next question, but I had to. "When do you want to start using this new machine?"

"In a week or two," he replied.

I began to sift through his requirements for the new system. Obviously, this was a job for a mature computer that has proven itself in the marketplace and has had time for third-party software and hardware options to be developed. As much as I wanted to put dear old Dad on the cutting edge of technology, I just couldn't recommend the Mac. Not if he wanted all this computing power next week.

I tried to explain that the Mac is in an embryonic stage and that you pay the price for advanced technology by waiting for the rest of the world to catch up. Unfortunately, this consideration does not mesh very well with the realities of the business world. Business people need tools that they can put to work immediately. An aficionado like me can wait for the tools, while remaining perfectly content to play and discover new ground.

My analysis left my father pondering new questions about the computer business. "How do they expect to sell a computer that lacks the software and peripherals that businessmen like me need? Can't they just write the programs, put them in the box, and sell them?"

"Of course not," I said. "Programming is one of the most complex jobs in the world. It makes the New York Times crossword puzzle look like child's play. MacPaint took years of testing, revising, more testing, and refining. Finally, after those thousands of hours and hundreds of days, Bill Atkinson achieved a very artful elegance. Now you and I can just boot up and start to draw. You don't realize what a major effort it takes to make an application program seem to be no big deal for us."

I think Dad grasped this fact, but it led to more questions. "How can you get so excited about a computer that I can't even use? You've never been particularly patient, so why are you so willing to wait for Macintosh software?"

"Well," I answered, "when you've waited for the best computer on the market, it just makes sense to wait for the best software."

The fact of the matter is that quality, not to mention greatness, is not created overnight. It's that way with just about everything—fine furniture, great literature, classic cars—you name it. Unfortunately, most business people can't afford to wait. But the lucky ones who do will be richly rewarded.

As software companies race to release Mac software, I'm sure that some will rush their products to market, just as many publishers try to capitalize on trends by rushing books to the bookstores. Some of these products will be good, and some will have bugs that drive you nuts. And a very few will be great. The great ones will have been tested thoroughly, revised and refined before being presented to the public. It is a time-consuming process, but it usually pays off in the long run.

Frederick Brooks makes an analogy between programming projects and cooking in his book Mythical Man Month (Addison-Wesley, Reading, MA, 1975). He says, "An omelet, promised in two minutes, may appear to be progressing nicely. But when it has not set in two minutes, the customer has two choices—wait or eat it raw. Software customers have had the same choices." My advice is to wait patiently, and keep the egg off your face.

Michael McGrath is the Editor of The Macintosh Library from Hayden Publishing Company.
You've bought a Macintosh, what do you buy next? **Maccessories!**

<table>
<thead>
<tr>
<th>Maccessories</th>
<th>Description</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swivel</td>
<td>A slim lazy susan that attaches underneath your Macintosh. It goes everywhere your Macintosh goes, even inside the carrying case.</td>
<td>$35</td>
</tr>
<tr>
<td>Surge Suppressor</td>
<td>Replacement power cord for the Macintosh and Lisa with powerful UL Listed surge suppression and noise filtering built in. It's light, compact and fits into the Macintosh carrying case.</td>
<td>$49.95</td>
</tr>
<tr>
<td>Portable Modem</td>
<td>For Macintosh and Apple IIc. Supplied with interface cables for both. The perfect travel modem; small, battery powered, weighs less than 1 lb, even has its own carrying case. Operates at 300 bps with any communications software.</td>
<td>$140</td>
</tr>
<tr>
<td>Disk Case</td>
<td>Provides safe storage for 36 Macintosh disks. Contains a packet of spare disk labels.</td>
<td>$30</td>
</tr>
<tr>
<td>Dust Cover</td>
<td>An anti-static cover to protect your Macintosh and keyboard from the elements.</td>
<td>$13.75</td>
</tr>
<tr>
<td>Control Center</td>
<td>Styled to fit underneath the external Macintosh disk drive. Provides fingertip control over the whole system. There's a Master switch to power the whole system on and off, and separate switches for a Printer, Modem and one Auxiliary device. Also protects entire system from power surges, line noise, and static.</td>
<td></td>
</tr>
<tr>
<td>Printer Buffer</td>
<td>Operates as both a printer buffer and an A-B-C switch. Available in configurations from 64K to 256K RAM. Users can choose between several outputs (2 serial, 1 parallel) and also have the choice of sending data through without buffering.</td>
<td></td>
</tr>
<tr>
<td>Printer Stand</td>
<td>Perfect for the Imagewriter printer. The Maccessories Printer Stand is Precision engineered and sturdy when assembled. It's also the first printer stand that travels. It knocks down and fits into a very small box.</td>
<td></td>
</tr>
</tbody>
</table>

Available at Apple dealers everywhere.
Set up your own forms (or customize provided forms) and then input information only once. Here is just one example: Enter an order, and generate an invoice, adjust inventory, update customer records, and keep track of receivables. Everything you enter can be easily modified, redefined, and interrelated. There are no barriers placed between you and the way you want to do things.
Odesta Helix is an interactive information management system designed to take special advantage of the Macintosh windows, icons, pull-down windows and mouse. The program makes possible a flexible, “give and take” interaction with the Macintosh for information and knowledge-based activities such as free-form data base management, text processing, statistical analysis, and a wide range of form-based input, query and reporting.

Odesta Helix is a disk-based system, and will take advantage of double-sided drives, external drives and hard disks that conform to the Apple standard.

Odesta Helix will also take advantage of the additional memory of a 512K Macintosh or a 1M Lisa (Under MacWorks).

Retail price: $395.00

Additional resource models under preparation include: Accounting, Statistics, Archival Storage and Retrieval, and Data Capture.

Odesta Helix is available at your local Apple or Apple software dealer. Discussion regarding OEM, VAR, and single-site licensing arrangements may be initiated by contacting Odesta at:

Odesta, 3186 Doolittle Drive, Northbrook, IL 60062 (USA)
(800) 323-5423 In Illinois, (312) 498-5615
Apple, Lisa, and Macintosh are trademarks of Apple Computer, Inc.

© 1984 ODESTA

Circle 13 on reader service card
With Odesta Helix, you can now manage information according to your own requirements, your own style, and your own imagination. Begin using Odesta Helix immediately, without having to set "field parameters" or learn a programming language. You can type in a free-form report or complicated calculations within your own easily created forms. You can even use pictures from MacPaint to illustrate your inventory or teach language skills. Odesta Helix is a new program, not an old program made to work on a new machine. With Odesta Helix, you experience the real power and flexibility of windows, pull-down menus, icons, and mouse interaction because it takes a new approach to information and knowledge formation.

Odesta Helix comes with many pre-made forms, so that you can get started finding your own way, right away. In addition to time management and organization forms, you also get forms for name, address, phone number and important date lists, as well as many more. For instance, after you customize the book, record, tape and disk cataloging forms for your own use, you will be ready to put together your own powerful applications—without having to earn a purple heart learning rules, restrictions and commands.
Odesta Helix & Macintosh
A Personal Decision Support System

Tiles act as arithmetic, text, Boolean and date operators, functions and values.

Visual building blocks let you set up even the most complicated statement or calculation and use it whenever you want. You “flow” the information from one block into another – just by pointing. Each “diagram” shrinks down to become an abacus icon (see “Number Format” screen shot). Move its icon within and between forms, or embed it in another “tile”. The magic of the tiles and arrows has to be seen to be believed – ask your dealer for a demonstration.

Odesta Helix automatically creates icons to represent every piece of your information. Make them appear if you wish, and rearrange them within or between forms. Define and restrict them if you wish, for data checking and security. But most of the time, just let them stay hidden “behind” the form.

No special commands to learn in order to search through your “ocean” of information. Simply ask a question by pointing to a spot on a form, or by filling in spaces with your own questions – Odesta Helix will search and sort at the click of a mouse. Example: “Find all books published before 1940, that are first editions costing more than $13.00, and that are about World War I and are illustrated.” Imagine the possibilities.
Odesta Helix & Macintosh
An Individualized Knowledge Base

The form palette – a way to “paint” forms that can respond to the shape of your thoughts.

Draw a rectangle with:
Double lines, that will expand, accordion style, to make room for even your longest entry. Surround any area with a limit rectangle to keep it from growing beyond a certain point. Single lines don’t grow. Dashed lines don’t show.

Odesta Helix dynamically keeps track of what is in the window, and keeps you from making a mistake. You can’t overlap rectangles, or put things in impossible places – the box just zooms back to where it came from. Then if you ask “Why?” Odesta Helix will give you the reason.

Each rectangle can hold its own font and style, so that each type of information can communicate its own personality and impact.

Once you have the form put together, choose “Lock”, and the form is ready to use. Of course, if you want to re-design or edit the form, you can always do so.

No complicated “data definition language” in Odesta Helix. Just open the icon for any piece of information, and click it into the format you want. You can set up text, numbers, dates and even flags to appear in different ways in different forms. And you can always go back and change things later if you feel like it – Odesta Helix will automatically give you an example of how it will look.

This is an abacus icon. You open it to define a calculation, and then use it as many times as you want within your forms (or other calculations). Make them up (no limit), save them, and drag them around to really make things happen.

This is a form icon. It automatically identifies a form that is already made up (including a “free-form” like a document or letter). There are no limits to the number of forms that you can use, or on the number of form icons that can relate to a set of information.

With this kind of graphic form construction, you are able to quickly put together a powerful, interactive way to manipulate information. At the same time, Odesta Helix has the “intelligence” to give you the kind of room you want, when you want it, and to keep track of everything for later searching, calculating, and reporting.
An Interactive Information Management System.

For Individuals With A Need To Know.
Letters

Upgrade Rumors
I find Macworld both enlightening and enjoyable. I hope you can shed some light on an issue that I am sure concerns many Macintosh owners. Rumors are circulating that Apple Computer will soon upgrade the Mac's RAM from its present 128K to 512K and replace the single-sided 400K disk drive with an 800K double-sided one. The obvious question are: How long is "soon"? Will these enhancements increase the price of the system? Will people who purchase a Mac now be able to upgrade both memory and the disk drive; if so, at what cost? Or is it better to wait until the Mac is sold that way?

Robert Reimann
Berkeley, California

A number of anxious readers have inquired about the same questions. We also are interested in upgrades for the Mac [see David Bunnell's column, July/August]. Barbara Koalkin, Apple 32 product marketing manager, says, "We're collecting 256K chips as fast as we can, and we're still on schedule to upgrade the Mac's RAM for early 1985." Apple plans to sell both 128K and 512K Macs. Owners who want to upgrade from 128K can do so through their dealers. Prices have not been set for the 512K Mac or for upgrading the 128K version.

John Rizzo, the Mac's product manager, reports, "We have no plans at present for double-sided drives because the technology isn't yet able to produce quantities sufficient to meet anticipated customer demand."—Ed.

Torn Between Two Loves
Thanks for Charles Spezzano's piece ("Note Pad," May/June)—as another IBM PC lover who has complex emotional and financial ties with his PC, I felt like a traitor when I decided to give in to my feelings (which are apparently those of many people) on first seeing and using a Mac.

I often introduce people to computers. Usually they say, "That's great"; with the Mac, they say, "Great—let me try that." Observers of the Mac are rarely passive. They can quickly see how to do things and want to take a hand in doing them.

Eventually a Mac owner comes back to earth. It takes a long time to read and write all the 'friendly' graphics to and from disks. And the limited disk space with one drive is frustrating. For everything the Mac does that the PC doesn't, there is an equal trade-off. The important question finally is what you do with either of them.

Richard Wanderman
Eugene, Oregon

Typing Error
You quoted Apple representative Alain Rossman ("The International Macintosh," May/June) as saying that using the Mac keyboard "will be the first time that Japanese people type." Although this statement is good PR for Apple, it isn't true. The Japanese have been typing for years and even developed early versions of a mouse like the Mac uses.

However, handwriting remains the standard for most communications because typing in Japanese isn't easy. The Japanese typewriter chooses from over 2000 characters using a pre-electronic age "mouse." The typist positions the mouse on the correct character with one hand and types it with the other. Few people could type 50 words per minute with this arrangement.

Several major Japanese electronics manufacturers make word processors ("wah puro" in Japanese) capable of making sophisticated editorial choices. From a phonetic input (Japanese needs only 50 basic syllables to represent any word in the language), the software examines the context and chooses the most likely character for the pronunciation and linguistic situation. The screen also displays other possible characters that have the same pronunciation so the user can select another in case the most likely character is not the correct one.

Howard Stern
Cambridge, Massachusetts

Both Alain Rossman, international product manager for the Mac, and Macworld regret the exaggerations of Japanese typewriting capabilities and Apple's role in Japanese computing that appeared in our article. Rossman wishes to assure people that the Mac team is not nearly so naive as the mistaken statements make it seem. Apple is well aware of the state of word processing in Japan and is working closely with Japanese technicians and programmers in its California headquarters and through its subsidiary, Apple Computer Japan Inc. See "Macworld View" in this issue for further information about Japanese Apples.—Ed.
**Letters**

**French Connection**
I am a vice-president of a para-governmental agency that promotes industrial research. To help in our work, the agency ordered three Macintoshes in March; to date, only one has been received. I was surprised to read in your magazine ["The International Macintosh," May/June] that a French-language keyboard and software seem to be so easy to get in France. Here in Quebec, we are still waiting; our dealer says the French versions are not available.

As you know, the official language of Quebec is French. We also use the metric measure for form letters. We are so much closer to California than France is. Why are we unable to get the French keyboard?

Robert P. Morin  
Agence Quebecoise de Valorisation Industrielle  
Montreal, Quebec

According to Joanna Hoffman, international market manager for the Mac, the French Canadian "QWERTY" keyboard will be available this fall. Its layout differs from the "AZERTY" Mac keyboard sold in France.—Ed.

**Hype Gripe**
David Bunnell ["The Making of a Personal Computer Milestone," July/August] expresses the opinion of readers like me who are less impressed by the marketing achievements of companies like Apple and IBM than we are interested in the development of software products that make our computers more useful. The fact is that most of us are tired of the fanfare and self-congratulation with which the industry bombards us. Companies seem to expect consumers to assist them in endless product promotions by believing that we receive more than a computer when we spend thousands of dollars; we also participate in the "computing phenomenon."

One of the lessons of the Mac, its publicists say, is that computers can and should be oriented toward people and not the other way around. We are told that the Mac is a kind of computing messiah that will end an age in which the common folk have been deprived of the advantages personal computing brings. Supposedly, in the pre-Mac period, an elite group jealously guarded its privileges by making it necessary to learn arcane computer skills. Of course, it's a good idea to open up access to technology, but let's not pretend that selling computers is more important than using them. I don't look forward to the time when personal computers will be marketed like cars and consumers urged to buy a new one every year.

Roy Burns  
Rutherford, New Jersey

**Apple the Innovator**
The Macintosh is the first personal computer in recent years to excite me about my career in computers. Apple should be commended for its innovative concepts and not criticized for breaking away from the large programming base that drives so many companies. Many products are touted largely for their compatibility with an existing customer base. Although this is not necessarily bad, it stifles innovation. It is boring to see the same computers introduced over and over, differing sometimes only in the nameplate. Thanks, Apple, for the breath of fresh air.

Larry Elkembery  
Beaverton, Oregon

**MacWrite Flunks Test**
I like the Mac's looks and I've seen some students use it effectively for papers and other assignments. But I don't plan to buy one now because it doesn't adequately perform the function I need: extensive word processing. I am writing a Ph.D. dissertation that ultimately will be between 200 and 300 pages long. MacWrite's dinky storage capacity (which is only somewhat increased by making workdisks) is simply no match for a document of this length. I have neither the time nor the patience to open and format a new file every 7 to 10 pages, not to mention the inconvenience of moving to a new disk every 80 pages or so. I won't waste time paying attention to the computer's needs, when it should be meeting mine. As a programmer friend said to me, "Computers help you do work, but sometimes they make more work for you to do."

Bruce F. Lucas  
Palo Alto, California

It's true that MacWrite is not suited to long documents; the program wasn't designed to be. Perhaps you should look into Microsoft Word [see "The Word from Microsoft," July/August].—Ed.

**Dying for Color**
I know I'm not the only Macintosh artist who is dying to have multiple-color capability. MacPaint is a whiz of a program, but its high resolution and fine patterns aren't shown off well enough in only black and white. I've read explanations for why there is no color on the Mac (too expensive), but they still don't alleviate the need for color.

Sheila Floyd  
Cleveland, Ohio

**Artist's Shopping List**
As a graphic artist, I've put together a list of enhancements I'd like to see for the Mac. First of all, I'd like to have an alternative mouse that is shaped more like a pencil and allows a more natural drawing motion. I could really use a digitizer too (preferably priced under $2000), in order to transfer a preexisting image directly into the Mac, without having to redraw the image. Next, how about larger patterns? MacPaint's patterns currently are all 8 dots by 8 dots; if they were 16 by 16 dots or 32 by 32 dots, more complex patterns that don't repeat themselves so often could be developed.

It would certainly be helpful to have software that enables you to rotate a drawing in increments other than 90 degrees (to which MacPaint is restricted). Finally, I'll bet artists would benefit from the ability to create custom MacPaint brush shapes to put into the brush menu. I know these are ideal wishes, but I thought I'd let you know what one artist is dreaming about as he works on his Mac—which, by the way, is a terrific drawing tool as it is now.

Curtis Phegley  
Little Rock, Arkansas

Letters should be mailed to Letters, Macworld, 555 De Haro St., San Francisco, CA 94107, or sent electronically to ComputerServe 74055,415 or Source STE908.
Imagine.

Mac products you've been dreaming of, at prices you'd never dream of.

On your Mac, get set, go!
A lot of manufacturers are working hard to create exciting enhancements for the Mac. And we've been talking with them from the beginning—to make sure that you get their products as soon as they're available, at the lowest prices possible.

What follows here is just a sampling of what we have.

1-800/Mac & Lisa

More products are arriving daily. So call us for the latest information.

Some very friendly Macaddicts are waiting to answer your questions, and take your orders.

SOFTWARE

<table>
<thead>
<tr>
<th>Software</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Living Videotext</td>
<td>$97</td>
</tr>
<tr>
<td>ThinkTank</td>
<td>$97</td>
</tr>
<tr>
<td>Microsoft</td>
<td>$129</td>
</tr>
<tr>
<td>Microsoft Basic</td>
<td>$99</td>
</tr>
<tr>
<td>Megahaus</td>
<td>$86</td>
</tr>
<tr>
<td>Megamerge (Mailmerge for MacWrite)</td>
<td>$35</td>
</tr>
<tr>
<td>T/Maker</td>
<td>$35</td>
</tr>
<tr>
<td>ClickArt</td>
<td>$35</td>
</tr>
</tbody>
</table>

GAMES

<table>
<thead>
<tr>
<th>Game</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Chip</td>
<td>$35</td>
</tr>
<tr>
<td>Millionaire</td>
<td>$39</td>
</tr>
<tr>
<td>Infocom (Difficulty levels shown in italics)</td>
<td>$27</td>
</tr>
<tr>
<td>Zork I (standard)</td>
<td>$35</td>
</tr>
<tr>
<td>Zork II (advanced)</td>
<td>$27</td>
</tr>
<tr>
<td>Zork III (advanced)</td>
<td>$27</td>
</tr>
<tr>
<td>Witness (standard)</td>
<td>$27</td>
</tr>
<tr>
<td>Deadline (expert)</td>
<td>$39</td>
</tr>
<tr>
<td>Infidel (advanced)</td>
<td>$35</td>
</tr>
<tr>
<td>Planetfall (standard)</td>
<td>$27</td>
</tr>
<tr>
<td>Penguin Transylvania</td>
<td>$24</td>
</tr>
<tr>
<td>Sienna On Line</td>
<td>$27</td>
</tr>
<tr>
<td>Frogger</td>
<td>$27</td>
</tr>
</tbody>
</table>

HARDWARE

<table>
<thead>
<tr>
<th>Device</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronic Protection Devices</td>
<td>$39</td>
</tr>
<tr>
<td>The Lemon</td>
<td>$39</td>
</tr>
<tr>
<td>The Lime</td>
<td>$59</td>
</tr>
<tr>
<td>The Peach</td>
<td>$64</td>
</tr>
<tr>
<td>The Orange</td>
<td>$94</td>
</tr>
</tbody>
</table>

Kensington Kensington
S'wivel | $23 |
Surge Suppressor | $39 |
Dust Cover | $10 |
Starter Pack (all three items above) | $54 |
Disk Case (holds 36 Mac disks) | $23 |
Innovative Flip & File 40 (holds 40 Mac disks) | $23 |
ARTSCI MAGICphone | call |

MISCELLANEOUS

MAXELL 3½" Micro Floppy | $35 |
MEMOREX 3½” Micro Floppy | $39 |

OUR POLICY: We accept VISA and MASTERCARD. No surcharge added for cards. Your card is not charged until we ship. If we must ship a partial order, we never charge freight on the shipment(s) that complete the order. No sales tax. All shipments insured: no additional charge. Allow 1 week for personal & company checks to clear. COD max. $500. Cash or certified check. 120 day guarantee on all products. To order, call us anytime Monday thru Saturday 9:00 to 5:30. You can call our business offices at 603/446-7711.

SHIPPING: Continental US: For monitors, printers, and drives, add 3% to all orders. For all other items, add $2 per order for UPS surface, $3 per order for UPS 2nd-Day-Air. We particularly recommend 2nd-Day-Air if you live west of the Mississippi or south of Virginia. In most cases it will only cost $1 more and will save you up to four days on delivery time. If you live in the outside Continental US: We add freight charges to credit card purchases. For prepayment, call 603/446-7711 for information.

DETECTIVE SOFTWARE REPLACED IMMEDIATELY. DEFECTIVE HARDWARE REPLACED OR REPAIRED AT OUR DISCRETION. SOME ITEMS HAVE WARRANTIES UP TO FIVE YEARS.
The news is out! ClickArt™ for Publications is here. This new package is second in a series of ClickArt portfolios of professionally drawn illustrations for Macintosh™.

There are modular column heads and borders, illustrated titles and drawings you can use to create invitations, reports, memos, maps, flyers, newsletters and more.

Illustrated phrases and an alphabet of slanted letters can be used to add impact to memos, reports & flyers.

Column heads like the one below can be easily modified to fit your application.

ClickArt is the starting point for developing your own creativity on the Macintosh.

Create documents that are fun to write and that make a lasting impression.

Show off the power of your Macintosh with drawings like Mark Twain.

ClickArt includes:
- 2 & 3 Column Newsletter Formats
- Illustrated Headlines
- Borders and Backdrops
- Cartoons / People in Action
- Maps (Accurate U.S. maps including Alaska & Hawaii)

You get great backdrops like the bus with areas for dropping in words and images.

"THE NEWS" was created using ClickArt and MacPaint™

ClickArt for Macintosh with MacPaint™ and MacWrite™ $49.95 each. See your local dealer for details or call.

T/Maker Graphics
2115 Landings Drive
Mountain View, CA 94043
415/962-0195

ClickArt is a trademark of T/Maker Company. Macintosh is a trademark licensed to Apple Computer, Inc. MacPaint and MacWrite are trademarks of Apple Computer, Inc.
"Any filing software could list my wines. The problem is finding one in my cellar.

"Filevision" finds the wine that's ready to drink. One that cost less than seven bucks. And goes best with my famous pasta dish. "All in the click of a mouse."

Circle 54 on reader service card
Introducing Filevision™ for Macintosh.™
The fine art of filing by pictures.

Now you can file things the way you see them.

Because Filevision lets you store any kind of information visually. Within pictures you easily create yourself. Even if you can't type or draw.

Filevision. The first software that combines a practical filing system with a simple-to-use, object-oriented drawing system. Which lets you quickly visualize your data. Instead of sorting through tedious line-by-line listings.

In the click of a mouse, you can retrieve the data stored behind each object in your picture. You can even select the objects in your pictures, based on the data in your files.

What's more, Filevision lets you link another picture to an object. And lets you group objects together as a common type. So you can create zoom-like effects, step-by-step hierarchies, or overlays. Whatever your mind can picture.

"Finally. A filing system that sees things my way."

Imagine. A filing system for less than $200, that lets you look at information the way you look at the world around you. Utilizing the simplicity of the Macintosh's eye-opening technology, Filevision allows you to create the most spectacular visualizations of whatever you need to file. Or anything you want to see in more detail.

Whether you're an entrepreneur, a businessperson, or someone who collects things at home; if your data relates to

Create technical illustrations or pictures of science class projects, with ease. Whatever you need to remember about your picture, Filevision lets you store on forms connected to it. And retrieve in the click of a mouse.

Organize office space by department. Diagram a summer home. Even create a play book for your football team. It's a breeze with Filevision.
something you can see, you can file it visually with Filevision. And retrieve it visually, too.

You simply place objects in a picture, or select symbols from Filevision's ready-made symbol menu to represent pieces of the information you wish to file.

Then there's Filevision's flexible way of handling alphanumeric data. Each object in your picture is automatically connected to a data form. Which you custom design, quick as a click.

“For a change, it's simple to modify my files.”

Updating your files is just as easy. Whenever the best-laid plans of mouse and man need a little replanning, remember you're just a click or two away from reper-fecting your files. Create new symbols and objects, and add them to your picture.

Make a data form for any new object, and all objects of that type will have the same form. Automatically.

Modify a symbol and all matching symbols in your picture will be modified. Automatically.

Change an existing form, and all forms of that type will change. Automatically.

“Picture the potential.”

The possibilities are endless. Filevision can help you quickly make maps, and dawdle over the demographics. Assemble anatomical drawings and look up the names of the ligaments. Separate a plan of Bar Mitzvah guests into those who do and those who don't eat Kosher food and actually see who you seat them next to. Pinpoint places and connect them to faces. Control your inventory by depicting your entire shelf space. And map out geography lessons, sales territories and direct-mail ad targets ad infinitum.

Filevision. The unique filing system for your Macintosh that lets you store and work with information in pictures, as well as numbers and text.

Map out sales territories. Sift out subdivisions for direct-mailings. Or search out the states that participated in the French and Indian Wars. Filevision makes your requests pop off the screen. In the click of a mouse.

Plan a political fund-raiser with Filevision, and seat the non-smoking Independents away from the smoking Republicans. Or, click to see which blocks of seats have been reserved at your dinner theater.
Macworld View reports on new products and developments in Macintosh technology. We will cover items of interest to Mac users and comment on industry trends. We welcome contributions from readers and pay up to $50 for the items we use. Please include your name, address, and phone number with your contributions; send them to Macworld View, 555 De Haro St., San Francisco, CA 94107.

Edited by Janet McCandless

Tie a Colored Ribbon

Have you complained about the lack of color on your Macintosh? Then you'll be interested to learn that colored ribbons for the Imagewriter are now available. The ones we have in the Macworld office cost about a dollar more than the standard black and come in red, green, blue, purple, brown, and yellow. The color quality is very good, especially in MacWrite's High Resolution and MacPaint's Final printing modes.

Colored ribbons are manufactured by American Ink of San Francisco and are distributed in San Francisco by Express Computer Supplies, which accepts telephone orders and will usually ship an order by UPS the same day to any location in the United States. Ribbons in colors are also produced by Sharp Color of Columbus, Ohio (see "Macware News" for address information). If you really want to print in color, you now have the capability. Printing in multiple colors, however, is still no easy task; you must transfer ribbon cartridges in and out of your printer. With a number of ribbons at your disposal, you can create multicolored prints with the Imagewriter. While you probably won't turn out sophisticated work at first, you can come up with some interesting effects by experimenting. Use different shades and patterns from the MacPaint palette, since colors vary depending upon the density of the dot pattern.

Insert a ribbon and print the first layer of a drawing. Go back to your drawing and erase or cut what's on the screen. Then draw the second layer of your "print," change the ribbon, insert the same sheet of paper, and print again. You can blend colors by overlapping them to produce a variety of shades. Repeat these steps for as many colors as you wish to use. You might also try pasting several copies of a drawing to the Scrapbook, then erasing all but the portions you need for each color.

This MacPaint drawing was printed using six different colored ribbons (including black). Bring up each portion of your drawing individually on the screen, replace the ribbon cartridge each time, and reinsert the page to add a section in a new color.
University Potpourri

Reports on Apple's University Consortium Program tell of Macs in dormitories, libraries, and scholastic departments linked by networks to provide access to mainframe computers and other university resources. Computer centers, such as the Information Resource Center at Reed College, are being organized and equipped with Macs, printers, disk drives, and peripherals. Systems like Reed's GriffinTerminal are being introduced to give students complete graphics and text software for terminal connection to mainframes.

At the University of Michigan, software and hardware are being developed to connect the networking systems AppleBus and Ethernet to the university's network UMnet. Terminal emulators will be written to access the university's mainframe, and software will be developed that enables students to extract information from databases and produce hard copy with a high-speed laser printer. Rice University's OWLnet will offer students electronic mail, file transfer between their personal computers and the school's mainframe, and bulletin boards that describe courses and announce campus activities. At Dartmouth University, dorm rooms will be equipped with AppleBus to connect Macs to the university computer network.

Some professors plan to supplement textbooks with courseware. Chemistry 101 students at the University of Notre Dame will see computer simulations of chemistry experiments. Linguists at Notre Dame will have access to foreign language fonts in the Greek, Hebrew, and Cyrillic alphabets. At Dartmouth, history students will consult Mac-based atlases, and courseware will enable geology students to simulate geologic changes and study the earth's interior by seismic-wave analysis. Computer science students will work on a 68000 assembler/debugger, a programming language called Smalltalk-80 that runs with UNIX, and animation based on algorithms. Michigan will conduct seminars on the Mac's Toolbox, and programmers there will work on software to extract color information from the QuickDraw data structure and transmit it to a medium-resolution color display.

It is still too soon to predict the Mac's impact on university computer systems or to evaluate the effect of educators' software and hardware on the market. But it is clear that the universities' contribution to the use of the Mac is already significant.

Lisa 2 Miscellany

Sales for the Lisa 2 product line are outstripping Apple's production capacity by a margin of two to one, with the Lisa 2/10 commanding two-thirds of the sales. Lisa product manager Randy Battat says, "We can't build them fast enough." Apple expects to be able to meet the demand by the third quarter of 1984.

Many retailers are touting the Lisa as a big Mac, an assertion that will have more validity when Apple provides access to the Lisa 2/10's hard disk with MacWorks. Software developers are adjusting the distortions produced by the difference in the Mac and Lisa screen sizes, Microsoft Chart automa-
Macworld View

ically compensates so that a pie chart looks round (not oval) on the Lisa screen.

Running Mac software on the Lisa gives you access to more memory than on a Mac. In a MacWrite document written on the Lisa, you can store eight times as many pages per document as with the Mac. The Lisa screen size allows Multiplan users to see 50 percent more information. Although the Lisa’s full screen is not used by MacPaint, with MacDraw the Lisa displays four times as many objects as the Mac does.

Apple is preparing enhancements to Lisa software. You will be able to cut and paste graphics into LisaWrite documents, cut and paste between LisaList and other applications, and between LisaTerminal and other applications. LisaWrite now includes a spelling checker, LisaProject has a job-cost program, and LisaDraw supports color output for the Canon ink-jet printer and reduced fit (the ability to scale the size of a design on the screen).

International Forecast

Like a chameleon, the Mac adapts to new environments. The descriptive label Apple currently applies to this conversion process is “localizing,” which means customizing the Mac’s hardware and software for the language, culture, and customs of the country it’s designed for. With localized versions already in use in the United Kingdom, France, Germany, Italy, and Japan, Apple plans to introduce Spanish, Swedish, Dutch, and French Canadian models this fall and an Arabic Mac soon after. The American form of the Mac is being shipped throughout the world, primarily to markets in Australia, Canada, Europe, and the Far East.

Through its subsidiary, Apple Japan Inc., and its distributor, Canon Sales, Apple will introduce a keyboard that types the Japanese katakana characters. A full Japanese version that incorporates kanji, katakana, and hiragana characters is scheduled to follow. At press time, Apple is considering limited distribution in this country of the international Macs. Ask your dealer for order information.

Software developed by American companies such as Microsoft is being translated for the European market. According to Joanna Hoffman, the Mac’s international marketing manager, Apple also believes that as much as 20 to 30 percent of software developed in other countries will be translated for the American market. (The first two such programs include a French data base and a German calendar.)

Hoffman expects that after a few years we will see an even greater crossover of software. She bases this assumption on the attractiveness of an international market to developers and the low overhead cost of translating software, due to the Mac’s Resource Manager, Toolbox, and user interface. It will be interesting to see what the cross-pollination of ideas and forms produces worldwide in the use of personal computers by the late 1980s.

As this Japanese advertisement shows, marketing efforts are going ahead as Apple readies international versions of the Mac.
Insur-A-Mac

Personal computers are costly investments, so it's no surprise that a large insurance company has come up with a comprehensive policy for Apple computers, including the Mac. Emett & Chandler, a southern California insurance brokerage, offers coverage for an entire Apple system—hardware, software, and accessories (including printers, modems, disk drives, and other peripherals). Underwritten by the Chubb Group of Insurance Companies, the policy guarantees full (not depreciated) replacement cost for all or part of your system. Coverage remains in force regardless of how the computer is used (including business) or where (including travel). California residents will be especially relieved to hear that the policy covers earthquakes as well as theft and fire (though not war or freezing).

All this security costs the anxious Mac owner only $29 per year and carries a $100 deductible. The program is sponsored, but not subsidized, by Apple Computer. Get an application form from your Apple dealer, or contact: Insure Your Apple, Emett & Chandler Insurance Services, 62 E. Colorado Blvd., Pasadena, CA 91105, 818/796-4571.

The Mac for Multiusers

Mac owners who require multiuser systems (which enable several people to share a computer's software, hardware, and data) can connect their Macs to a Lisa 2/10 running the UNIX operating system. Barry Smith of the Apple 32 team predicts that three-fourths of the clients interested in multiuser systems will use accounting and data base applications. A segment of the university and data processing markets is likely to accept the Mac/Lisa connection as a viable solution for their multiuser requirements in both price and performance.

The Mac's unique power as a terminal with UNIX originates in the Mac's user interface. Information retrieved from UNIX can be stored in the Clipboard to be cut and pasted into Mac applications. A manager preparing a weekly report could obtain up-to-date information from a data base shared by other managers in the company. Information could be cut and pasted into MacWrite documents and illustrated with Microsoft Chart in accompanying graphs and tables.

To configure the Mac to serve as a UNIX terminal, an office needs a Lisa 2/10 running UNIX, and cables to connect the Mac(s) to the Lisa's two RS-232C serial ports. A board with four serial ports manufactured by Tecmar can be installed in the Lisa to connect up to four additional Macs. Communications software such as MacTerminal will enable the Mac to interact with programs running on UNIX.

The Lisa 2/10's hard disk is sufficient for most multiuser packages running on UNIX. If additional memory is required, Unipress offers a 20M Corvus hard disk and Sunol hard disks that hold as much as 92M.

Two UNIX-based systems for the Lisa 2/10 are now offered: Xenix by Santa Cruz Operations and UniPlus by UniPress. An accounting package by Open Systems and a data base called Informax by Santa Cruz Operations provide multiuser software. A relational data base management system that operates with UNIX is available from Unify Corporation. RM Cobol and RM Fortran are available from Ryan-McFarland. R Systems is working on the documentation for their office automation software that runs on Xenix. BACS (Business Accounting Control System) is an integrated accounting system developed by American Business Systems and is available on Macworld 27
Xenix. Several other companies have announced product development for UNIX on the Lisa 2. Although Apple is completing AppleBus, the networking product that will connect Apple computers with peripheral devices, the software is not yet finished. AppleBus may present Mac owners with a solution to the problem of shared resources and information, but at present UNIX on the Lisa 2/10 addresses users' requirements for multiuser software.

American Business Systems 3 Littleton Rd. Westford, MA 01886

R Systems 11450 Page Mill Rd. Dallas, TX 75243

Ryan-McFarland Corp. 609 Deep Valley Dr. Rolling Hills Estate, CA 90274

Santa Cruz Operations 500 Chestnut St. Santa Cruz, CA 95060

Unify Corporation 4000 Kruse Way Place, Bldg. #2 Lake Oswego, OR 97034

UniPress Software 1164 Raritan Ave. Highland Park, NJ 08904

User Groups Spring Up

If you're looking for other Mac owners to share news and skills with, you're in luck. Mac user groups are organizing in communities, universities, and elementary and secondary schools. We've listed some of the clubs below.

User groups offer a variety of services: guest speakers, product demonstrations by manufacturers, public domain software, special interest or study groups, public bulletin boards and newsletters, and group discounts on hardware, software, and publications.

Two agencies that assist Mac owners in finding or forming clubs are the International Apple Core and Apple Computer Clubs. If you send a stamped, self-addressed envelope to either agency, you will receive information on Mac clubs in your community. The International Apple Core is a non-profit organization of Apple users and user groups. Apple Computer Clubs supports clubs in the elementary and secondary schools and, with Apple Computer, co-sponsors competitions for students.

If your group is not listed below, please notify us. We'll report from time to time on user group activities and bulletin board services.

Macintosh/Lisa User Groups

California
Conejo Valley Mac Users 3637 Thousand Oaks Blvd. Suite Mac Westlake Village, CA 91362 805/496-8090

Los Angeles Macintosh Group 12021 Wilshire Blvd. #405 West Los Angeles, CA 90025 213/392-5697

Macintosh Users Group 2040 Polk St. #340 San Francisco, CA 94109 415/441-8648

San Diego Macintosh User's Group PO. Box 12561 La Jolla, CA 92037 619/566-3939

Colorado
Club Mac 735 Walnut Boulder, CO 80302 303/449-5533

Maryland
Capitol Mac Users Group 9431 Georgia Ave. Silver Spring, MD 20910 301/585-4262

Washington Apple Pi, Ltd. 8227 Woodmont Ave. #201 Bethesda, MD 20814 301/654-8060

Massachusetts
Boston Computer Society Macintosh Users Group 1 Center Plaza Boston, MA 02108 617/367-8080

New York
New York Mac Users' Group PO. Box 6686 Yorkville Station New York, NY 10128 212/535-1943

North Carolina
Carolina Apple Core PO. Box 31424 Raleigh, NC 27603

Washington
A.P.P.L.E. 21246 68th Ave. S. Kent, WA 98032 206/872-2245

For more information on Mac user groups in your area, contact:
International Apple Core 908 George St. Santa Clara, CA 95050 408/727-7652

For elementary and secondary schools, contact:
Apple Computer Clubs P.O. Box 948 Lowell, MA 01853 617/452-9979
MAC LION—YOUR DATA BASE MANAGER.

ENTER MAC LION

With the click of your mouse, Mac Lion roars onto the screen to give your MAC all the power you will ever need, and then some.

Because Mac Lion unleashes the kind of performance normally associated with a main frame, it grows with you, no matter how large your business expands.

BRAINS & BRAWN

Time, as we all know, is synonymous with dollars. Demonstrating a fine appreciation for the truism, Mac Lion goes about its business of helping your business in record time.

With Mac Lion's relational data base you can often solve problems ten times faster than other programs. So fast we could easily have named it Mac Panther.

MEOW

Because Mac Lion is so powerful and does so much so well, you might be getting the idea it's highly complicated to use.

Bite your tongue. It's a pussycat. Mac Lion utilizes Mac’s pull down menus, Icons, and context-oriented ‘help’ and will have you productive in no time at all.

PROUD PEDIGREE

Although Mac Lion is a new concept in data base management, its lineage is a proud one. CSD, the makers of Mac Lion, developed this product as a natural evolution of our seven years experience in data base management systems on micros.

MONEY-BACK GUARANTEE

Compare Mac Lion with the competition and you'll see that its price tag of only $379 is indeed modest.

That aside, if Mac Lion doesn't prove to be all we say it is, return it within 30 days and you'll receive a full refund. Without a growl.

Should you be unable to locate a dealer selling Mac Lion in your neck of the jungle, please call our toll-free number 1 (800) 252-LION or (714) 634-9012 and we'll supply the information. Or send your check directly to;

COMPUTER SOFTWARE DESIGN INC 1904 Wright Circle, Anaheim, California 92806 and we'll mail your Mac Lion directly.

©1984 Computer Software Design, all rights reserved.
Mac Lion and CSD are trademarks of Computer Software Design.

Circle 66 on reader service card
Beat These Scores and You Could Win a Macintosh.

The competition's already started. But you've still got time to win those Macintosh computers and other great prizes.

It's easy to enter. Simply get hold of our new Mac-Slots casino game package. Then get set for the time of your life. Because the action is fast and the excitement is real.

**MAC-SLOTS. Two Complete Games in One Package.**

A coin operated **SLOT MACHINE.** Even better than the original "one armed bandit."

**KENO.** Non-stop action like you've never seen before.

Both games are totally mouse-controlled and let you pit your skill and luck against real Las Vegas odds.

So, if you want an experience that'll beat Vegas, Reno and Monte Carlo at their best ... Put your money on Mac-Slots.

And don't forget to enter our **Mac-Slots' National Competition.** You'll find full details inside each package. Each month, we'll publish the current top ten scores in our magazine ads.

**Both Games for Only $77.77. AVAILABLE NOW!**

Order your Mac-Slots today. $77.77 plus shipping. Call 1-800-235-6646, Ext. 561.

In California: 1-800-235-6647, Ext. 561. MasterCard and VISA.

Send check or money order to Soft-Life Corporation, 2950 Los Feliz Boulevard, Suite 103, Los Angeles, California 90039, 213-660-7940.

CAUTION. USE OF THIS SOFTWARE FOR ACTUAL WAGERS IS ILLEGAL IN MOST STATES.

Mac-Slots
It Turns Your Macintosh Into a Casino.
A data manager without simplicity is like a sportscar without wheels

It will get you nowhere fast. Unless that program is easy to master, you might never get it into first gear.

Main Street Filer Takes You Where You Want to Go

Test drive the MAIN STREET FILER and you’ll see that it offers you everything your business needs for information management, from data storage and retrieval to custom report generation and personalized mailings.

The FILER’s beauty is in its ease of handling, maneuverability, and dependability. It’s menu-driven, so it’s easy to learn. If you need help, each screen shows the page number of the manual on which that screen is explained. Once in operation, the FILER allows you to move quickly from one application to the next. Its index system eliminates sorting, giving you instant access to any data in your files.

And now, a new Macintosh version of the Main Street Filer takes full advantage of Macintosh technology, letting you glide through file design, data retrieval, and printing functions at the touch of the mouse button.

Let the Main Street Filer and Macintosh put you on the fast track!

Circle 23 on reader service card

Available for Macintosh, registered trademark of Apple Computer, Inc. Also available for CP/M 2.x, registered trademarks Digital Research, Inc.; PC DOS, registered trademark IBM, Corp.; MS DOS, registered trademark Microsoft, Corp.

800-824-8757
415-332-1274 (CA)
The Mac's Special Keys

The Macintosh keyboard is similar to any standard typewriter keyboard. However, the Mac has additional keys that give you an effective alternative to using the mouse to choose commands from the pull-down menus.

Many personal computers have elaborate keyboards that hold more than 80 keys, including several rows of programmable "function keys" and special keys labeled with names or abbreviations like Alt, Control, and Esc. Function keys are often configured to perform common actions that otherwise require a sequence of two or three keystrokes, and special keys are frequently used in combination with other keys to execute commands. Most personal computers also have cursor keys that help you move from place to place in a document.

The Macintosh's keyboard design is as lean and compact as the design of the Mac itself. The keyboard sports a standard "QWERTY" layout (named for the sequence of letters in the first row of alphabetic keys) and 58 keys (59 on the international version), about the same as on a standard typewriter. The Mac keyboard has no function keys; you must use the mouse to issue commands, select text or objects, scroll windows, move the cursor, or mark insertion points.

The Mac keyboard doesn't provide cursor keys either. Moving around a document with a mouse instead of cursor keys seems like a limitation to some users. But a mobile mouse cursor that travels quickly through a document is faster and more flexible than traditional cursors that move character by character or line by line.

Instead of the Mouse

For keyboard-intensive applications such as word processing, you'll want to keep your fingers on the keyboard as much as possible. If you are a touch typist or accustomed to a traditional word processing program, you'll probably want to minimize mouse activity during the editing process. If you have less typing or computer experience, you may be more comfortable relying on the mouse to help edit and revise your text.

Keyboard artists will appreciate the Mac's special keys—, Option, and Enter—that can activate commands, especially those commands used for editing. You can combine these special keys with other keys to give commands or to choose the default responses in dialog and alert boxes. Many of these key combinations are mouse-selectable choices. MacWrite, for example, provides keyboard alternatives for commands.
Keyboard Shortcuts

Tear Out and Save This Card

Desktop

File
Duplicate  ⌘D
Get Info  ⌘I
Eject  ⌘E

Desktop File Menu

Edit
Undo  ⌘Z
Cut  ⌘X
Copy  ⌘C
Paste  ⌘U
Select All  ⌘A

Desktop Edit Menu

MacPaint

Edit
Undo  ⌘Z
Cut  ⌘X
Copy  ⌘C
Paste  ⌘U
Trace Edges  ⌘E

MacPaint Edit Menu

Style
Plain  ⌘P
Bold  ⌘B
Italic  ⌘I
Underline  ⌘U
Outline  ⌘O
Shadow  ⌘S
Align Left  ⌘L
Align Middle  ⌘M
Align Right  ⌘R

MacPaint Style Menu

MacWrite

Edit
Undo Typing  ⌘Z
Cut  ⌘X
Copy  ⌘C
Paste  ⌘U

MacWrite Edit Menu

Style
Plain Text  ⌘P
Bold  ⌘B
Italic  ⌘I
Underline  ⌘U
Outline  ⌘O
Shadow  ⌘S
Superscript  ⌘H
Subscript  ⌘L

MacWrite Style Menu

MacPaint Short Cuts Menu
Key Caps Reference Table

Tear Out and Save This Card

Key Caps using the Shift key

Key Caps using the Caps Lock key

Key Caps using the Option key

Key Caps using the Shift and Option keys

MACWORLD
The Macintosh™ Magazine
555 De Haro St.
San Francisco, CA 94107
415/861-3861
If you prefer to keep your hands on the keyboard while working with the Mac, these tips will help you speed up all phases of word processing.

in the Edit menu (Undo, Cut, Copy, and Paste) and in the Style menu (Plain, Bold, Italic, Underline, Outline, Shadow, Superscript, and Subscript). The Mac's special keys are also used with other keys and the mouse to carry out "shortcuts" in MacPaint, such as $> and $<, which enlarge or reduce text.

The reference table entitled "Keyboard Shortcuts" lists the key combinations that can be used in the Finder, MacWrite, and MacPaint. Tear out the table along the perforated edge and put it where you can see it easily. You'll probably memorize the various key combinations in a short time. As you add application programs to your library, you can create your own reference sheets. Display the appropriate pull-down menu; use Shift-$3-$5, which takes "snapshots" of the screen contents and turns them into MacPaint documents; erase the extraneous parts of the desktop or application document in MacPaint; cut and paste the menus so they fit onto one document; and print them out on the ImageWriter.

Command Key
The Mac's Command key ($) does nothing by itself; you must press it along with another key. In MacWrite, for example, press $b to change the type style to boldface or $x to implement a Cut command. Holding down the ($) key and typing a period aborts a Print command. If you want to move a window on the desktop without making it active, hold down the ($) key before you drag the window.

The ($) key combinations in the Edit menu are an important part of the Macintosh user interface. The Finder, MacPascal, and application programs such as MacWrite, Microsoft Word, Chart, and Multiplan use the z, x, c, and v keys with the ($) key so that you need only one hand to choose an Edit command from the keyboard. For word processing, most people will find it more efficient to use their right hand to select text with the mouse and their left to initiate editing commands from the keyboard.

The Undo command ($z), which undoes the previous action (or the previous Undo), is conveniently arranged so that the two keys line up with each other; perhaps the software designers at Apple considered Undo the most valuable editing tool to have at your fingertips.

Other ($) key combinations are defined by the first letter of the command, such as $d for Duplicate in the Finder or $p for Plain text and $s for Shadow text in the MacWrite and MacPaint Style menus. This mnemonic way of identifying keyboard commands makes it easy to remember key assignments. The ($) key as-
Inside The Keyboard

Dan Kottke

Have you ever wondered how the Macintosh keyboard knows which keys you press? The keyboard has its own 8-bit microprocessor, the 8021, which constantly monitors the keyboard for changes, with the help of a short ROM program on the same chip. When you switch on the Mac, the ROM program checks to see that the keyboard is working properly and whether the numeric keypad accessory is attached. Pressing any key sets in action a chain of events that lets you send characters and commands to the Mac.

Almost every key lies at the intersection of a row and a column on an electrical grid called the keyswitch matrix. When you press a key, an electrical connection is made at an intersection unique to that key. The Caps Lock key, the Option keys, the Shift keys, and the [ ] key are not part of the matrix but each makes a direct connection to the 8021 chip. These keys have separate circuits to handle the added information when they are pressed simultaneously with other keys. The keyboard's microprocessor continually scans the keyswitch matrix to see if any changes have occurred.

The 8021 scans the keyboard so quickly that, even if you're an incredibly fast typist, you can't possibly fool it. To the 8021, keystrokes seem few and far between. The world speed record for typing is about 180 words per minute, which is about 15 characters per second or one character every 66 thousandths of a second. The 8021 scans the keyboard every 3 thousandths of a second, making for many uneventful scans.

As the scan progresses, the microprocessor recognizes a change by comparing the up or down state of each key in the matrix with a key map it keeps in a small portion of memory. The 8021 has 64K of RAM built into the chip, 8K of which are used for the key map. The key map reserves one bit for the status of each key and remembers which keys are up and which down. When the microprocessor detects a change, it waits 5 thousandths of a second and then double-checks by scanning the key matrix a second time. All mechanical switches, such as those used in the Mac keyboard, must be rechecked because they may take 1 or 2 thousandths of a second to establish an electrical connection. Apple chose mechanical switches, even though they don't last as long as capacitive switches or rubber conductive switches, because they feel and sound better to most typists.
Once a key change is verified, the 8021 takes the row and column numbers of the key intersection and transforms those numbers into a key code. One bit of the key code also indicates whether the key is in up or down position. The entire one-byte key code is sent to a chip in the Mac.

For example, pressing the D key activates the processes discussed so far. When you press D, a switch connects at the intersection of column 0 and row 2 of the key-switch matrix. The 8021 discovers this connection and checks it against the key map to see if there has been any change. The 8021 doublechecks and confirms the change. The 8021 then converts the new key position into the key code 10001010, which it sends to the shift register in the 6522 chip in the Mac.

When the key code number fills up the register, it signals an interrupt to part of the ROM operating system software called the interrupt handler. The interrupt handler detects that the interrupt came from the keyboard and calls another part of the operating system called the keyboard device driver. The keyboard device driver compares the key code it has just received with an ASCII lookup table that you unknowingly loaded into RAM from an application disk when you put the disk into the Mac. The table shows the ASCII equivalent of the key code sent to the device driver. In our example, the key code 10001010 would be indexed to the ASCII code 01100100, which represents a lowercase d.

After the ASCII conversion is made, the keyboard device driver calls the event manager (another part of the operating system in ROM) to notify it that a change has occurred. The event manager holds the key change information until the application program then running is ready to receive it. The application, according to its own rules, then acts on the key change information. For example, MacWrite might take the letter d and display it on screen after the last letter you typed.

The keyboard connects to the Macintosh via a modular coil cord that is similar to those used on telephones. The Mac's cord has heavier gauge wire to prevent drops in voltage that don't stop you from understanding phone conversations but can interfere with the accuracy of the digital signals the Mac uses. If you replace the Mac's cord with a telephone handset cord, it doesn't damage the keyboard's microprocessor, but it won't work.

Although at first it might sound clever to put your keyboard on a 25-foot telephone handset extension cord, it makes little practical sense; most people can't comfortably read text on the screen from much further than six feet away. The modular coil cords, however, provide a convenient way to attach other types of input devices such as bar code readers, voice or optical character recognition devices, or piano keyboards. Some day you may see all these unusual devices in place of the Mac's keyboard. Until then, the 8021 will be hard at work.

Dan Kottke, a digital engineer at Apple Computer, co-designed the Macintosh keyboard with Ed Riddles. He describes himself as the Mac team's "digital handyman" and has worked on various support projects for the Mac.
signments may vary among application programs; in *Microsoft Chart*, `⌘`-s implements the Show Page command, and in *Microsoft Word*, the Save command.

The `⌘` key is also used in *MacPaint* to create special effects: holding down the `⌘` key and dragging an object selected using the marquee stretches a selection. When you are using the pencil, holding down the `⌘` key and clicking the mouse button enables you to enter and exit FatBits. The Short Cuts option in the Goodies menu lists the other *MacPaint* key modifiers.

Other application programs can use the `⌘` key in different ways. In *Multiplan*, for example, holding down the `⌘` key and clicking a cell within a selection makes that cell the current cell.

**⌘-Shift**

One unique feature on the Mac is the `⌘`-Shift key combination. As mentioned before, you can turn the current contents of any screen into a *MacPaint* document by holding down the `⌘` and Shift keys and typing 3. This "snapshot" technique is especially useful for customizing documents because it allows you to apply the full range of *MacPaint* tools to the snapshot.

The Mac also has a "quick print" feature that prints the contents of the screen. To print an active window only (including the title bar and scroll bars), hold down the `⌘` and Shift keys and type 4. You can print the contents of the entire screen by engaging Caps Lock, holding down `⌘` and Shift, and typing 4. Once you press either combination of keys, the image is immediately sent to the printer. These options produce a quick printout of a graphic image or a short document such as a page of the Note Pad.

The `⌘`-Shift-1 key combination ejects the disk from the Mac's internal drive, and `⌘`-Shift-2 ejects the disk from the external drive. However, don't use the `⌘`-Shift command sequence as a standard procedure; there are a few cases in which using this technique can damage your disk and lose information.

*Microsoft Word* uses the `⌘`-Shift combination to provide a full range of keyboard-driven editing and formatting commands. For example, `⌘`-Shift-r specifies right justification, and `⌘`-Shift-< reduces the font size of selected text.

**Enter Key**

The Enter key confirms a command or acknowledges an alert box. It has the same function as clicking a button in a dialog box to confirm a command such as Yes, OK, or Go Ahead. If a button in a dialog box is surrounded by a boldfaced border, such as the Yes button in the *MacWrite* "Save changes before closing?" dialog box, pressing Enter puts that command into effect. In some cases pressing Enter confirms a command in a dialog box that doesn't have a button outlined in bold. In those situations the Enter key activates a command in a dialog box that doesn't have a button outlined in bold.

The way the Enter key works varies from program to program. In *Multiplan*, for example, the Enter key has the normal function of confirming commands in dialog and alert boxes. The key also enters the contents of a formula bar into a cell, makes the next cell within a selection the current cell, and moves the selection from one unprotected cell to the next within a partially protected worksheet.

If you work in the fast lane, the Enter key can help satisfy your need for speed. For instance, if you leave an application by choosing Quit, wait for the beep, and immediately press Enter, you can save your text without having to wait for the dialog box to appear completely on the screen.

**Option Key**

The Option key is used to give a key an alternative interpretation such as accented characters or the special symbols required in scientific writing. Key Caps in the Apple menu lists the characters associated with each key. You can see the alternate characters by holding down the Option key while the Key Caps window is active. Option-g gives you the copyright sign (©), and Option-u pressed before a character produces an umlaut (¨) above the character (u). "Key Caps Reference Table" (on the reverse side of the "Keyboard Shortcuts" table) lists the alternatives available using Shift, Caps Lock, and Option.

In the same way that the `⌘` key is not rigidly defined, application programs can configure the Option key to provide shortcuts that allow for more flexibility and complexity within a program. In *MacPaint*, for example, you can copy an object by holding down the Option key and dragging the selected object. Holding down both Option and `⌘` and dragging an object selected using the lasso produces multiple copies.
Return and Tab
In word processing programs, the Return key works like a typewriter carriage return key; it moves the insertion point to the next line. Like the Enter key, Return can be used to confirm a text entry (such as a document name) or a dialog box command. The function of the Return key varies from one application program to another; in *Multiplan*, Return performs the same functions as Enter and moves the current cell down one cell.

The Tab key carries out different operations, depending on the situation. In a dialog box, pressing Tab moves the insertion point to the next field, or the next box in which you can type information. In word processing, Tab moves the insertion point to the next tab marker, which you set in *MacWrite*.

Shift and Caps Lock
The Mac's Shift key acts like a typewriter shift key. When you hold down Shift and press a key, a character's uppercase version (or the uppermost character on the key) appears. The Shift key is also used with other keys or the mouse to produce special effects; pressing Shift and clicking the mouse button, for example, allows you to extend a selection. When you want to select more than one icon on the desktop, hold down the Shift key as you select the icons. In *MacWrite*, pressing Shift and clicking at the beginning and end of a section of text selects all text between the two points. (In *Multiplan* this procedure selects all the cells between two points.)

On a typewriter you can "lock" the Shift key to generate uppercase characters. Caps Lock works in this way, but it affects letters only. Locking it doesn't produce the symbols or characters above the numeric or punctuation keys.

Control Panel Adjustments
The Control Panel in the Apple menu contains two adjustable controls for the keyboard. You can set the repeat rate of the keys (how fast a character duplicates itself when you hold down a key) and the keyboard response rate, which determines how much time elapses before a character starts to repeat. If you have a heavy touch on the keyboard, set this control at 1 or 0.

Customizing the Keyboard
The software you use defines the Mac's keys as specific characters. When you press a key or key combination, the Mac makes the character that you want appear. It even produces characters and images you don't see labeled on the keyboard or in the Key Caps window. These robots, apples, cars, footprints, sheep, and other special characters, produced by holding down the Shift and Option keys and pressing the key in the upper-left corner (see "Open Window," May/June), were created using a font editor that displays characters dot by dot.

Because the Mac has bit-mapped graphics, you can redefine a key or key combination just as you would use FatBits to modify a *MacPaint* drawing. A key-mapping procedure translates the signals from the keyboard into a code that the Mac understands, and then the appropriate character is displayed on the screen (see "Inside the Keyboard" for an in-depth discussion of how the keyboard works). Apple plans to release a utility program that will enable you to create your own characters and assign them to the keys you choose.

Speed and ease of use are among the most important features that people look for in a computer. The Mac is certainly easy to use, and these alternatives to the mouse-driven commands can help speed up the editing process. Whatever style you adapt for working on the Mac, you'll want to learn to integrate the mouse and the keyboard so that your work flows smoothly. Try different ways and see what method works best for you.

Daniel Farber is the Associate Editor of *Macworld*. 
Reveal The Power Inside Your Macintosh™

Brock Keystroke* Data Base And Report Generator

Advanced information management becomes crystal clear with the only software that mirrors the productivity potential of your Macintosh...Brock Keystroke Data Base and Report Generator.

The Keystroke electronic file cabinet enables you to STORE, FIND, UPDATE, or PRINT information with startling clarity. And only Keystroke has enlightened features such as field formatting, automatic repeat fields, default responses, rapid search sorts, computed fields and cross-referencing. Plus, Keystroke's Report Generator directs the full power of the Data Base into printouts that conform to your exact needs, including flexible formatting, statistics, highlighting, computed columns, and more.

To reveal the full power inside your Macintosh, you don't need a crystal ball. Simply visit your Apple® dealer and ask for a Brock Keystroke demonstration. Or contact us directly for all the illuminating details.

Brock Software Products, Inc.
8603 Pyott Rd., Box 799
Crystal Lake, Illinois 60014
815/459-4210
Telex: 722-489 BROCK CRYS

A Symbol of Excellence By Brock Software Products, Inc.

*Apple is a registered trademark of Apple Computer, Inc. Macintosh is a trademark of Apple Computer, Inc.

Circle 46 on reader service card
There's a better way to store your Macintosh® treasure trove of pictures, word processing and application software! Get an add-on floppy drive or hard disk system from Micro-Design.

Micro-Design will be your oasis for add-on floppy disk drives (3.5" — just like the one in your Mac), fixed hard disk drives and our near-immortal combination fixed/removable cartridge hard disk subsystems.

We're currently putting the final touches on these units, to make sure they're worthy of the Mac — easy to use, durable, and competitively priced. Look for shipments to begin during the third quarter of this year.

We've been serving the microcomputer user since 1979 (that's almost ancient in this industry). Our policy is to offer our customers mass storage devices that match the original manufacturer's specifications at the lowest possible price. And when it comes to after-the-sale support, we won't desert you.

Call us TOLL FREE to get on our Mac mailing list and be the first to know when these new products are available. We'll send you our FREE catalog listing our complete product line.

Call 1-800-531-5002. In Texas, call 512-441-7890.
OUR STORIES LACK IMAGINATION.

Because Infocom's interactive fiction is designed to run on your imagination.

That's precisely why there's nothing more interesting, challenging or interactive than an Infocom disk—but only after you've put it in your computer.

Once it's in, you experience something akin to waking up inside a novel. You find yourself at the center of an exciting plot that continually challenges you with surprising twists, unique characters (many of whom possess extraordinarily developed personalities) and original, logical, often hilarious puzzles. Communication is carried on in the same way as it is in a novel—in prose. And interaction is easy—you type in full English sentences.

But there is this key difference between our tales and conventional novels: Infocom's interactive fiction is active, never passive. The course of events is shaped by what you choose to do. And you enjoy enormous freedom in your choice of actions—you have hundreds, even thousands of alternatives at every step. In fact, an Infocom interactive story is roughly the length of a short novel in content, but because you're actively engaged in the plot, your adventure can last for weeks and months.

Find out what it's like to get inside a story. Get one from Infocom. Because with Infocom's interactive fiction, there's room for you on every disk.

For your: Apple II, Macintosh, Atari, Commodore 64, CP/M 86, DECmate, DEC Rainbow, DEC RT/11, HP 150 & 110, IBM PC+ & PCjr, Kaypro II, MS-DOS 2.0, NEC APC, NEC PC-8800, Osborne, TI Professional, TI 99/4A, Tandy 2000, TRS-80 Color Computer, TRS-80 Models I & III.

*Use the IBM PC version for your Compaq and the MS-DOS 2.0 version for your Wang, Mindset, Data General System 10, GRiD and many others.

Circle 43 on reader service card
Introducing OMNIS from OSC. Powerful, progressive, friendly.

Three powerful, upgradeable database programs take you from file management to a sophisticated relational/hierarchical system.

OMNIS 1, OMNIS 2, and OMNIS 3. The new family of database software that grows with you. From basic file management to sophisticated information management. From applications development through comprehensive database management.

The OMNIS trio offers more power, more features than other leading database packages costing much more. Each OMNIS program is upward compatible. And each is easily upgradeable—you pay only the difference in program cost plus a handling charge.

OMNIS 1, OMNIS 2, and OMNIS 3 are available for IBM* PC, IBM XT, Apple* IIE, Apple III, DEC*, Sirius*, Sager*, and Apricot* microcomputers. OMNIS 2 and OMNIS 3 are also available for Macintosh* and Lisa*.


The Database Manager. A complete database management system. Supports up to 12 open files at any time. Operates as a relational or hierarchical database system. Flexible screen and report formatting and user-defined entry sequences allow screen overlays, custom messages, and menus. Can generate complete turn-key systems. Supports hard disk systems and multi-user operation on local area networks.

Compare the OMNIS family, Europe's best-selling microcomputer database software, with these database products:

<table>
<thead>
<tr>
<th>Product</th>
<th>Retail Price</th>
<th>Records per file</th>
<th>Fields per record</th>
<th>Open files</th>
<th>Max. char. per record</th>
<th>Built-in Letter/label merge</th>
<th>Calculation fields</th>
<th>Customized menus &amp; messages</th>
<th>User interface</th>
<th>DIF compatible</th>
<th>Hardware</th>
<th>Multi-user LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMNIS 1</td>
<td>595</td>
<td>unlimited</td>
<td>120</td>
<td>1</td>
<td>3000</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>menu</td>
<td>yes</td>
<td>1,2,3,4</td>
<td>yes</td>
</tr>
<tr>
<td>PFS-File*</td>
<td>120</td>
<td>32K</td>
<td>32</td>
<td>1</td>
<td>1600</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>1,2,3,4</td>
<td>no</td>
</tr>
<tr>
<td>PFS-Report*</td>
<td>120</td>
<td>-0-</td>
<td>-0-</td>
<td>-0-</td>
<td>-0-</td>
<td>Report only</td>
<td>no</td>
<td>menu only</td>
<td>no</td>
<td>no</td>
<td>1,2,3,4</td>
<td>no</td>
</tr>
<tr>
<td>OMNIS 2</td>
<td>295</td>
<td>unlimited*</td>
<td>120</td>
<td>1</td>
<td>9600</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>menu</td>
<td>yes</td>
<td>1,2,3,4,5,6</td>
<td>yes</td>
</tr>
<tr>
<td>Database Manager II</td>
<td>295</td>
<td></td>
<td>40</td>
<td>1</td>
<td>2400</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>menu</td>
<td>yes</td>
<td>1,2</td>
<td>no</td>
</tr>
<tr>
<td>DB Master* App. IBM</td>
<td>350</td>
<td>250K</td>
<td>100</td>
<td>1</td>
<td>1020</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>menu</td>
<td>yes</td>
<td>3,4</td>
<td>no</td>
</tr>
<tr>
<td>R:BASE*</td>
<td>295</td>
<td>unlimited</td>
<td>1440</td>
<td>12</td>
<td>25000</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>menu</td>
<td>yes</td>
<td>1,2,3,4,5,6</td>
<td>yes</td>
</tr>
<tr>
<td>CONDOR:3</td>
<td>650</td>
<td>65K</td>
<td>32</td>
<td>2</td>
<td>1000</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>comm</td>
<td>yes</td>
<td>1,2,3,4</td>
<td>no</td>
</tr>
<tr>
<td>R:BASE*</td>
<td>650</td>
<td>64K</td>
<td>127</td>
<td>6</td>
<td>1024</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>comm</td>
<td>no</td>
<td>1,2,3,4</td>
<td>no</td>
</tr>
<tr>
<td>R:BASE*</td>
<td>4000</td>
<td>unlimited</td>
<td>400</td>
<td>40</td>
<td>1530</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>menu</td>
<td>yes</td>
<td>1,2</td>
<td>no</td>
</tr>
</tbody>
</table>

*Limited only by disk capacity

Chart compiled from published information

1-IBM PC 4-Apple III
2-IBM XT 5-Macintosh
3-Apple IIE 6-Lisa

Now available for Macintosh!

OSC

For more information, contact Organizational Software Corporation, 2655 Campus Drive, Suite 150, San Mateo, CA 94403, (415) 571-0222.

Circle 38 on reader service card
Get Info

Macworld's tutor answers questions about using the Mac

Lon Poole

Get Info answers questions about the Macintosh and how it works. Most inquiries will deal with application programs, but no topic is too elementary nor too advanced. Discussions will range from setting up the Mac to programming in BASIC and Pascal. When you need advice about using the Mac, drop me a line. I cannot respond to individual letters, but I will answer the most representative questions.

This issue's column answers six questions. One person wants to print MacWrite headers on only the first page of a document. Another wants information about the Grid in MacPaint. Several readers wonder if it's possible to have Multiplan print smaller characters to get more rows and columns on a printed page. Someone wonders whether switching the Mac off and on will shorten its life. Several readers want to know why the Mac sometimes renames a disk during a disk change, and a few people ask for an explanation of setting the clock, calendar, and alarm clock. There have been lots of programming questions too, and next time I'll answer some of them.

Header Suppression

Q. When I type business letters, I want the header to appear only on the first page. How do I get rid of it on subsequent pages?

Andrea Sibak
Englewood, Colorado

A. To print the header of any MacWrite document on the first page but not on the following pages, you can print the document in two stages. Print the first page of the document with the header visible by choosing Display Headers from the Format menu. Print only the first page by choosing Print from the File menu and entering a page range from 1 to 1 in the Print dialog box.

In the second stage, print the remaining pages of the document with the headers hidden by choosing Remove Headers from the Format menu. Then print the remaining pages by choosing Print from the File menu a second time and entering a page range from 2 to 99 (or the last page number of your document).

But why bother with this cumbersome procedure? If you want to print a letterhead at the top of the first page of your letter, for example, why not add it directly to the top of the document? Use the header feature to restate the name of the recipient, the page number, and the date on following pages. The Title Page feature of the Format menu keeps the header off the first page, which shows your letterhead. Of course, this approach requires you to type the date on the first page and in the header. You won't be able to use the date icon in the Header window if the date on the first page doesn't coincide.

MacPaint's Grid

Q. There doesn't seem to be any documentation about the Grid in MacPaint. Can you explain how to use it?

Douglas E. Roesch
Greensburg, Pennsylvania

A. When you choose the Grid option from MacPaint's Goodies menu, the Mac imposes an invisible grid on the drawing window. Pointer movement is then constrained to the grid lines. It's as if the drawing window were a piece of graph paper, and the pointer could only move on the lines or jump from line to line. The Grid feature affects only the following operations:

- Selecting, dragging, and duplicating with the marquee (selection rectangle).
- Selecting a text insertion point with the I-beam pointer.

42 September/October 1984
• Drawing straight lines.
• Drawing rectangles, rounded-corner rectangles, ovals, and polygons (but not freeform shapes).
• Dragging and duplicating an object selected by the lasso (selecting with the lasso is only affected by the Grid immediately after pasting something selected by the lasso, and then only until you click on another tool).

The invisible grid lines are eight dots apart, so the pointer moves eight clots at a time instead of the usual one dot. This feature makes it easy to position parts of a drawing by eye; it's easier to spot objects that are out of line by eight dots than by only one or two dots.

The Grid is especially handy for working with patterns. Each pattern is defined by an 8-by-8-dot square. You can see a magnified version of a patterned square by double-clicking on a pattern in the pattern palette or by choosing Edit Pattern from the Goodies menu.

**MacPaint** fills an area by laying patterned squares end-to-end like floor tiles. The Grid feature constrains movement of a selection to the same eight-dot intervals that the pattern squares are laid on. If the Grid is active when you drag patterned objects, overlapping patterns always mesh. If you drag patterned objects when the Grid feature is inactive, they are not constrained to the invisible grid lines, and overlapping patterns usually end up offset from each other by a couple of dots.

At a recent Macintosh Users Group meeting in San Francisco, Bill Atkinson (the author of MacPaint) demonstrated another way to use the Grid. Have you tried elongating a patterned object by selecting one end of it, pressing `Shift-Option`, and dragging the object? Without the Grid, the middle part of the pattern is ruined.

With the Grid, the pattern's uniformity is maintained (see the figure entitled "Grid Demo").

**Compressed Multiplan**

Q. I have been printing Multiplan spreadsheets with my Imagewriter on standard letter paper and printing with the Tall orientation option from the Page Setup command. I know that I can also print a spreadsheet using the Wide orientation, but I would like to shrink the size of the printed type. Is it possible to do this?

Andrea Michaels

Boylston, Massachusetts

A. Normally, Multiplan uses a special 10-point font called Seattle for row and column numbering and for worksheet contents. Unlike MacWrite and MacPaint, Multiplan has no Font or Style menu for choosing different type fonts, sizes, or styles. However, if you remove the Seattle font from the System file on the Multiplan disk (using the Font Mover utility), the current Multiplan Version 1.02 substitutes 9-point Geneva. However, make sure that you do not remove the Seattle font from the outdated Multiplan Version 1.00. That version scales 9-point Geneva to a 10-point size, making the displayed and printed characters difficult to read.

Multiplan columns are narrower and rows are shorter with 9-point Geneva than with 10-point Geneva. A standard empty worksheet window shows 15 rows by 5 columns using 10-point Seattle or 20 rows by 7 columns using 9-point Geneva (see the figures labeled "10-point Seattle" and "9-point Geneva"). The same proportions pertain when printing, so you can get more columns across and more rows down a page with 9-point Geneva.

There is a catch to compressing the size of a Multiplan document. When you open an existing worksheet, Multiplan maintains its original column width. Thus, you will see the same number of columns across the window using 9-
10-point Seattle

This is the font that Multiplan normally uses for numbering rows and columns and for the contents of worksheets. Multiplan has no menus for choosing different type fonts, sizes, or styles.

point Geneva as you originally had using 10-point Seattle. Since the characters in those columns are smaller, more of them fit in the same space. To get maximum benefit from the smaller font size, you must reduce the width of each column by placing the pointer on the column partition in the row of column headers and dragging the partition to the left. Alternatively, you can select a cell and choose Column Width from the Format menu to set column widths. Only then will you get more columns across the page.

Fear of Switching

Q. I've been admonished not to turn off and on electronic equipment such as computers and color televisions. Such action, I'm told, shortens the life of the equipment. I'm reluctant to turn the Mac off and on to run applications that require differing configurations of the System file or different versions of the Finder file. On page 237 of _The Apple Macintosh Book_ (Microsoft Press, 1984), Cary Lu recommends restarting the Mac by pressing an Interrupt/Reset button that owners may install on the left side of the main unit. Since I've not read about this button in _Macworld_, I wonder if the button is available; if so, does pressing it substitute for turning the Mac off and on?

Greg Peirce

San Luis Obispo, California

A. Don't worry; your Mac won't suffer from being turned off and on. The Interrupt/Reset switch you mention is a small plastic part that snaps onto the grill on the lower-left side of the Mac. The switch is included in the white box that contains the Macintosh System Disk, _MacWrite_ and _MacPaint_, and the Guided Tour disks and cassettes. If you misplace your switch or didn't get one when you purchased your Mac, contact your dealer, who should have extras in stock.

Pressing the Reset part of the switch has the same effect as switching the power off and back on. The Mac beeps, the screen goes blank, and the Mac waits for you to insert a startup disk. However, you need not switch the Mac off and on or reset it simply to change applications, even if the applications use different configurations of the System file. For example, your _MacWrite_ disk's System file might contain different fonts than your _MacPaint_ disk's System file. To go from _MacWrite_ to _MacPaint_ on a single-drive Mac, you quit _MacWrite_ and eject the disk. Then you insert the _MacPaint_ disk, open the _MacPaint_ disk icon, and open either the _MacPaint_ application icon or a _MacPaint_ document icon.

When you start an application, the Mac automatically uses the Finder and System files on the application's disk. In fact, the Mac considers the application's disk to be the startup disk.

Buffer Alert

Q. It seems that I can get the Mac to rename a disk arbitrarily just by jiggling the keyboard during a disk change. Why doesn't the Mac have a keyboard buffer to eliminate such dangerous accidents?

Bill Johnstone

Victoria, British Columbia

A. The Mac does have a keyboard buffer, but the problem you describe occurs because the Mac doesn't clear the buffer when you change disks. Here's how the keyboard buffer works. Usually when you strike a key, the Mac immediately displays the character on the screen. But sometimes the Mac is busy performing other functions, so it stores your keystrokes in a holding area of memory called the keyboard buffer. When the Mac is no longer busy, it spews the characters from the buffer onto the screen, either at the insertion point or as a replacement for selected text.
When you insert a disk, the Mac is busy checking the disk, getting its name, learning what documents and applications it contains, remembering the comments in the Get Info windows, and so on. The last thing the Mac does after you insert a disk is select the disk’s icon, including its entire name. During all this processing, any characters generated by keystrokes—whether intentional or accidental—are stored in the keyboard buffer. When the disk activity ceases, characters in the buffer stream out onto the screen, replacing the selected disk icon’s name.

The Undo command is unavailable after an icon name is changed. You can still restore the correct icon name without retyping it, as long as you have not yet clicked the mouse button. First you select the bogus name by pressing the mouse button at one end of the name and dragging the pointer to the other end. Then press the Backspace key to delete the selected name. Finally you click anywhere on the gray part of the screen. The former name will reappear under the icon.

Arm the Alarm

Q. The MacIntosh manual doesn’t have much information about the Alarm Clock desk accessory. Please explain how it works.

Ellen Howlett
St. Louis, Missouri

A. The Alarm Clock desk accessory reports the time of day, the date, whether the alarm is set to ring, and the time at which it will ring. It also enables you to set and adjust those items. The clock is accurate to within a second or so each day, and keeps running when the Mac is switched off, thanks to a self-contained, long-life battery. The Calendar is accurate through the 21st century, including leap years.

When you choose Alarm Clock from the Apple menu, you see a digital clock that reports the time of day. Clicking the small lever to the right of the time drops the other two parts of the Alarm Clock into view. The middle part is used for viewing and setting the date, or for setting the time. The bottom part of the Alarm Clock contains three icons that control the function of the middle part.

To set the time, first select the clock face by pointing at it and clicking the mouse button. A second digital clock replaces the date and keeps time below the first one. Move the pointer over the lower digital clock, where it will change from an arrow to a cross (a large plus sign).

Next, select any element in the lower digital clock—hours, minutes, seconds, or AM/PM. An adjustment button appears and the lower clock stops keeping time. The upper digital clock continues to keep time while you adjust the lower one.

To adjust a selected number upward, place the pointer on the up arrow and click or hold down the mouse button. Click to bump the number up by one; hold down to spin ahead rapidly. Use the down arrow to decrease the number. To switch back and forth between AM and PM, click anywhere on the adjustment button.

When the time on the lower digital clock is correct, click on the clock face. Clicking on the highlighted clock face or anywhere on the upper digital clock resets the upper clock so it matches the lower clock. To reset the lower clock instead, click the mouse button with the pointer between the adjustment button and the AM/PM indicator. To view or change the date, select the calendar icon. Use the same method to set the date as to set the time.

To check the alarm, select the alarm clock icon. Set the alarm time like you set the time of day: When you click the alarm clock icon, the time at which the alarm will ring appears, with an on/off button to its left. Clicking the on/off button alternately arms and disarms the alarm.

When the alarm goes off, the Mac beeps once and then starts flashing the Apple logo in the menu bar. If the alarm goes off while the power is off, the Mac beeps once and flashes the Apple logo the next time you switch the machine on. To make the Apple logo stop flashing, choose Alarm Clock from the Apple menu and disarm the alarm by clicking on the displayed on/off button.

Tuck the middle and bottom parts of the Alarm Clock away by clicking a second time on the lever next to the time of day. Put back the whole Alarm Clock by clicking on its close box or by choosing Close from the File menu.

Send your questions to
Get Info, Macworld, 555 De Haro St., San Francisco, CA 94107.

Lon Poole is a Contributing Editor of Macworld and the author of several computer books including The Apple II Users Guide and MacWork/ MacPlay.
When you first laid eyes on that fish in the scrapbook file that came with your Mac, didn't you wish for a whole disk full of such clever illustrations? Well, now there is such a disk—Mac the Knife. It's chock full with over 500 useful illustrations, borders, icons, and maps... all in convenient MacPaint files. And every file has its own unique set of textures.
MacTote™
The highest quality case built specifically to carry your Macintosh™ Computer.

Now your Macintosh Computer can leave your home or office fully protected and in style. The MacTote computer case is clearly the finest carrying case manufactured especially for your Macintosh Computer, and for a number of easy-to-see reasons:

1. Padded pouch for mouse;
2. Open pouch for manuals or notes;
3. Open, padded pouch for keyboard;
4. Side handle for easy carrying and stability;
5. Padded, Velcro handle (no snaps);
6. Padded, non-slip shoulder strap;
7. Zippered pouches for disks or accessories on both sides of case;
8. Zippered pouch for accessories, modem, cords, etc.;
9. Padded pouch for disk drive, and extra padding to protect Macintosh's screen;
10. Reinforced bottom fully supports and distributes weight of Macintosh;
11. Heavy-duty nylon zippers.

Optimum Computer Luggage has extensive experience in making top-of-the-line totes and accessories and MacTote is the latest in a long line of beautiful and functional luggage. Made of long-wearing and completely water-resistant Cordura, MacTote gives you every feature you'll ever need for carrying your Macintosh and peripherals.

Another attractive feature is MacTote's low price, which makes it even easier to pick up and carry away. Call today for the dealer nearest you so you can get a MacTote for your Macintosh.

Who says you can't take it with you? Call (800)447-0300
Or in CATOLL FREE (800)632-4200.

Macintosh is a trademark licensed to Apple Computer, Inc.
MacTote is a trademark of Optimum Computer Luggage.

Circle 34 on reader service card
Introducing

MACWORLD

The Exciting New Magazine for the World's Most Creative Personal Computer—the Macintosh

At Special Charter Subscriber Rates
Save Up to 54% Off the Newsstand Price*
(*when you subscribe for 3 years)

Personal computing took a giant leap into the future when Apple introduced the Macintosh. We've created Macworld as your passport into this incredible new realm of computing. Each issue we'll bring you everything you need to explore and get the most out of your Macintosh. From the latest product news to innovative business applications, from amazing graphics to personal productivity tools and games, each issue of Macworld will be packed with interesting, practical, readable information written by skilled, perceptive writers.

Each month we'll be creating a Macworld community; sharing ideas, problems, and creative solutions while we explore the world of Macintosh together.

So why take a chance on missing a single exciting issue? For a limited time only you can subscribe to Macworld at special Charter Subscriber rates of only $24 for 1 year (12 issues)

That's a savings of 20% off the regular $30 subscription rate and 50% off the newsstand price!

And you can save even more by subscribing for 2 or 3 years at Special Charter Rates. Don't Wait...Subscribe Today and Save!
Special Charter Subscription Offer

Save 50% off the Newsstand Price!

Newsstand

Regular Subscription Rate

$24

Special Charter Offer

Order Now to Take Advantage of This Limited Time Offer! VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

Macworld will be published in May, July, and September 1984 and will begin monthly publication in November 1984.

YES! Please send me Macworld, the Macintosh magazine.

□ Please Bill Me □ Payment Enclosed

Please Send Me: □ 12 issues/$24 □ 24 issues/$46 □ 36 issues/$66

Name __________________________

Company __________________________

Address __________________________

City, State, Zip __________________________

Please allow 6-8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $12 per 12 issues for surface mail or $60 per 12 issues for airmail.

VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

YES! Please send me Macworld, the Macintosh magazine.

□ Please Bill Me □ Payment Enclosed

Please Send Me: □ 12 issues/$24 □ 24 issues/$46 □ 36 issues/$66

Name __________________________

Company __________________________

Address __________________________

City, State, Zip __________________________

Please allow 6-8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $12 per 12 issues for surface mail or $60 per 12 issues for airmail.

Yes! Please send me Macworld, the Macintosh magazine.

□ Please Bill Me □ Payment Enclosed

Please Send Me: □ 12 issues/$24 □ 24 issues/$46 □ 36 issues/$66

Name __________________________

Company __________________________

Address __________________________

City, State, Zip __________________________

Please allow 6-8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $12 per 12 issues for surface mail or $60 per 12 issues for airmail.
Desktop Calendar for your Lisa 2

Desktop Calendar, a new tool for the Lisa 2, will improve the way you work because it helps you manage your time.

You’re an important person. Working hard to get the job done. But what happens if you get so involved in your work that you lose track of time? Missing an important appointment or meeting can mean disaster.

If you put the times and dates of all your important appointments and meetings into Desktop Calendar, it will automatically remind you of them in time for you to meet your commitments. Once you place Desktop Calendar on your electronic desktop, you can use your computer to write a letter, recalculate a schedule, prepare a financial statement, or use any of the Lisa Office System Tools. At the proper time Desktop Calendar will interrupt, reminding you of your appointment.

Talking on the phone to an important client? Want to know all the dealings you’ve had with them for the last three months? Desktop Calendar will search through its electronic notebook and tell you. Want to know the address of an important business contact named ‘JONES’? Desktop Calendar will tell you that too.

Desktop Calendar is more than just a calendar for your computer. It will also keep track of appointments, hold addresses for easy reference and remind you of important events, even when you are busy working with another tool in the Lisa Office System.

Desktop Calendar will be available third quarter 1984 from Videx.

Circle 42 on reader service card
The Electronic Drafting Set

Danny Goodman

When you zoom in on a piece of MacPaint art with FatBits, you can grasp otherwise minuscule picture elements as easily as children's building blocks. MacPaint's power to reduce a person's field of view and control to a micro scale is one of the program's major attractions. What Paint lacks, however, is a macro scale—a comfortable way of working on shapes and objects that extend beyond the confines of the program's 3-by-5-inch drawing window. Apple's soon-to-be-released MacDraw gives you that capability. The program's practical electronic graphics and drafting tools enable you to produce
professional-looking graphics for business and college coursework applications in which pencils, rulers, and mechanical drafting tools currently reign supreme.

MacDraw is a direct descendant of the LisaDraw program used today by many architectural and design firms. LisaDraw's designer, Mark Cutter, has adapted this powerful program to the Mac, which is no small feat when you compare the memory constraints of the Mac against the half-megabyte capacity of the Lisa.
When you open *MacDraw*, it presents a window that contains an empty worksheet crisscrossed by a light background grid. The window shows a portion of the worksheet that corresponds to a printed area 5½ inches across by 3 inches down. If your document is larger than the screen size, you can use horizontal and vertical scroll bars to move the worksheet around within the window. You can reduce the worksheet scale so your field of view shows much more of your drawing. To display a standard 8- by 10-inch worksheet (the page size with which *MacDraw* starts up), you can choose among the 5½- by 3-inch normal-size view, an intermediate view (8 by 7½ inches), and a full-page view.

In each view size, you have complete control over the graphics images you create and manipulate. Therefore, if you need a "big picture" overview of your work area to lay out basic elements, such as headline and copy blocks of a magazine ad or boxes for an organizational chart, you can draw your images and shapes while looking at the entire page. Shortcuts on the Layout menu let you jump quickly from Normal Size to a selection called Reduce to Fit, which reduces the worksheet just enough for the entire worksheet to appear on the screen.

*MacDraw* is taking it easy when it works with a single-page worksheet. The size of a completed image can grow to a maximum of 96 inches across by 50 inches down—that's over 33 square feet of graphics worksheet. The size of your drawing is determined by the number of 8- by 10-inch pages you select from the Drawing Size dialog box (see Figure 1). You'll find out later how a printer handles these multiple pages.

**Rulers**

No drafting set would be complete without an accurate way to measure shapes and make sure they are true to scale for architectural or landscape blueprints, furniture layouts, circuit board design, and so on. *MacDraw* comes through in this area.

One of the program's most powerful attributes is its ability to display rulers continuously along the edges of the Normal Size window, while also offering you the option of customizing the rulers (see Figure 2). The features available to you in setting up rulers are numerous; you can create virtually any scale you want, which includes choosing interval markings, numbering increments, and indicating whether you want the ruler based on English or metric measure (see Figure 3). As you move the pointer around the screen, subtle marker lines along the rulers show you the precise horizontal and vertical location of the pointer (see Figure 2). The zero point of either or both axes can be adjusted to any point on the worksheet at any time while you are creating or editing a drawing.

As if that weren't enough, a function called Show Size produces on-screen horizontal and vertical measurements at the pointer location when you are creating shapes on the worksheet. The measurements are relative to the starting point of the shape being drawn and adhere to the scale of the rulers currently in effect. For example, say your rulers are set like those in Figure 3. If you drag the rounded-corner rectangle (located toward the lower-left corner of the screen) to stretch it in any direction, actual measurements appear on the screen next to the pointer, and they

---

*Figure 1*

You can select the size of your overall *MacDraw* document from the Drawing Size dialog box. Documents can range from 8 by 10 inches to 96 by 50 inches. Beneath the dialog box is a single 8- by 10-inch page, which is being used for an organization chart. Note the light grid lines, which signify 1-inch increments.
change dynamically as you move the pointer. Therefore, if you set up your rulers accurately to measure an office layout, you can easily create furnishings according to the manufacturer's dimensions. This Show Size feature makes you feel as if you're working with a Computer-Aided Design (CAD) system that costs thousands of dollars.

MacDraw's Grid function operates just like the grid in MacPaint, aligning shapes to the grid as they are created. But because of MacDraw's background grid, its Grid feature is much easier to use than MacPaint's, since you have more visual feedback about how the area of the screen in which you are working relates to other shapes and the rulers along the margins.

MacDraw Tools

Along the left margin of the MacDraw screen are icons for nine kinds of shapes and lines. The icons for straight lines, rectangles with square and rounded corners, ovals, freehand shapes, and polygons should be familiar to MacPaint users. Among the icons new to MacPainters are the T icon (Paragraph Text) and the cross icon. The cross generates constrained lines, producing straight horizontal or vertical lines no matter how far off the straight-and-narrow the pointer wanders. The orientation of the line (vertical or horizontal) is determined by the first movements of your pointer. Also noteworthy is the arc icon, which can be drawn to virtually any dimension and characteristic. The filled box with the arrow works like the marquee (selection rectangle) in MacPaint; it selects all objects within its boundaries (the outer boundaries of objects show up on the screen as tiny black squares).

Shapes in MacDraw are manipulated much differently than in MacPaint. When you use MacPaint to draw a square or a circle, the image instantly becomes a pattern of dots (pixels), and each dot takes up a small piece of the Mac's memory. But when you draw a circle in MacDraw, the program always regards that shape as a circle, with a list of attendant characteristics of size, proportion, fill pattern, and location. The geometry of the shape and its attributes are stored in memory, rather than the pattern of individual dots. Therefore, long after you've planted a shape on the worksheet, you can go back to it, select it, and massage it—making that circle bigger or changing it to an ellipse, for example. In other words, the program is object-oriented rather than bit-mapped; the shape's "circleness" is what is stored in the document.

Figure 2

MacDraw offers standard (in inches) and custom rulers to assist in drawing shapes. In this figure, the rulers have been customized so that each major interval is the equivalent of 4 units (feet). The small black boxes at the edges of the rounded-corner rectangle near the lower-left corner indicate the boundary for the shape. You can stretch the shape by dragging the small boxes. If you use the Show Size option from the Layout menu, the pointer shows the numbers of the horizontal and vertical measurements from the square's starting point as you drag its boundary.

MacDraw offers standard (in inches) and custom rulers to assist in drawing shapes. In this figure, the rulers have been customized so that each major interval is the equivalent of 4 units (feet). The small black boxes at the edges of the rounded-corner rectangle near the lower-left corner indicate the boundary for the shape. You can stretch the shape by dragging the small boxes. If you use the Show Size option from the Layout menu, the pointer shows the numbers of the horizontal and vertical measurements from the square's starting point as you drag its boundary.
One type of operation this graphics structuring method lets you perform is to overlay portions of several shapes on top of one another, while maintaining control over each shape. MacDraw lets you bring or paste shapes individually to the foreground, send them to the bottom of the pile, or even remove them entirely. Moreover, the Group option gives you the flexibility to select more than one shape at a time and then change the location or the attributes of the entire group.

You can also lock a selected object or a group of objects so they cannot be altered or erased mistakenly. Stretching a geometrically appointed shape is also much cleaner than performing the same operation on a bit-mapped shape in MacPaint. If you've ever stretched a shape in MacPaint, you've probably noticed that some lines or features of the shape become distorted as the image expands unevenly to an awkward size somewhere between normal size and twice normal size. That distortion can't occur in MacDraw, because only the boundaries of the shape are being stretched, not the bit map. When you release the mouse button to plant the new boundary, all other attributes of the shape—line thickness, pen pattern, and fill pattern—are restored, but according to adjusted size parameters.

This geometric characteristic of MacDraw shapes is actually built into the Mac. Therefore, when you import a MacDraw picture into a program such as MacWrite, you can stretch the picture without distorting it.

### MacDraw Text

Two text modes reside within MacDraw—Paragraph Text and Label Text—although you hardly think of them as separate modes when you use the program. The difference between the two is where you place text—inside or outside a shape.

Paragraph Text is the mode for placing text inside a shape. For example, one application of this mode is the preparation of a corporate organization chart. Once you've made the layout of boxes and reporting lines, you can then select a box and begin typing titles and names. You don't have to select the T (text) icon, because the program knows that if you select a shape and press a character key, you undoubtedly mean to insert text in that shape.

Text options from the Type menu include alignment (left, center, and right within the box), line spacing (1, 1½, and 2), type style (plain, bold, underline, italic, hollow, and shadow), and the option of changing letters to uppercase, lowercase, or initial capitals. The list of capitalization options is included in case the overall look of a drawing could be improved by emphasizing or de-emphasizing some of the text blocks. Text is automatically word wrapped within the boundaries of a shape. You can also select text in a drawing and rotate it as you would any other object.

Paragraph Text also has a number of interesting attributes that make it a useful tool for fine-tuning a drawing and creating dramatic effects. Since the text block has boundaries unique to itself, you can alter the location and the proportions of the text block separately from the shape in which it is typed (even removing it from the shape entirely). If you fill the shape with one of the 36 patterns available in the Fill menu, the pattern fill respects the area surrounding the text and leaves it plain for easy reading (see Figure 4).

---

### Scale of Ruler Dialog Box

The Scale of Ruler dialog box lets you create custom rulers. You can specify two levels of division and numbering increments. The zero point of either or both axes can be adjusted to any point on the worksheet.

<table>
<thead>
<tr>
<th>Ruler:</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zero Point:</th>
<th>Locked</th>
<th>Custom</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Major Division Spacing:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1 1/2</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of Minor Divisions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 8 10 12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Numbering Increments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 8 10 12</td>
</tr>
</tbody>
</table>
Moreover, you can fill the text block area with a contrasting pattern if you like. Finally, you can fill the text boundary with no pattern, making the background of the text completely transparent, to give the impression the text is “floating” on the fill pattern.

The Label Text mode controls the placement of text outside selected shapes. To assign text to the worksheet outside a shape, you select the T icon, at which time the pointer turns into a text pointer that operates like the text pointer in MacWrite and MacPaint. As you type label text, the boundary box of the text grows dynamically with it. You can select the text as a block with the marquee (even if it is only one line), and move the selection, fill the box, or extend the size of the boundaries, as with any shape.

MacDraw produces text in all the fonts available in the Mac’s System file or in fonts moved to that file from the Fonts file (via the Font Mover utility.) Font and font size are selected from a single pull-down menu, called Font. One limitation is that the menu is only long enough to list nine of the available fonts together with the eight different sizes. If you like to vary your fonts dramatically from document to document, you may need to move some fonts to your workdisk or, better still, create a couple of MacDraw startup disks with different font libraries in their respective System files.

MacDraw’s Intelligence
You’ll soon realize that MacDraw boasts a number of features that give it the powers of an expensive CAD system. A few not-so-obvious features confirm this impression.

One benefit of MacDraw’s geometric approach to shapes is that not only can you stretch a shape in a strictly horizontal and vertical dimension, but you can virtually redefine its boundaries. Whenever you create a polygon using the polygon tool, you can select a command from the Edit menu that lets you reshape it. Grasping one of the boundary markers with the pointer, you can shorten or lengthen the boundary, and overlap one boundary with another—as if all the sides were made of rubber bands.

Since in MacDraw and MacPaint it is easier for non-artists to draw in straight lines than in free-form curves, MacDraw includes a command that smooths any polygon or ragged freehand drawing; the program draws curved lines as tangents to each straight line it recognizes. Even after you smooth a polygon, you can reshape it as easily as if it were in its original form, because inside the program the shape is still a polygon, but with smoothing attributes (see Figure 5 for examples).

Figure 4
Across the top of this screen are three examples of the Paragraph Text mode. In the example on the left, the shape has been filled, but the text area is blank. In the middle shape, the text boundaries have been changed, the font size increased, the text centered within its boundary, and the text area filled with a lighter pattern. The rightmost example shows the text type changed to hollow and right justified, and the text area filled with the “None” option, so the shape’s fill pattern shows through. Label Text, shown at the bottom, can be filled (as it is here) or left blank.
MacDraw's Duplicate command in the Edit menu is a greatly enhanced version of what you have on the Mac desktop or in MacPaint. Not only does this program duplicate a selected shape (or multiple shapes, if selected), but it monitors the destination to which you drag and plant the second edition relative to the original. If you duplicate the copy, the third edition is automatically placed in the same position relative to the second edition. To create a row of bushes in a landscape layout, for example, you duplicate the first bush and place the copy a few scaled feet from the original. Then, since the copy is still selected, if you duplicate that one, its copy will be automatically placed the same distance away in the same direction from the second tree, and so on. Using the ²-d keyboard shortcut, you can plant a row of 20 bushes in a few seconds.

MacDraw also provides several options for formatting lines. The Line menu offers five width options and various arrows, which are convenient for creating diagrams. The Pen menu offers the same patterns as the Fill menu, but they are used only to fill lines and the borders of objects. The small box in the lower-left corner of the MacDraw document window shows the current Line and Pen pattern selections.

Another welcome feature of MacDraw is that you can open as many as four documents at once—although only one window will be active at any time. Still, if you have a library of architectural shapes in one document, for example, you can set up the windows so a strip along one edge of the screen gives you access to each of the shapes (see Figure 6). Whenever you need to reach into the stack for a shape, you select the shape in the library window, copy it into the Clipboard (called Scrap in MacDraw) with the Copy command (²-c), and paste it into the primary document you're building (²-v).

Figure 5
The edges of polygon A can be smoothed (as in shape B) by selecting the polygon and choosing Smooth from the Edit menu. In polygon C, two of polygon A's sides were stretched and overlapped. This new polygon was then smoothed (as in shape D). You can also reshape the smoothed polygons.

The exact number of documents you can open at one time depends largely on the number of individual shapes the documents have. The Mac's 128K memory can keep track of about 500 different elements with all worksheets entirely in memory. This capacity represents an advantage of the geometric tracking of objects as opposed to the bit-mapped method of MacPaint, which keeps much less than a full page of text in memory.

Printing
Transferring a potentially enormous drawing to the Imagewriter is not as complicated as it might seem. Only an 8-by-10-inch portion of an 8½-by-11-inch sheet is the active area. MacDraw prints multiple pages in columns. Therefore, if you have a large drawing that measures the equivalent of four sheets across and three down, the program starts with the first column of three sheets. Because of the active area restrictions, however, gaps occur when you print on continuous form paper. When printing is finished, you must separate all the sheets, trim them, and reassemble them with tape or rubber cement. MacDraw currently prints only with the Imagewriter. An architectural or design firm might appreciate MacDraw more if it could plot its blueprint-sized drawings on plotters designed for such large jobs.

Document Transfer
A number of MacDraw's features lead you to believe that you can create drawings on a macro scale for a document and then fine-tune certain elements with the detailing abilities of MacPaint. However, you are restricted in your ability to integrate the two programs; you cannot import MacPaint documents or picture segments into MacDraw. Therefore, you can't design a detailed library of shapes in MacPaint and use them in a MacDraw floorplan. Document transfer moves one way only: from MacDraw to other programs such as MacPaint and MacWrite.

Another built-in restriction on using MacDraw and MacPaint together occurs when you excerpt a picture from MacDraw to use in MacPaint. The MacDraw segment you transfer can be no larger than the MacPaint window if you want to retain the proportion and the size of the original. MacPaint takes a large picture from the Clipboard and reduces it to fit inside the MacPaint window.

When moving a MacDraw image to MacWrite, however, you can transfer a picture larger than the MacWrite display window. Furthermore, your adjustment of the picture's size and proportions doesn't distort fill patterns or the thickness of outlines, as happens when a MacPaint picture is stretched in MacWrite.
**Other Limitations**

*MacDraw* lacks a couple of features to which MacPainters may be accustomed. Most noticeable is the absence of an Undo command. Fortunately, many instances in which you would want to undo a move or another command are accommodated by the way *MacDraw* manages rulers and individual shapes.

If you stretch a shape in a way that displeases you, the rulers help you restore previous contours. And if you don't like the way a particular shape fits into your drawing, you can select it and delete it by pressing Backspace or *c*, while leaving all other shapes and text intact. *MacDraw*’s fill commands are not exclusive—you can change your mind about the pattern of a fill at any time. Still, there are times when an Undo command would be nice (particularly if you change your mind about something you irretrievably erased with the Backspace key). You will also miss having the equivalent of the eraser. If you want to remove something from a *MacDraw* worksheet, you must select an entire shape and delete it; there is no way to remove part of a shape, such as a line joining two rectangles to make them one.

An aspect of the program that shows up quickly and may be distracting to advanced users is that, because of its vast array of commands and because the picture is held entirely in memory, there are disk access delays when you jump around from command to command. Unfortunately, this is unavoidable until more memory is available for the Mac.

You may need some practice to work successfully with layers of shapes, as might be assembled in an architectural floorplan. In some cases, it is easy to select and move a large shape accidentally, when you really wanted a smaller, detailed shape within it. However, you can use the Lock option to freeze individual shapes into place to avoid destroying a finished area.

---

**Applications**

The combination of *MacDraw* and the Mac supplies students, engineers, executives, and others with a powerful graphics tool that works very differently from presentation graphics programs like *Microsoft Chart*. *Chart* transforms numbers into pictorial representations, but *MacDraw* turns ideas into pictures. The ability to see and manipulate the overall layout of even an enormous drawing is important for non-graphics-oriented people who want a computer like the Mac to assist them in creating truly professional-looking graphics to jazz up presentations. *MacDraw* is an excellent tool to help graphics novices create text and images for transparencies used in overhead projector presentations. In the hands of a trained draftsman, architect, or engineer, *MacDraw* produces practical and expert drawings with a minimum of effort. Publishing and advertising executives will be able to design rough layouts for magazines, newspapers, and advertisements in much less time and for far less money than by conventional means.

In the past, we've seen personal computer spreadsheet programs become work-saving tools for people who deal with ledger sheets. *MacDraw* gives this kind of computing power to anyone who uses a pencil and a straight edge to produce drawings.

---


---

*MacDraw*

Apple Computer, Inc.
20525 Mariani Ave.
Cupertino, CA 95014
800/538-9696, in California
800/662-9238
List price: $125
The DiskBank® Media Mate 3.

Introducing Media Mate 3... another affordable solution in micro diskette filing technology from DiskBank by Amray.

Media Mate 3 combines an attractive desktop appearance with the same superior protection, organization and storing capability made famous by the versatile and expandable DiskBank System 3.

Designed to organize up to thirty micro diskettes, Media Mate 3 includes a fortress of features:
- Sturdy, high-impact styrene construction
- Attractive smoke see-thru cover
- Convenient adjustable tab dividers
- Self-locking cover with easy carry handle
- Case-on-case stackability

Media Mate 3 or System 3. Both help you neatly build your diskette library while providing unbeatable protection. Make the little investment that pays off big. Buy a Bank. Buy DiskBank.

DISKBANK®
AMARAY
AMARAY CORPORATION
2251 Grant Road, Los Altos, CA 94022
(415) 968-2840, Telex 171627 Amray-Ltos

Circle 67 on reader service card
WITH MEGAHAUS, YOU CAN TURN YOUR MACINTOSH INTO SUPER MAC.

NOW! NEW, SUPER SOFTWARE FOR THE MACINTOSH!

Look! It's a bird! It's a plane! No...it's four super new programs from Megahaus Corp. Each one compliments the other to make your Macintosh into a super machine by forming a powerful, integrated system!

**MegaMerge**

MegaMerge is THE mail merge program for MacWrite! With MegaMerge, you can use MacWrite to create form letters, print mailing labels and more! You can even overcome MacWrite's limited document size by "chaining" several documents together and printing them as one, long document!

**MegaFiler**

If you do any filing at all in your home or office, you NEED MegaFiler! It's the file management system for the Macintosh that lets you file and retrieve information with EASE!

You can store names, addresses or other information using MegaFiler's library of ready-made files for:
- Mailing Lists
- Customer Orders and Invoices
- Home Management
- Business Inventory
- Customer Files
- And MUCH more!

You can also design your own files using MegaFinder's fun-to-use design file! You can also print lists, tables, mailing labels and MegaMerge mailing lists. You can even incorporate them into MacWrite and other Macintosh applications!

**MegaForm**

MegaForm is an easy-to-use forms and reports generator. You can use MegaForm to create actual-size forms and reports such as:
- Invoice Forms
- Order Forms
- Purchase Orders
- Expense Reports
- And MUCH more!

With MegaForm you can draw forms and reports exactly the way you want them to appear. It will also help you fill out the form just created, using MegaFiler. With MegaForm you can also draw, file, calculate and even sequentially number your forms!

**MegaDesk**

MegaDesk is something almost all of us can use. With MegaDesk, you get three desktop accessories...in other words, a program that you can run at the same time as other programs.

With MegaDesk you'll get:
- A Desktop "Appointment Book" which is a calendar that shows you month, day and date. Every day has its own page on which you can jot down information.
- A "Quicklook" accessory which gives you a brief look into any MegaFiler file on your desk.
- A Reference Card accessory which allows you to flip up a "window" containing any information you choose. We supply a complete library of reference cards and you can also add your own!

The Megahaus family of software products truly does make your computer work harder and easier. They can also turn a mild-mannered Macintosh into "Super Mac"...faster than a speeding bullet.

The Megahaus family of Software will turn your Macintosh into a "Super Mac".
Three Faces of the Mac

Three new office assistants help the Mac take over some tedious chores from workers

Bill Grout

Computers are great impressionists, able to take on different personalities depending on the application programs they run. From an electronic typewriter or an artist's easel to a pocket calculator or a game machine, the Macintosh imitates a different home or office appliance simply by changing software. Some recently released programs add new business roles to the Mac's growing number of identities.

ComputerPhone combines telephone book, dialing system, and billing clerk functions for the Mac. MegaMerge turns the Mac into a secretary pool that produces mass mailings. Habadex is a personal information system that organizes your time, keeps track of names and addresses, prints letters and labels, and dials phone numbers for you.

When you must refer to a phone book, you have two dialing choices left. One choice is a quick-call list for frequently used telephone numbers such as those of friends, relatives, and business associates, and emergency numbers for the police and fire departments. Up to 80 numbers are listed alphabetically by name in four pull-down menus. To make a call, you choose a name from a pull-down menu and MacDialer beeps out the number over the phone lines.

MacDialer also has its own phone book that holds up to 200 numbers listed by name and is useful for storing numbers less frequently dialed than those in the quick-call list. When you click on the book's button, a window appears on the screen displaying the list of names. To dial a number, scroll up or down the phone list, choose a name, and click on the Dial button. The phone book also stores and dials numbers for long-distance phone services such as MCI and Sprint.

The Electronic Phone Booth

MacDialer does more than turn your Mac into a miniature telephone booth. During a call, it displays the current time and the starting and ending times of phone conversations. If you wish, the program calculates the charges for a call and displays them on the screen as you talk. By keeping an eye on the mounting charges, you can conserve on your phone bill.

If you charge fees for time spent on the phone, MacDialer can document phone-to-phone consulting costs. When initially recording a client's number, you include an hourly fee rate. During calls, MacDialer tallies your fee and displays the increasing number on the screen. The program also provides a note pad that holds up to 12 lines for recording important ideas discussed during a call.

When you hang up and stop the timer, MacDialer automatically records phone charges, your fee, the length of the call, and any notes jotted on the note pad in a log stored on disk. The phone log provides a record of every conversation made with MacDialer, and can be viewed on screen and printed. This automatic archiving of phone call statistics is MacDialer's most outstanding feature.
These new products (left to right, ComputerPhone, Habadex, and MegaMerge) easily assume secretarial, telephoning, billing, information storage, and mass-mailing functions.

Various Hangups

The ComputerPhone unit mounts on the side of the Mac with Velcro so the phone can be easily attached or removed. This design saves space on your desk. Be sure to mount the phone on the side opposite the mouse, to keep the phone set's 15 feet of cord (approximately 7 feet are in expandable ringlets) from obstructing the desktop area where you move the mouse.

The phone equipment seems poorly made. It produces an annoying tapping sound when you lift it from the hook. Voice reproduction is clear, however, and I had no problems placing calls. But the phone did not sever the connection consistently when I replaced it in the phone base; evidently the handset isn't heavy enough to depress the hang-up button. More than once I left the room and returned to hear the "scatter" tone that means the phone has been left off the hook.

MacDialer took me less than 15 minutes to learn, but the system doesn't replace the common Rolodex for providing quick access to phone and address information. The program takes longer to load on the Mac than it usually takes you to flip through a card file and dial a number yourself.

Although its 135-year calendar displays three months at once and can be used to schedule appointments, MacDialer records only names and phone numbers and doesn't provide space for other information routinely recorded in Rolodex-type card systems. Nor can MacDialer link up with computer modems,
which means you have to maintain another dialing directory for data communications.

*MacDialer* is probably best suited for people who sit for hours before the Mac, running applications and frequently making phone calls. The program is more a phone timekeeper than an information system. Because it often may be awkward to quit one program and load *MacDialer* to make a call, you might not use it enough to get your money's worth.

**MegaMerge**

*MegaMerge* enables you to print form letters repetitively for mass mailings. You can write a form letter in *MacWrite* and print numerous copies that have different names, addresses, and salutations, for example, substituted in each letter. You might like to mass-produce a yearly holiday letter for relatives and friends, or to print billing notices or letters to an organization's entire membership. *MegaMerge* switches information to the correct spots in the letter and prints copy after copy.

To use *MegaMerge*, you create two *MacWrite* documents: a form letter and a specially coded address list. You place code words such as Name, Address, and City in the letter wherever information is to be substituted. Codes are designated by being typed in a font different from the letter's text. You can plant as many codes as there are *MacWrite* fonts in a single letter.

In one letter a code might transfer a single word and in the next several sentences. To extend the illusion of "personalized" correspondence, you might code a personal sentence or two into the computerized letter.

**Making a List**

To create a mailing list, you use the same codes as in the letter, setting codes by typing in the same font or by putting a dollar sign in front of each code (so you don't have to remember which code font you used). End each code with an equal sign followed by the information to be substituted (see Figure 2).

The key to *MegaMerge* is setting up codes properly. A frequent problem in merging a letter and an address list is misspelling a code or using the wrong font. Errors in codes stop the printing process, forcing you to return to *MacWrite* to correct mistakes. Coding letters and lists may take several trials if you're new at the process; initially, I made simple coding mistakes in switching between fonts and in trying to make codes two words long. They must be a group of characters with no space in between.

To avoid coding mistakes, you should create one code set, try it out on a test letter, and simply copy it as many times as needed. When the codes are set up, fill in the address information, like filling blanks in a form.

*MegaMerge* uses the Mac's pull-down menus for printing selections, which makes it easy to use, and comes with ample documentation. In addition, the program can be copied conveniently onto a *MacWrite* disk. Its copy-protection method, however, requires you to insert the original *MegaMerge* disk in the computer, like a key in a lock, before the program will run. To print letters, you load *MegaWrite*, designate the file names of letter and list, specify the font used for the code, and tell the program to start printing. *MegaMerge* divides the Mac screen in half and shows the letter text in one window and the list in the other. This double display lets you confirm that you've matched the letter document with the correct address list (see Figure 3).

**The Long Wait**

*MegaMerge*'s printing process emphasizes one of the Mac's greatest weaknesses—it's slow disk access. After you instruct *MegaMerge* to start printing, it composes a letter and then saves a copy on disk. After printing the first letter, it composes the second, and relays it to the disk before printing. The intermediate step of saving a newly composed letter to disk takes a long time—about 20 seconds per letter.

To print a moderate-sized mailing of 60 letters, for example, you'll lean on your elbow for a total of 20 minutes during disk accessing. This figure excludes the time required to print each letter. The manufacturer claims that the program's method of disk spooling is the same as *MacWrite*'s and difficult to avoid. This feature also makes *MegaMerge* unsuitable for printing long lists.

Mailing lists age quickly. Addresses and residents change, but a list must evolve with the community it represents. Because the *MegaMerge* list is a *MacWrite* document, you must use word processing pro-

---

**Figure 1**

One of five ways you can dial phone numbers with *MacDialer* is by clicking out a number on the telephone keypad representation that appears on the screen.

**Figure 2**

A set of codes is used with *MegaMerge* to transfer names and addresses to a form letter. $NAME$, $ADDRESS$, $CITY$, and $DEAR$ are code words. John Brown's name, address and the salutation "John" will appear in the printed letter. You type different information after the equal sign of each code, and you can substitute different amounts of information as well.
When it comes to list maintenance, *MegaMerge* offers no help. The makers of *MegaMerge* are working on *MegaFiler*, which allows you to create and maintain lists as data bases, but until the new program appears, avoid creating long address lists with *MegaMerge*. In addition, Megahaus product managers plan to improve printing speed and enhance *MegaMerge* to run with *MacPaint*. For small personal mailings, *MegaMerge* works fine, but it is cumbersome for mailings even as small as 100 letters.

**Habadex**

If your schedule is so full that your hands never rest, and you're tired of badgering your secretary to find out the time and the purpose of your next meeting, *Habadex* may make your day. This program collects and stores frequently used business or personal information. It replaces three organizational essentials: the appointment book, the name-and-address card file, and hastily scribbled lists of things to do. *Habadex* imitates the ease of use of traditional appointment books, calendars, and Rolodex-type systems. If you've mastered the paper versions, you can start using *Habadex* literally in minutes.

For people unfamiliar with computers, *Habadex* displays on the screen pictures of an address book and an appointment book (see Figure 4). You open the books and find information with the mouse just as you flip through a real address book by hand. *Habadex*’s directory holds names, addresses, phone numbers, company names, notes, and miscellaneous information for up to 500 friends, clients, and business associates. Its appointment book is a working calendar in which you record the subject and times of meetings, reminders, traveling expenses, things to do, and even a list of special occasions such as birthdays and anniversaries.
**Added Features**

If Habadex only recorded information the way usual address and appointment books do, you could do as well with the paper versions. But Habadex gives you greater control over information and provides conveniences that only computers can offer.

The directory, for example, can dial a phone number for you. Along the directory’s right edge, tabs appear in alphabetical order. To dial a number for someone whose last name is "Grant," you use the mouse to click the directory’s G tab. A list of names beginning with G and corresponding home and business phone numbers appears instantly (see Figure 5). If you click on Grant’s phone number and choose the menu item Dial, the Mac dials the number on your phone (which must be hooked up to the Mac’s audio jack with the Habadex adapter).

To check an address, you click on the name instead of the phone number, and Habadex displays information that you might find on a file card. This process is called *zooming in* on a record and provides easy information access that takes the bother out of typing search criteria.

To record new directory information, you click on a directory tab marked New Entry. A screen appears that resembles a fill-in-the-blanks business form. Completing a record is as easy as moving the cursor from blank to blank and typing information.

Habadex’s Arrange menu enables you to reorder the directory in eight different ways. The directory’s cover tells you how the information is currently set up (see Figure 5). If you rearrange your information from last name to zip code, for example, the side tabs display numbers instead of letters.

**Tracking Your Appointments**

The Habadex appointment book tells you the time of your next meeting and the tasks you need to do. It holds a year’s worth of appointments. Down the appointment book’s side run tabs listing the months of the year. To open the book, you use the mouse to click on the desired month’s tab. A traditional calendar appears, showing the first two appointments in each day’s calendar square (see Figure 6). Travel schedules also appear on the calendar to let you know where you should be on a given day.

---

**Figure 5**

*After you click on a tab on the Habadex directory, a list appears with names and corresponding phone numbers you’ve recorded that begin with the letter (in this case, G). If you click on one of the phone numbers and choose the menu item Dial, the Mac dials the number on your phone.*

<table>
<thead>
<tr>
<th>Name</th>
<th>Category</th>
<th>Business Phone</th>
<th>Home Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant, Gary</td>
<td></td>
<td>1223-11234</td>
<td></td>
</tr>
<tr>
<td>Grout, Bill</td>
<td></td>
<td>472-7183</td>
<td>472-7183</td>
</tr>
</tbody>
</table>

**Figure 6**

*A calendar for the month appears after you click on the tab for that month on the right side of the Habadex appointment book. A day’s first two appointments are listed in each day’s calendar square, with travel destinations listed below the square. You can see a whole day’s schedule in detail by clicking on the corresponding calendar square.*
Letters and Mailing Labels

Information isn't much good unless it's applied, and Habadex helps you do that. You can use the directory information to print labels, lists, and letters. Habadex can print labels for mass mailings, and permits you to design the label format and designate whether labels are printed one, two, or three across on a sheet. To set up labels for printing, you simply use the mouse to position labels on the screen as you want them to appear on paper.

After specifying the layout for labels, you tell Habadex which records to print. If records are ordered by last name, for example, you can tell the program to print all the records from A to Z, or some partial listing such as “Grant” to “Green.” Habadex also enables you to print selected information from the directory in lists.

For mass mailings, you can merge form letters with a Habadex address list. Create a letter in MacWrite, leaving out the address information to be substituted in each letter. Then copy the letter to the Clipboard and load Habadex, which enables you to specify a list of address records and print the letter repeatedly while addressing it to a different recipient each time.

Certain limits exist for Habadex's mass-mail printing. A letter can be only one page long, and you cannot substitute information in the body of the text. Habadex prints address information only at the top of each letter. The program automatically prints a date at the top of the letter and prints text in justified format. In the current version, the date and text justification can't be avoided. Still, the ability to print MacWrite documents with directory information is an attractive feature.

Habadex brings out some of the Mac's best qualities. You can learn most of the program by looking at the screen and rely on the documentation to learn the finer points. The screen images of the directory and the appointment book allow you to grasp the program's use without much knowledge of computers.

Computers can't do every job better than people can. Although software developers are eager to produce products, some programs are not worth buying. The real test of a program is whether it can do a job that you couldn't do before, or do a job better than you can. Habadex effectively automates desk organization aids. Computer-Phone and MegaMerge each have a more narrow focus; make sure that they correspond to your work routines before you buy them.

Bill Grout reviews software for the San Francisco Chronicle and is a coauthor of Word Processing with the IBM PC.

ComputerPhone
Intermatrix, Inc.
5547 Satsuma Ave.
North Hollywood, CA 91601
818/985-2922
List price: $199.95

Habadex
Haba Systems, Inc.
15154 Stagg St.
Van Nuys, CA 91405
818/901-8828
List price: $199.95

MegaMerge
MegaMaus Corporation
5703 Oberlin Dr.
San Diego, CA 92121
619/450-1230
List price: $125
Our engineers have designed the most advanced personal computer modem your money can buy. And then we’ve added the right software to make it absolutely simple for you to communicate with your Macintosh or Lisa.

The modem is our new Hayes-language LSI 300/1200 Smart-Cat PLUS™. It’s better right from the first step with faster more accurate dialing. An automatic self-test checks out the entire communications loop including the modem on the other end. You get the last word in LSI circuitry. And more.

The software is MITE™. It’s menu-driven, telling you exactly what to do at each step.

No mysteries. It checks itself out to make sure what you send is exactly what is received at the other end. And you can have easy, instant access to Dow Jones, CompuServe and the like.

The price is right, too. At $499, it’s a lot less than you might expect.

Your computer dealer has the new Cat system now. Ask for a hands-on demonstration and discover how nice simple really is.

Novation, Inc., Box 2875
20409 Prairie Street, Chatsworth, CA 91311 (800) 423-5419.
In California: (818) 996-5060

$499 Cat for your mouse.
New Products For Macintosh

MacPUBLISHER
Mac 1200 MODEM PAK
Mac SUPER MODEM PAK
Mac-NET STARTER PAK

Also announced today was the formation of a new online service especially for Macintosh users, called DELPHI Mac-NET PAK.

MacPUBLISHER
Newsletter Layout / Pasteup
Software for Macintosh...

MacPUBLISHER is a text and mixed graphics editing system that produces multi-column newsletters, reports, product price lists, etc. Overcoming certain limitations of MacWrite and other word processors, MacPUBLISHER allows several articles to be on the desktop at the same time. Articles (text or pictures) may be dragged to a MiniPage (40x scale) where they are laid out automatically in their chosen widths. Articles 'wrap' to the next available column or they may be continued to inside pages. When front page text is re-edited, the page jump adjusts accordingly. Full, 2/3, 1/2, or 1/3 page headlines may be inserted freely.

Standard size Imagewriter printouts may be directly offset or photocopied for small-volume publishing. 'Oversize' printing options (125%, 150%, and 200%) use larger Macintosh fonts, and may be photo-reduced before printing for better image quality. A unique 'Ruler' desk accessory measures text in inches, point-size lines, or pixels. The Clipboard is supported to cut to and from MacPaint, or spreadsheets and graphics packages like Microsoft's Multiplan and Chart. All the current Macintosh fonts, styles, and sizes are supported, but they may only be changed for complete lines of text.

MacPUBLISHER is not a textsetting front end for communications to a typesetter. It is a complete text and graphics layout package for organizations that are satisfied with the quality of Macintosh fonts and QuickDraw pictures for small-scale publishing. $99.95

Mac 1200 MODEM PAK.
A complete communications package containing a 300/1200 baud, auto-answer, auto-dial, an intelligent modem with all the features needed in a smart modem and more (with LEDs and a cable that fits the Macintosh). The Mac 1200 MODEM PAK also has communications software that allows terminal emulation, transferring of files, uploading and downloading of software, auto-logon and auto-redial. Also included is a lifetime subscription to DELPHI Mac-NET, with two free hours use of that service, plus documentation. $349.95

Mac SUPER MODEM PAK.
A 300 baud, direct-connect modem with telephone cord, cable, with communications software that allows terminal emulation, transferring of files, uploading and downloading of software. Also included is a lifetime subscription to DELPHI Mac-NET, with two free hours use of that service, plus documentation. $129.95

Mac STARTER PAK.
A lifetime subscription to DELPHI Mac-NET, with two free hours use of that service, plus documentation. $39.95

DELPHI Mac-NET
Has all the features you'd expect from a full featured information utility: MacBB, a collection of bulletin boards for Mac users. Maccompare, a software and peripherals configuration program which accesses files with the latest product features and pricing information to help you get the most for the money you spend on your system. Macvote gives you a consensus on how all users feel about everything affecting the world of Macintosh. Macatalog, a collection of things you can order online for your system. Not just securities prices, but place buy and sell orders, any time, day or night. Complete airline schedules and reservations.

Full featured electronic mail, including Mailthru (tm), letting you send electronic messages to subscribers of other services. Telex and other paper-based messages to anywhere in the world (with mail list management features).

The world's largest collection of online databases (Lockheed's Dialog), featuring vast searchable files on everything from finance to marketing to engineering and research.

- $6.00 AN HOUR EVENINGS AND WEEKENDS.
- NO EXTRA CHARGE FOR 1200 BAUD SERVICE.
- NO MONTHLY MINIMUM FOR CREDIT CARD CUSTOMERS.

MacBuff Printer Buffer to be announced. See next issue of THE MAC STREET JOURNAL.
Macware News

The latest developments in Macintosh software, hardware, and accessories

Edited by Erfert Nielsen

Macware News announces new Macintosh products. Those listed here are available now or will be in the near future. We will keep you informed of developments as the number of products for the Mac increases.

Software

• American Training International
  12638 Beatrice St.
  Los Angeles, CA 90066
  213/823-1129

  MacCoach
  An interactive training program that simulates various Macintosh functions to teach beginners how to use the Mac. The program consists of two disks and a handbook. Instructions cover topics such as using the keyboard and the mouse; viewing the contents of a disk; managing information on the desktop; and copying, saving, and printing documents. List price: $75.

• Ann Arbor Softworks, Inc.
  308½ S. State St.
  Ann Arbor, MI 48103
  313/996-3838

  Animation Toolkit
  A program that allows you to construct animation sequences and run them on the Mac screen. The animation occurs as you construct the images, which can be saved on disk. The images are created in an environment similar to MacPaint's FatBits, and they can be cut, copied, pasted, rotated, and resized. Sample programs are included that show programmers how to incorporate the images into BASIC and Pascal programs. List price: $49.95.

  Laser Hopper
  An arcade-style game in which you use the mouse to guide the Hopper on a 3-D playing surface, as it seeks out and destroys enemy "glipzoids" while avoiding lasers and other hazards. You can set parameters including thrust, gravity, and surface friction. List price: $39.95.

  Lunar Explorer
  An animated game in which you attempt to land a spaceship on increasingly hazardous lunar surfaces. Each successful landing adds fuel and increases the level of difficulty. You use the mouse to control thrust and pitch, and click the mouse button to fire the engine. List price: $39.95.

• Apropos Software, Inc.
  64 Hillview Dr.
  Los Altos, CA 94022
  415/948-7227

  Personal Financial Planning
  A series of financial planning programs that run with Multiplan. The following programs are available: Real Estate Property Planner ($49.95), Life Insurance Planner ($39.95), Education Fund Planner ($29.95), Automobile Purchase/Lease Planner ($29.95), Home Budget ($29.95), Personal Financial Statement ($29.95), Stock Portfolio Planner ($29.95), and Loan Planner ($29.95).

• Basic Business Software, Inc.
  P.O. Box 23311
  Las Vegas, NV 89126
  702/876-9493

  Utilities
  A disk containing eight Microsoft BASIC (MBASIC) programs for Macintosh software developers. You must have the MBASIC interpreter for the Mac to run these programs. Typex displays ASCII files; Dump displays both the hexadecimal and ASCII values of a file; Remove allows you to remove files without using the Mac's trash can icon; Xref cross-references...
MBASIC programs; List prints ASCII files on the printer; Set baud allows you to set a baud rate; Rename lets you rename a file without returning to the Finder; and Transfer enables you to transfer ASCII files to the Mac via the communications port. List price: $45.

Blue Chip Software
6744 Eton Ave.
Canoga Park, CA 91303
818/346-0730

Baron
A real-estate investment simulation game for one player. You begin with $35,000 and attempt to make a million dollars by speculating in the real-estate market. One session covers 60 weeks of activity. Each month you review the newspaper, examine mortgage-rate trends, and buy or sell various commodities. The game becomes more sophisticated as your net worth increases. List price: $59.95.

DataPak Software, Inc.
14755 Ventura Blvd. #1-774
Sherman Oaks, CA 91403
818/905-6419

Mac-Jack
An animated blackjack game for one player. You use the mouse to move chips onto the table for placing bets and to call for a hit or stand pat. Options include pair splits, double down, and insurance. The betting limit increases as play progresses, and high scores are saved and displayed. List price: $39.95.

DeskTop Software Corporation
228 Alexander St.
Princeton, NJ 08540
609/924-7111

1stBASE
A relational file-handling and report-writing system. The program features user-defined file formats, help messages, and sorting on up to ten keys. File size is limited only by disk space. Reports can be written from individual files or from multiple files joined on a common field. List price: $195.

Dow Jones Software
P.O. Box 300
Princeton, NJ 08540
800/257-5114, 609/452-1511

Spreadsheet Link
A program that uses the Straight Talk communications program to load information from the Dow Jones News/Retrieval service into Multiplan spreadsheets. This feature allows you to perform numerous financial calculations without...
having to enter the figures by hand. For example, rather than typing current stock quotes into a spreadsheet, you can download the quotes and then perform calculations on the information. List price unavailable.

**Straight Talk**
A communications program that enables the Macintosh to access the Dow Jones News/Retrieval service and other online databases. The program also allows you to send and receive documents between the Mac and other computers and to send and receive MCI mail messages. *Straight Talk* supports MacWrite, as well as the Mac’s Note Pad, Scrapbook, and Clipboard, allowing you to download, edit, and save information. List price unavailable.

**Empress Technology Inc.**
510 King St.
Littleton, MA 01460
617/486-9601

The Empress
A relational database management system and report generator. The Empress can manage an unlimited number of records and sorts up to 1000 records per second. List price: $200.

**Hayden Software Company**
600 Suffolk St.
Lowell, MA 01853
617/937-0200

**daVinci**
A series of illustrations that can be used by architects and interior designers, as well as by individuals who want to plan a room or an office layout, design a house, or landscape a yard. Each disk contains several hundred images that you can copy to the Scrapbook and paste into a drawing. You can then use standard MacPaint features such as FatBits, Flip, Rotate, enlarging, reducing, and the various drawing tools to customize the drawing. Three disks—Buildings, Interiors, and Landscapes—are available now, and others will follow. List price: $49.95 each.

**Lewis Lee Corporation**
1646 Portola Ave.
Palo Alto, CA 94306
415/853-1220

**Bank President**
A game designed to teach the fundamentals of business strategy through role-playing. As the chief executive of a bank, players formulate strategies and make business decisions. One player can play against the computer, or several players can compete with each other. Players choose the type of bank they want to manage, set loan and deposit interest rates, raise or lower salaries, open or close branch offices, and manage the bank’s investment portfolio. The game uses a variety of charts and graphs to keep players informed about the bank’s condition, competitors’ actions, and the state of the economy. List price: $74.95.

**Magnum Software**
2115 Devonshire St. #337
Chatsworth, CA 91311
818/700-0510

**McPic!**
A disk containing 130 pictures that can be pasted into MacPaint or MacWrite documents. The pictures are arranged in the following categories: animals, astrology, business, fun, holidays, home, money, nature, people, sports, symbols, and transportation. List price: $49.95.

**Mead Data Central**
9393 Springboro Pike
P.O. Box 933
Dayton, OH 45401
800/227-4908

**Communications Software**
Software that provides 1200-baud, asynchronous access to NEXIS, LEXIS, and other Mead Data Central information retrieval services. The NEXIS database contains the full texts of more than 100 newspapers, magazines, professional journals, newsletters, and wire services. LEXIS is a computer-assisted legal research service. List price: connect time $20 per hour plus telecommunications...
costs for reading, scanning, and printing on line; searches $9 to $18 depending on the value and amount of information in the file being accessed (search prices are reduced by half during off-peak hours); call the above number for software price information.

**Megahaus Corporation**

5703 Oberlin Dr.
San Diego, CA 92121
619/450-1230

*Merge*

**price: $195.**

**6191450-1230**

The number of records per file is limited only by disk space. 
**Omnis 2** is upwardly compatible with **Omnis 3**, a data base management system that supports as many as 12 open files at a time. 
**Omnis 3** operates as a relational or a hierarchical data base. The program provides flexible screen and report formatting and user-defined entry sequences. **List price:**

- **Omnis 2** $195, **Omnis 3** $295.

**Nexa Corporation**

P.O. Box 26468
San Francisco, CA 94126-6468
415/387-5800

**Scheduling and Billing**

A desktop calendar and client-billing system that allows you to enter appointments and other information and keep track of billable time. You select and open a single day from the program's displayed calendar in order to enter or view information. This program is one of six packages in Nexa's Accounting System software series. Information can be transferred from one Accounting System module to another, as well as into Multiplan spreadsheets. **List price: unavailable.**

**Xyphus**

A fantasy role-playing game consisting of a series of scenarios with characters that continue from one to the next and encounter a wide variety of spells, weapons, and monsters. Each scenario takes a few hours to play, and all are linked together into a larger game. **List price: $39.95.**

**PC to Lisa/Mac Communications**

Communications software that enables you to transfer text files between the IBM PC and the Macintosh or the Lisa. The package includes an RS-232C cable and a source code for file transfers. **List price:** $100.

**Penguin Software**

830 Fourth Ave.
P.O. Box 311
Geneva, IL 60134
312/232-1984

**Pensate**

A game for one or two players in which you try to get to the top of an 8-by-8 grid while avoiding all other playing pieces. Each of the ten types of adversary pieces moves in a distinct pattern in relation to your moves. As play continues, more pieces appear on the board. **List price:** $39.95.

**Construction Estimator**

A software package that you use with Multiplan to calculate construction costs such as percentage of money expended on a job, completion percentages, cost differences between suppliers, and savings realized by item. The package calculates bid items, contract labor, appliances, and other details that can affect cost accounting for bidding. **List price:** $69.95.

**Omnigraf**

A personal financial management package that allows you to set up as many as 120 record-keeping categories of five different types: assets, liabilities, expenses, income, and checking. You can assign budgets, enter transactions automatically or manually, automatically issue preprinted checks, and produce a variety of reports and graphs. Three sample record-keeping categories—personal, tax preparation, and small business—are provided on disk to help you get started. **List price:** $149.95.

**Organizational Software Corporation**

2655 Campus Dr. #150
San Mateo, CA 94403
415/571-0222

**Omnis 2 and Omnis 3**

**Omnis 2** is an information management system that includes the following features: user-defined records, error checking by means of a wide range of logical functions and operators, global update and delete facilities, record retrieval on up to 50 selection criteria, and mail-merge capabilities.

**Xyphus**

A fantasy role-playing game consisting of a series of scenarios with characters that continue from one to the next and encounter a wide variety of rolls, weapons, and monsters. Each scenario takes a few hours to play, and all are linked together into a larger game. **List price:** $39.95.

**Pterodactyl Software**

200 Bolinas Rd. #27
Fairfax, CA 94930
415/485-0714

**PC-BASIC Compiler**

A BASIC compiler that is compatible with the BASICA compiler for the IBM PC. The Lisa version is available now, and two Macintosh versions are in development: the first will cross-compile from the Lisa to the Mac (using the Workshop supplement for development of Mac software on the Lisa), and the second will compile and run on the Mac. The PC-BASIC compiler generates a 68000 assembler file and an EXEC file; you run the EXEC file and it automatically links your program, creating an executable object module. **List price:** single user-in-house use $250, runtime license $750.

**Construction Estimator**

A software package that you use with Multiplan to calculate construction costs such as percentage of money expended on a job, completion percentages, cost differences between suppliers, and savings realized by item. The package calculates bid items, contract labor, appliances, and other details that can affect cost accounting for bidding. **List price:** $69.95.

**Omnigraf**

A personal financial management package that allows you to set up as many as 120 record-keeping categories of five different types: assets, liabilities, expenses, income, and checking. You can assign budgets, enter transactions automatically or manually, automatically issue preprinted checks, and produce a variety of reports and graphs. Three sample record-keeping categories—personal, tax preparation, and small business—are provided on disk to help you get started. **List price:** $149.95.

**Organizational Software Corporation**

2655 Campus Dr. #150
San Mateo, CA 94403
415/571-0222

**Omnis 2 and Omnis 3**

**Omnis 2** is an information management system that includes the following features: user-defined records, error checking by means of a wide range of logical functions and operators, global update and delete facilities, record retrieval on up to 50 selection criteria, and mail-merge capabilities.
Mac-Slots
A disk that contains two games: Keno and a slot machine. You use the mouse to select numbers on the Keno board and to deposit coins in the slot machine and pull its handle. Your betting limit increases as the game progresses (and as you order more cocktails from one of the game’s menus). High scores are recorded and displayed. List price: $77.77.

TK!Solver
An equation processing program for engineers, scientists, financial analysts, educators, and other professionals who use equations or mathematical models. TK!Solver allows you to solve for any unknown variable in an equation without restating the problem. The program handles sets of simultaneous equations, solves for a variable located on either side of an equation’s equal sign, and offers iterative solving, unit conversion, list solving, and table and plot generation.

TK!SolverPack application programs for mechanical engineering, financial management, and introductory science are also available. List price unavailable.

DB Master Macintosh
Version
A database management program that includes on-screen prompts, computed fields, ascending and descending sorts, a built-in report generator, and a browse capability that enables you to view numerous records simultaneously. The program can display different font styles and sizes, and a file can span multiple disks. List price: $195.

Filevision
A filing system that enables you to attach data files to drawings that you create. You first draw an object on the screen, then type in information about that object. For example, you can draw a map of the United States, entering information for each state as you draw it. You can later access this information by clicking on a specific state. You can rearrange fields using the mouse, modify any of the program’s 20 pre-drawn symbols, and print graphics, reports, and mailing labels. List price: $195.
Printer Optimizer
A 64K print spooler (expandable to 256K) that enables you to connect up to three printers to the Macintosh at one time. The Printer Optimizer translates data from the Mac into data that can be used by any printer, including letter quality. Serial printers, parallel printers, and plotters can be connected to the Mac in various combinations. The Printer Optimizer allows you to store and print multiple copies of documents, and to continue to work at the computer while a printer is in use. Instructions to make MacWrite compatible with a letter quality printer can be entered at the Printer Optimizer’s keypad or loaded into MacWrite from a disk (available for $24.95) and transmitted to the print spooler. List price: two printer connections $598, three printer connections $648.

Mac Barcode
A system that enables you to print bar code labels on the Imagewriter and to read bar codes with a light pen or a laser scanner. The labels meet the requirements of the automotive, health care, food processing, and packaging industries. The system consists of the Mac Barcode disk, which converts alphanumeric data into bar code, and the Scanstar-Mac, a bar-code reading device that automatically distinguishes six of the most commonly used bar codes. Either the Pen Reader (a light pen that you move across the bar code) or a handheld laser gun can be attached to the Scanstar-Mac. List price: Mac Barcode disk $395, Scanstar-Mac $445, Pen Reader $150, laser gun $1695.

Mac Switch
A switch box, a cable, and software that enable you to connect the Macintosh to a Brother HR-15, HR-25, or HR-35 letter quality printer. The switch box allows the Brother printer and the Imagewriter to be connected to the Mac simultaneously; flipping the switch activates one printer or the other. The LetterWare disk included with the package contains a file that, when copied to a MacWrite disk, lets you select letter quality printing. MacCable, a package containing a printer interface cable and the LetterWare disk, is also available. List price: MacSwitch $249, MacCable $129.
CineMac
A Macintosh with an added video port that allows screen images to be sent to an external monitor with a larger screen, for use in teaching, training, or demonstrations. CineMac is available as part of a system that includes the Mac, the ImageWriter, and the Accessory Kit, or it may be purchased separately as an upgrade kit and installed by an authorized Apple dealer. The video signal can be displayed on most single-color video monitors with a horizontal scan rate of 22 KHz or higher. A list of compatible monitors is available from MicroGraphic Images. List price: complete system $3255, upgrade kit $195.


Mach 2
A large-screen video projection system that displays a high-resolution picture on a flat or curved screen measuring up to 20 feet across. The projector can be attached to a ceiling or mounted on an optional cart. The Mach 2 system consists of a custom interface, a projector, a 6-foot screen, cables, and a handheld light pointer. List price: $6495.

Purchasers of Mach 1 and Mach 2 video systems must ship their Macs to Professional Data Systems' video labs, where the video interface will be installed.

Accessories

Computer Cover Co.
P.O. Box 3080
Laguna Hills, CA 92654
714/380-0085

Dust Covers
A set of nylon covers for the Macintosh, its keyboard, and the ImageWriter. The covers help protect the system from spilled liquids and dust accumulation, and are available in red, blue, black, brown, beige, and rust. Your company's name and logo will be printed on the covers at no extra charge with a minimum order. List price: $30.

East/West Leather
1400 Grant Ave.
San Francisco, CA 94133
415/397-2886

Carrying Bag
A leather carrying bag for the Macintosh. The bag has a padded lining, a shoulder strap and carrying handle, a slot for the keyboard, pockets for the mouse and accessories, and a zipper pocket in the lid. It is available in black, brown, and tan. List price: $229.

Express Computer Supplies
2215-R Market St. #292
San Francisco, CA 94114
415/864-3026

Colored Ribbons
Ribbon cartridges for the ImageWriter printer. The nylon ribbons, manufactured by American Ink, are available in red, blue, green, yellow, brown, and purple. List price: $7.20 each, or $7 each in quantities of 12 or more.

Information Concepts, Inc.
P.O. Box 462
Stone Mountain, GA 30086
404/979-8479

Micro-Disk-a-Do
A plastic carousel 9 inches in diameter that holds up to 30 micro-floppy disks. The disk holder rotates on a base plate and has numbered slots for indexing disks. List price: $29.95.

Inland Corporation
32051 Howard Madison Heights, MI 48071
800/521-8428

Macsivvel/Mactilt
A plastic holder on which the Macintosh can swivel 360 degrees and tilt upward 25 degrees. Adjusting the angle of the screen reduces glare, and swiveling allows a second viewer to see the screen easily. List price: $34.95.

I. & R. Associates
2000 Rock St. #19
Mountain View, CA 94043
415/968-9504

MacRack
A desktop organizer for a complete Macintosh system including the Mac, keyboard, mouse, modem, printer and paper supply, and external disk drive. The system components are stacked on a chrome-plated, welded-steel wire rack that collapses for shipping and storage and can be assembled without tools or fasteners. MacRack measures 16 1/2 W by 21 H by 12 1/4 D inches when assembled. List price: $79.

Micro Products Company
2210 N. 45th St.
Seattle, WA 98103
206/632-1524

Micro/File 40
A disk organizer that holds up to 40 micro-floppy disks in individual track slots. Micro/File 40 has an off-white base and a smoke-colored acrylic top. List price: $27.95.

Sharp Color
400 N. High St., Box #175
Columbus, OH 43215

Colored Ribbons
Ribbon cartridges for the ImageWriter printer. The high-resolution carbon/polyethylene film ribbons are available in red, green, blue, brown, and black. List price: $10 each (minimum order: 2).

Express Computer Supplies
2215-R Market St. #292
San Francisco, CA 94114
415/864-3026

Colored Ribbons
Ribbon cartridges for the ImageWriter printer. The nylon ribbons, manufactured by American Ink, are available in red, blue, green, yellow, brown, and purple. List price: $7.20 each, or $7 each in quantities of 12 or more.

Information Concepts, Inc.
P.O. Box 462
Stone Mountain, GA 30086
404/979-8479

Micro-Disk-a-Do
A plastic carousel 9 inches in diameter that holds up to 30 micro-floppy disks. The disk holder rotates on a base plate and has numbered slots for indexing disks. List price: $29.95.

Inland Corporation
32051 Howard Madison Heights, MI 48071
800/521-8428

Macsivvel/Mactilt
A plastic holder on which the Macintosh can swivel 360 degrees and tilt upward 25 degrees. Adjusting the angle of the screen reduces glare, and swiveling allows a second viewer to see the screen easily. List price: $34.95.

I. & R. Associates
2000 Rock St. #19
Mountain View, CA 94043
415/968-9504

MacRack
A desktop organizer for a complete Macintosh system including the Mac, keyboard, mouse, modem, printer and paper supply, and external disk drive. The system components are stacked on a chrome-plated, welded-steel wire rack that collapses for shipping and storage and can be assembled without tools or fasteners. MacRack measures 16 1/2 W by 21 H by 12 1/4 D inches when assembled. List price: $79.

Micro Products Company
2210 N. 45th St.
Seattle, WA 98103
206/632-1524

Micro/File 40
A disk organizer that holds up to 40 micro-floppy disks in individual track slots. Micro/File 40 has an off-white base and a smoke-colored acrylic top. List price: $27.95.

Sharp Color
400 N. High St., Box #175
Columbus, OH 43215

Colored Ribbons
Ribbon cartridges for the ImageWriter printer. The high-resolution carbon/polyethylene film ribbons are available in red, green, blue, brown, and black. List price: $10 each (minimum order: 2).

Rio Grande Software, which was listed in the July/August issue's Macware News, has moved to a new location. Their new address is 1107 Upas, McAllen, TX 78501, 512/630-6979. In addition, Softmaker II, which we listed at $195, sells for $150.

Macware News uses information provided by manufacturers; it does not evaluate products or corroborate manufacturers' claims. Send a description and a photograph of your new product to Macware News, Macworld, 555 De Haro St., San Francisco, CA 94107, 415/861-3861.
How can you get your Macintosh to print with a daisywheel, letter quality printer?

By using the new Mac·Daisywheel·Connection!

From the team who wrote MacWrite comes a powerful application program that allows you to print your text with any popular daisywheel, letter quality printer. The new Mac Daisywheel Connection comes with the interface cable you'll need, the software program and a quick start-up guide. The application program is straightforward and maintains the visual fidelity of your file even when you mix text and graphics. The Mac Daisywheel Connection supports MacWrite and Multiplan and other Macintosh software products. The Mac Daisywheel Connection is as easy to use as your Macintosh mouse. Just point and print!

The MAC·DAISYWHEEL·CONNECTION is now available through your local Apple Computer Dealer. List price $99.

Or call toll-free: 1-800-MAC-5464
In California, toll-free: 1-800-421-0243
In Canada, direct-dial: 619-243-7993

Other quality products available from Assimilation Process:
- Ten-Pack of blank 3½” diskettes for your Macintosh $55.
- 3½” diskette hanging file holder $6.50.

Assimilation Process
The Imagewriter and Beyond

Edited by Daniel Farber and Adrian Mello

Owen Densmore, the technical leader of the four-person Macintosh "Print Shop Team," discusses the evolution and development of the Imagewriter printer and offers a glimpse of the future of Macintosh printing.

The Macintosh is a major attraction in the world of personal computers. Millions of people have looked at the Mac in person or have seen it on prime-time TV commercials. Thousands of people already have Macs poised on their desktops ready for action. And on most of these desktops, the Imagewriter printer sits next to the Mac like a faithful servant, prepared to carry out its master's commands.

People often take for granted that a printer should print out what they see on the screen, including different fonts and detailed drawings. They don't realize that the Imagewriter, like the Mac, is a technological work of art in its own right.

Owen Densmore helped design the Imagewriter and wrote the printing software for both the Lisa and the Mac. He came to Apple's Cupertino, California, headquarters from Xerox Corporation, where he had worked on developing expensive, high-quality laser printers. While doing research at Xerox, Densmore became convinced that research in printer technology going on in Xerox's labs should be applied to personal computer printers, but his supervisors disagreed. He subsequently joined Apple to realize his dream of bringing laser-quality printing to a low-cost dot matrix printer. In what follows he talks freely about the Imagewriter and other printer-related topics with Macworld Associate Editor Daniel Farber.

Macworld: When you were first thinking about the design of the Imagewriter, what features did you want to include?

Densmore: We wanted to build a poor man's laser printer—a low-cost dot matrix printer that prints high-quality dots. To help design the printer, we talked to engineers from Tokyo Electric of Japan, who make the C. Itoh printers, but they didn't seem to understand what we wanted at first.

From their standard printer, we saw little irregularities on the page such as dots that were too black or tiny white gaps between the dots. I said, "We can't..."
Owen Densmore takes a break from planning ways to pump up the Mac's printing capabilities. Ink-jet and laser printers are among the options under consideration to give more muscle to its printed output. The Imagewriter (above) continues as the standard Mac printer.
tolerate this quality.” We had to achieve accurate dot placement, which required both perfect vertical registration (the paper had to feed within a dot or half a dot of where it was told to) and horizontal registration (within half a dot in both directions). Finally I showed the Japanese a picture of what we’d done with a dot matrix printer in our lab. All of a sudden, the oldest guy at the table, a mechanical engineer (not a typographer or an electrical engineer), looked at the picture and said, “Aaah.” That’s all he said. Then they went away and came up with the ImageWriter. It was one of the most amazing feats of engineering I’ve ever seen.

*Macworld:* Is it difficult to reproduce on paper the exact images you see on the Mac screen?

Densmore: Every new printer requires a new strategy for swimming across the void between the computer and the printer: How do you provide the connection between what you see on the screen and what the printer prints out? That “binding” problem—what I call the visual fidelity connection—is tough to solve.

You can define visual fidelity simply as “what you see is what you get.” I look at the visual fidelity issue somewhat differently—how do you manipulate the programs and the printer to provide the right connection between the screen output and the printed output?

**We wanted to build a poor man’s laser printer—a low-cost dot matrix printer that prints high-quality dots.**

Basically, the screen consists of pixels, or dots, and each font or drawing is a little array of dots known as a *bitmap*. We had to come up with a strategy for mapping the dots from the screen onto paper. Unfortunately, the resolution of the screen and that of the printer usually don’t correspond exactly: The resolution of the Mac’s screen (the number of dots horizontally and vertically) is 512 by 342, which translates to 72 dots per inch (the number of dots horizontally and vertically per inch). Suppose the printer you hook up to a Mac has a resolution of 120 dots per inch. That printer is almost a worst-case match—a dot and a half on the printer equals one dot on the Mac. Achieving visual fidelity in this situation is a difficult game to win.

*Macworld:* How did you make the connection between the Mac’s screen resolution and the ImageWriter’s resolution?

Densmore: The key to the way we solved the binding problem between the Mac and the ImageWriter is Bill Atkinson’s QuickDraw graphics procedures, which are an essential part of the Mac’s ROM-based software. They allow the Mac to perform highly complex graphics operations easily and quickly. Bill and I worked out a way to take QuickDraw’s imaging technique, such as drawing a line or a character, and make the screen and the printer bit maps similar. The printer is presented to application programs as just another QuickDraw image (bitmap). Applications, therefore, interact with the printer exactly as they do with the Mac’s bit-mapped screen.

We achieved a high degree of visual fidelity not only by using the same imaging technique to map the printer as we used to map the screen, but also by using a printer that has a resolution relatively close to the Mac’s. In standard print mode (low resolution), the visual fidelity between the Mac and the printer is approximately one to one and requires few adjustments. As I said, the Mac’s screen resolution is 72 dots per inch, and the ImageWriter’s resolution is 80 dots per inch. They don’t correspond exactly, but they’re close enough for good results.

Adjustments to the resolution through the Print dialog box may be necessary depending on the print mode you’ve chosen. The printing software is kept in the ImageWriter file contained in the System folder.

*Macworld:* What exactly does the ImageWriter file in the System folder contain?

Densmore: The ImageWriter file is a resource file that contains all the information and programming necessary for using a particular type of printer. (Every type has its own resource file.) In particular, the file contains a printer driver, the driver data record, and what we call the Print Manager.

The *printer driver* is the lowest-level code of the printer resource file and performs three standard functions: simple bit-map printing, selection and scaling of fonts, and printer command implementation.

The *driver data record* includes special information such as the specific printer commands that implement formatting like boldface or underlining, character sets for European or other special characters, and configuration information such as a document’s resolution.

To guarantee a minimum printing capability, the printer driver, its data record, and the file name for the current printer [ImageWriter] are also stored in the System file. This arrangement means that if you don’t need to print every document in standard or high resolution, you can gain 17K of disk space by removing the ImageWriter file. In applications that use the stan-
The Page Setup dialog box permits you to set the parameters for paper type and page orientation. Unlike the Print dialog box, the parameters specified in the Page Setup dialog box are bound to the document and must be reset if you don’t want to use the default parameters.

The Print dialog box allows you to specify parameters for print quality, paper feed, and page range. These parameters are stored as print records in the Imagewriter file, so the next time you print a document, the dialog box is set with the same parameters as the last print job.

dard dialogs, such as MacWrite, MacDraw, and Multiplan, you cannot take out the Imagewriter file (though you can remove it from MacPaint).

The Print Manager is the highest-level code in the Imagewriter file and contains the information needed for spooled printing, including the printing dialogs [the Page Setup and Print dialog boxes], the print file spooler, and the QuickDraw Interpreter.

Macworld: You mentioned two ways of printing, “minimum print capability” and “spooled printing.” Can you explain in more detail the different printing modes that the Imagewriter uses?

Densmore: We have two printing scenarios for the Imagewriter: draft mode, for immediate printing, and spooled mode, for standard and high-resolution printing. Spooling is the process of temporarily storing in memory information destined for the printer or another hardware device. Spooled printing is more complicated and time-consuming than draft. For most printing, however, you’ll use the spooling method because it gives you more control over the printing process and produces better output.

Draft printing was designed to provide an immediate print mode capable of printing without buffering (without writing a print file to disk as in spooled printing). When you print a MacWrite document in draft mode, the QuickDraw commands that make up a document are replaced with the necessary printer commands—in this case, the C. Itoh (Imagewriter) command codes—and sent through the serial port to the printer. These printer commands are actually a programming language that controls the printer’s resolution and the printhead and paper motion, and tells the printer where to print the dots.

Macworld: The spacing between words printed in draft mode is not always the same width. Why does draft printing produce such strange spacing?

Densmore: Unlike standard or high resolution, draft printing doesn’t give you an exact representation of the characters you see on the screen, but you get immediate execution. The spacing on a text document printed in draft mode appears strange because it simulates the output you get in high-resolution or standard printing, but using an elite font resident in the printer—not the fonts in the Mac’s System file. The words are placed on paper exactly the way they are located on the screen bitmap. If you print something in draft mode and hold it up to the screen, the individual words line up with each other. We thought that people would use the draft mode to see an approximation of what their document would look like in final [standard or high-resolution] form.

Draft printing has some other anomalies. Sometimes an application stores headers at the bottom of the document file, rather than in the logical order. In those cases the printer prints the main body of the text, and then is instructed to feed the paper backward so that the header can be inserted at the top of each page.

Macworld: How does the printing software work when you print a document in spooled mode?

Densmore: The first thing that has to happen is for the application to get information about how you want the document printed. Then you enter the infor-
State of the Art

mation into the two printing dialog boxes. The Print dialog box allows you to specify parameters like paper feed (Continuous or Cut Sheet) and print quality (High, Standard, or Draft). The Page Setup dialog box lets you choose the type of paper and the page orientation.

The Print dialog box has a unique feature that eliminates the need to reset parameters each time you print. Its parameters are stored as print records in the Imagewriter file, so the next time you go to print a document, the dialog box is set with the same parameters as the previous print job. We thought that this feature would make printing easier, because usually you don’t change printing options during a work session.

The Page Setup parameters, however, are bound to a document; you have to change the default each time you want to print with a different page orientation such as wide or tall adjusted.

Macworld: What happens in the spooling process after you set the parameters in the dialog boxes?

Densmore: Once you click on OK in the Print dialog box, the application, such as MacWrite, goes through a sequence of repeated instructions called a document/page loop. The application opens each page of the document and calls the QuickDraw commands that represent the document as bit maps and structured objects such as lines, ovals, rectangles, and polygons. The document/page loop is complete when all the individual pages have been opened, transcribed into QuickDraw commands, and closed, and the entire document has been stored as a Picture file on disk.

Macworld: What is a Picture file?

Densmore: In both draft and spooled printing, a document is translated into a collection of QuickDraw calls. During spooling, these calls are recorded into a QuickDraw entity called a Picture file. Then the application calls the print pic file procedure (from the Imagewriter file), which is a miniature program that reads the pic file into the Mac's memory and then prints it. The print pic file procedure uses QuickDraw to create the bit map for printing in a portion of the Mac’s memory that we call the band buffer, and then transcribes the bit map into printer command codes.

Macworld: Why is it necessary to spool a pic file instead of sending the information directly to the printer as in the draft mode?

Densmore: We have to spool in standard and high-resolution modes because neither the Mac nor the printer can process an entire page of pic file data at once. The Mac can’t afford to image at once the quarter megabyte of memory that a full-page drawing printed in high resolution takes up. We devised the band buffer strategy so we could send the page image to the printer in small chunks. We break each page image into small, partial-page bands and alternate imaging and printing them. Each band in high resolution is only about 6K. The printer prints the bands, moving

Set the controls in the Print dialog box to choose the paper orientation and print resolution. After you click on OK, an application program such as MacWrite calls QuickDraw to build a Picture file of the document for spooling purposes.

The Picture file is saved on disk. Spooled printing often requires large portions of memory; at this point in the spooling scenario, the application can remove its own code and data from memory to provide more space for printing.

The print pic file procedure reads the Picture file into memory and tells QuickDraw to reimage the Picture file page by page into small partial-page bit maps called bands. The print pic file procedure also translates the QuickDraw commands into codes that the printer can interpret.

Each band is sent through the Mac's serial port to the printer, where it is mapped onto paper. A page printed in high resolution has 47 bands and takes about 200 passes of the printhead.

Whenever you print in standard or high resolution, the Mac and the Imagewriter use the spooled print mode. Spooled printing is more complicated and time-consuming than draft printing, but it gives you more control over the printing process and produces better output. In spooled printing, several steps are followed to conserve the required memory for detailed printed output.
down the page, starting from the top of the page and moving to the bottom (except in wide printing, which images the page from left to right).

Each band is broken into four chunks 8 dots high, which adds up to 32 scan lines. Every four passes of the printhead across the paper are equal to one band. In high-resolution printing, each page is redrawn 47 times in the band buffer—that's about 200 passes of the printhead per page.

To get an idea of how the banding technique works, look at how a line is printed on the Imagewriter. Every time a line is drawn, the dots are placed on the paper a little differently. If you watch the printer printing a line such as "the quick brown fox," in 12-point Geneva [a point is \(\frac{1}{72}\) of an inch], for example, the first time the printhead draws the sentence, the top two-thirds of the characters are drawn. Then the printhead comes back and draws the bottom third of the characters, and prints the next line and goes on.

**Macworld:** How does the Imagewriter determine the placement of dots on the paper?

**Densmore:** The printer commands tell the printer where to put the dots on paper. The print file procedure finds out what part of the bit-mapped page is white and where the "dirty" (black) portions are located in the bitmap. The printing code is smart enough to trim off the right and left margins of each band, and checks to see if a band is empty [contains no dots]. The printing commands also tell the printhead to skip over the white spaces to decrease printing time.

The vertical placement of dots is controlled by the paper movement. The horizontal placement of dots is determined ballistically. The printhead has pins spaced \(\frac{1}{2}\) of an inch apart that strike the ribbon to create dots on the paper. The firmware [software in the printer's ROM] has to calculate when to fire the pins, taking into account the acceleration and deceleration of the printhead as it moves back and forth across the page. The printhead uses eight of its nine pins in standard or high-resolution printing, and seven pins for any one character for printing text in draft mode. In standard printing, the Imagewriter prints 80 dots per inch horizontally (that's 640 dots per printhead pass because the Imagewriter has an 8-inch-wide platen) and 72 dots per inch vertically (in the paper-motion direction).

**Macworld:** How does the firmware time the firing of the printhead's pins so accurately?

**Densmore:** An internal 320-dots-per-inch clock controls the pin firing, taking into account the acceleration and deceleration of the printhead. In standard resolution, for instance, the pins have the opportunity to fire every four clock cycles, which matches the printer's horizontal resolution.

**Macworld:** What does the Imagewriter have to do to produce high-resolution printed output?

**Densmore:** High-resolution mode gives twice the resolution of standard printing by doubling the number of dots per inch in each direction, which quadruples the number of dots per square inch (144 by 160 dots per square inch). The Imagewriter prints twice as many dots horizontally by making two passes for each line. We call this second pass of the printhead a microscan.

To get a vertical doubling of the dots, the printer must move the paper half of the inter-pin distance of the printhead. Because the pins are \(\frac{1}{2}\) of an inch apart, the paper must move precisely \(\frac{1}{4}\) of an inch to make the printhead go back and fire in between the dots of the previous pass.

**Macworld:** How does the printing software produce the correct image (bitmap) to enable the Imagewriter to print in high resolution?

**Densmore:** To print in high resolution, the Imagewriter prints four times as many dots as in standard resolution. A bitmap with four times the number of bits must be imaged in the band buffer. To create a high-resolution bitmap, the pic file pages are imaged at twice the actual size, doubling the horizontal resolution. The pages are then played back to the band buffer at half that size. This doubling of dots and zooming down from a larger size creates a page with the same physical size as the data on the screen, but with four times the amount of data. The end result of this process is that the printer produces a picture on paper with twice the detail but the same size as the screen original.

**Macworld:** Can you explain how the Imagewriter prints the Macintosh fonts?

**Densmore:** A font is basically a character image that exists within a bit pattern. When you print text, QuickDraw sends font size and scaling factor information to the Font Manager, a part of the User Interface Toolbox in ROM. The Font Manager helps find the correct font, and if it's not available, it pursues a prioritized series of next-best options that vary according to the chosen resolution.
In standard resolution, the Font Manager searches for the exact size of the selected font from among the sizes stored for the font in the System file, and then returns the appropriate information to QuickDraw. When the Font Manager doesn't find an exact match, it continues to look for the next-best font and scales it accordingly. If the desired font isn't available in any size, the Font Manager uses the application or System default font and scales the font to the proper size.

When you print in high resolution, the Font Manager follows a different set of priorities. Instead of first searching for a font that exactly matches the specified font as in standard resolution, the Font Manager searches for a font that's twice the specified size. When no double-sized font is available, it looks for a font four times the specified size. If that font size isn't available, the Font Manager continues to follow a sequence of priorities that looks for the best available font that it can scale to double the selected font size and then zoom down to half-size for printing.

**Macworld**: Is there a way to tell which font sizes actually exist in the System file?

Densmore: You may have noticed in the Style menu that the font sizes are displayed in outlined or nonoutlined characters. The nonoutlined font sizes must be computed by the Font Manager and QuickDraw. The outlined font sizes already exist in the System file and don't have to be computed. If you want the best quality font for high-resolution printing, choose a font size that also exists in double its size in the System file.

**Macworld**: Why do some fonts look better on the screen than when they're printed?

Densmore: When we designed the fonts, we had to make some trade-offs between fonts that look better on screen and those that look better printed. The Imagewriter dots are about 25 percent larger than is typical for a printer designed to print in high resolution; therefore, varied-stroke-width fonts that look good on screen, such as New York, don't look as good as uniform-stroke-width fonts on paper. When 24-point New York is scaled down to print 12-point text in high resolution, the characters look a little lumpy because of the large dot size.

Generally, fonts with uniform stroke width, such as Geneva or Monaco, print better in high resolution on the Imagewriter. Uniform-stroke-width fonts are easier to scale for high-resolution printing; at 1 dot wide, they look better when zoomed down mainly because the printer overlaps dots more evenly: This kind of printing artificially emboldens the characters on paper. An example of a trade-off that worked in the printer's favor is 24-point Geneva. This font would look better at 2 pixels wide on the screen, but we decided to keep uniform fonts at 1 dot wide to improve the printed output.

**Macworld**: What's the function of the Tall Adjusted printing option in the Page Setup dialog box?

Densmore: The purpose of tall adjusted printing is to simulate the square dots you see on the Mac by maintaining the same resolution for printing as for the screen. If you cut and paste a checkerboard you create in MacPaint into MacWrite, for example, and the "squareness" of the MacPaint checkerboard is important, you should use the tall adjusted mode.

The standard tall adjusted mode has a resolution of 72 dots per inch, which is exactly the same as the screen's. However, 72 dots per inch is not an even division of the printer's 320-dots-per-inch clock. As a result, there are slight jitters when the printhead scans a line, and printing is somewhat slower. We try to solve this problem by going into an "emphasis" mode that "smears" the dots. This print mode uses the internal clock to fire the pins in close succession so the dots are bunched more closely together.

**Macworld**: Sometimes the first printed line at the beginning of the paper is crunched or expanded. Why does this problem occur, and is there any way to remedy it?

Densmore: This problem sometimes occurs when you take the paper out of the platen. There may be extra space between the printer's gears, so when you start printing, the first paper advance does not move its normal distance, and the second printhead pass prints over the top of the first line. Sometimes the paper is not held tightly enough by the rollers, especially when you use cut sheets. We try to solve the problem by having the Imagewriter "burp" at the beginning of every page to tighten up the gear, but it doesn't always work.

You can prevent the problem by "burping" the printer yourself; turn the printer off and on so the printhead moves back and forth and the gears are tightened.

**Macworld**: Are you planning to make enhancements for the Imagewriter, or what enhancements would you like to see?

Densmore: We're working on making the Imagewriter print faster by modifying the way picture files pages are read into memory during spool printing. I'd also like to install a zigzag printhead. The pins on a zigzag printhead are staggered and vertically placed closer together than on the Imagewriter's printhead. The pins are also smaller, and spaced ⅛ of an inch apart. Because the dots overlap a little, the printer
could do high-resolution printing in one pass per line. The printer could print in standard resolution by firing pairs of pins to space the dots \( \frac{1}{2} \) of an inch apart.

This type of head would also eliminate some of the problems with printing fonts like New York in high resolution. With zigzagging, you wouldn't get that lumpy look in 24-point New York because the placement and size of the dots would be more refined.

Another product we are currently developing for the Mac is what I call the Big Foot, an Imagewriter with a 15-inch-wide carriage. The Big Foot prints 70 percent more data per page than the regular Imagewriter, but as a consequence it takes 70 percent more time to print a page.

**Macworld:** Is it difficult to configure printers other than the Imagewriter for the Mac?

Densmore: We made the decision that the Mac had to be able to print with as many printers as possible. In a way that was my most important goal. I really like the Imagewriter, but I know that niftier printers will appear. One of the difficulties with hooking up other printers to the Mac is the dynamic linking problem. This concept may sound arcane, but let me explain. Suppose you want to hook up an XYZ letter quality printer to the Mac. The easiest way to accomplish that objective is to put a new printer resource file on your disk, similar to the Imagewriter file.

I wrote a little application, a 3K piece of code that I call a printer configuration program. The program lets you install new printer resource files in the system so you can run different printers. The printer configuration program works like the Font Mover, which allows you to add or delete fonts in the System file. Here I have to take my hat off to Bruce Horn, who designed the Resource file. The way the Resource file works with the operating system enables you to open a system file and say, for example, "Replace Imagewriter with Daisywriter" to install the printer's resource file into the system. That way you don't have to change the system with a screwdriver to add a new printer.

**Macworld:** Many people want to use letter-quality printers with the Mac. How are you addressing this need?

Densmore: We're developing a generic printer driver that we hope will let the Mac run with 70 percent of the daisy wheel printers in the world. Like the Imagewriter file, each printer will have a self-contained QuickDraw Interpreter with the associated driver that will have its own dialogues to ask questions unique to the particular daisy wheel printer.

**Macworld:** Can we look forward to a color printer for the Mac?

Densmore: The biggest problem in developing a color printer for the Mac is that the printers we're interested in using are not serial devices, which the Mac requires. We'd like to use the same printer as the one in development for the Lisa—the Canon ink jet—but currently they don't offer a serial device. QuickDraw already has the color definitions built in, and we are telling program application developers to provide structures in their programs for color.

The technology for displaying color on the screen, however, is not accessible in a cost-effective form. Different applications will most likely specify color in different ways. In a chart or a spreadsheet, a dialog box could ask you the appropriate color-related questions. For example, the color release of LisaDraw has a menu option that allows you to specify colors while you create a drawing; the Mac implementation will probably work the same way.

**MacPaint** poses a special problem. Because the data is stored in bits, you need to be able to manipulate the data in that form. Without a color monitor, that process would be almost impossible. You could get around the feedback problem to some extent by doing quick printouts in draft mode that would give you a rough look at the colors and the layout of a page.

**Macworld:** Many people are talking about the new breed of low-cost laser printers like the Hewlett-Packard Laserjet and Fujitsu M3072S that produce high-quality text and graphics. Is Apple planning to offer a laser printer for the Mac?

Densmore: All I can say is that we have a laser printer under development that will knock your socks off. 

---

**Now Your Macintosh Can See!**

**$395.00***

An imaging peripheral complete and ready for plug-and-go operation with your Macintosh® personal computer. Featuring easy-to-use pull-down menus, the user can print a picture or save to disk. Several features for image enhancement are built right into the program: Pictures created with the MicronEye® software are fully compatible with MacPaint®; allowing a full range of customizing capabilities. Only the MicronEye® uses the revolutionary IS22 OpticRAM™ image sensor for automatic solid state image digitizing with capability for grey-tone imaging through multiple scans.

The MicronEye® is available with immediate delivery for your Macintosh. It comes complete with tripod, lens, hardware, software and user's guide.

The MicronEye® is also available for these computers: Apple II, IBM, PC, Commodore 64, TRS-80CC and TIPC (trademarks of Apple Computer, Inc., International Business Machines, Commodore Corp., Tandy Corp. and Texas Instruments respectively).

*Add $10.00 for shipping and handling (Federal Express Standard Air). Residents of the following states must add sales tax: AR, AZ, CA, CO, CT, FL, GA, IA, ID, IL, IN, LA, MA, MD, ME, MI, MN, NC, NE, NJ, NY, OH, PA, SC, TN, TX, UT, VA, VT, WA, WI.

Micron is a trademark licensed to Apple Computer, Inc.

---

**Micron Technology, Inc.**

VISION SYSTEMS
2805 East Columbia Road
Boise, Idaho 83706
(208) 362-6106
FAX 913-970-5973

Circle 63 on reader service card
"Where can I get a financial
report to act on this stock?

"Where can I find the latest
news and quotes on the top stocks
in the aerospace industry
in time for the three o'clock
meeting!"

"How am I supposed to
sell these stocks so I can

"How can I
sell these
stocks at this
price?"

"What you need is a little Straight Talk."
Macintosh™ has changed our concept of what it's like to use a personal computer.

Straight Talk, from Dow Jones Software™, changes the concept of how a personal computer can be used.

Straight Talk gives you the exact information you need, anytime you need it, right on your desk.

Straight Talk takes advantage of the functions Macintosh is famous for, allowing you to store and process information from Dow Jones News/Retrieval® and other remote database services. You can do research, write reports, send electronic mail — even buy a tennis racquet.

Dow Jones Straight Talk™ No Macintosh should be without it.

For more information see your dealer or call 1-800-345-8500, ext. 272

DowJones Software™

Circle 69 on reader service card

Macintosh and MacWrite are trademarks licensed to Apple Computer, Inc. Copyright © 1984, Dow Jones & Company, Inc. All Rights Reserved.
The first mouse wanted a modem that would be very Macintosh-like. Icons and all.
The second mouse wanted a modem that could talk to its brothers at IBM.
The third mouse wanted a modem that could take over while its owner was sleeping.
The fourth mouse wanted a 1200 baud modem that could be inexpensively upgraded to 2400 baud.
The fifth mouse wanted a modem that worked error-free on anybody's phone service, even the discount ones he was afraid to use.
A difficult series of requests, to be sure.

But not impossible. Because today, there is a modem that will make your mouse very, very happy. It's called MACMODEM. It's made just for the Macintosh.
Two clicks and your mouse will be in and out of your favorite database with exactly the information you want. A job that takes an awful lot of clicking and keystrokes with any other modem.
To see it in person, visit your local Apple dealer and ask for MACMODEM. If he hands you something else, don’t go for the bait.
MODEM

MICROCOM

MACMODEM™

Circle 72 on reader service card
Making a Case with Multiplan and Chart

Steve Lambert

Multiplan and Chart are two Macintosh programs from Microsoft that work together to help you rapidly analyze large amounts of information, form opinions, and convey those opinions to others.

The value of a properly designed chart was illustrated recently in a conversation I had with a business consultant. He had been hired to present the facts, from his client's point of view, in a court battle between the client and the client's former attorney. The attorney was suing for $150,000 in legal fees generated by work on two separate cases. The client maintained that the attorney had billed work done on one case (a bankruptcy with which the client was only indirectly connected) to a second case for which the attorney had a better chance of collecting.

The consultant carefully categorized several years' worth of bills from the attorney and fed the information into an electronic spreadsheet program. After analyzing the information from various viewpoints, he prepared a series of charts. The charts were manipulated and refined to produce the chart shown in Figure 1. It portrays the change in distribution of fees between the cases, and shows the cumulative bill as a gradually rising line—right up to the change in billing method, at which point the line skyrockets.

The day before the trial was scheduled to begin, the consultant gave this chart to the attorney, as an example of the kind of evidence he would submit in court. The attorney dropped his suit the next morning, settling out of court for about $50,000.
Unlike the columns of numbers in a table or a spreadsheet, a chart gives an immediate visual impression of information. This chart shows an apparent discrepancy in an attorney's billing method.

**Hands On**

**Figure 1**

The Point

This story demonstrates one of the primary purposes of a chart: communication. A chart can be used to pass on rapidly to its viewer the essence of the rows and columns of numbers it represents. Like most other forms of communication, a chart allows its creator to editorialize. The consultant may have stretched the limits of fair charting practices in an effort to make his point, and the chart might not have held up as evidence if the case had gone to court. But the emotional impact of the chart was strong enough to raise a serious doubt in the attorney's mind about his chances of winning—or at least some question about whether he wanted his other clients to have the chance to interpret the chart.

This case took place before the release of Microsoft Chart for the Macintosh, so the work was done on another computer using a popular charting program. The consultant explained to me the intricate series of steps he went through to "trick" the program into plotting the chart exactly as he wanted it, including running the same piece of paper through the plotter several times and removing plotting pens at critical points to avoid unwanted lines. I admitted that he was ingenious, but it occurred to me that this intricate chart is very close to one of Chart's many standard formats. Using Chart, he could have created his hundred-thousand-dollar masterpiece in minutes—and modifications would have taken only a few moments more.

The importance of Chart lies not in the program's ability to create a chart from your data but in its ability to rapidly create variations of a chart based on your instructions. The difference is not between having a chart at once or waiting for an hour or so, but between merely having a chart and having the right chart to prove your point emphatically.

In the following example, I will duplicate a portion of the spreadsheet created for the aforementioned case using Multiplan and then transfer some of the information to Chart for plotting. Follow the required steps on your Mac if you care to.

**The Plan**

Each row/column junction on the Multiplan grid forms a cell into which you enter text, numbers, or formulas that use the contents of other cells to calculate numbers. You select the cell or the group of cells you want to work with by clicking or dragging to make them active. The line between the menu bar and the window is called the formula bar; it displays the row/column address and the contents of the currently selected cell. (For an introduction to Multiplan, see "Multiplan Meets the Mac" and to construct a stock portfolio, see "Investing with Multiplan," both in Macworld's Premier issue.)

You enter information into cells by typing at the keyboard, by cutting and pasting from other documents, or by simply opening a file if it has been stored in the proper format. For this exercise you will type the information. The filled-in portion of the spreadsheet will end up looking like Figure 2, but you will be able to view only one windowful at a time.
The Works

Start up *Multiplan* and begin by clicking on cell R1C2 to make it active, and then type *Commingling Dispute*. Everything you type is displayed on the formula bar, even though only some of the characters fit in the highlighted cell and are shown there. An entry is not considered final until you press either Enter or Return. Enter finalizes the entry and leaves the same cell selected; Return finalizes the entry and selects the next cell down in the same column (R2C2, in this case). Press Return and the full title is displayed, spilling over into the adjacent cell. Titles that span several cells are displayed in their entirety as long as you don't enter anything in the overlapped cells.

The text that you must type directly to enter is shaded in Figure 2. Enter this text just as you did the title. You will enter the rest of the text using other methods.

Copy and Paste

Use the Mac's copy and paste techniques to repeat the labels Q1 through Q4 for 1981, 1982, and 1983. Select Q1 through Q4 by dragging the pointer from row 4, column 2 to row 7, column 2 (the abbreviated terminology for the selected area is R4C2:R7C2) and copy it. Select the cell to the right of "1981" (R8C2) and paste your copy of the four labels stored in the Clipboard into column 2, rows 8 through 11. Repeat this procedure with the cells to the right of "1982" and "1983." The Q1 to the right of "1984" should already be filled in.

Use a simple formula to increment the year in R3C5 and fill in the cells below. Click R4C5, type = 1 + R and click the cell above, which contains the number 1979. The formula = 1 + R[-1]C appears on the formula bar and, when you press Enter, the number 1980 (which is 1 + 1979) appears in cell R4C5. Drag the pointer down from the selected cell containing "1980" to R8C5 (the entire block of cells is highlighted) and choose Fill Down from the Edit menu (or press 8-d). The formula is duplicated downward, and the numbers 1981 through 1984 appear.

Next enter the numbers in columns 4, 6, and 8 (see Figure 2). Type only the numbers, without dollar signs. You don't have to type the decimal point unless you type a significant digit to the right of it.

Blocks of numbers can be entered in several ways. If you simply select the cell at R3C3, type a number, and press Return, the selection highlight moves down the column, and you can type number after number until you reach Q1 of 1984. You can then select R3C4 and start over again with Client #2. A second method is to drag through the entire section you want to fill in, in this case from R3C3 to R20C4. This way, if

---

**Figure 2**

Once you have entered the information for the Commingling Dispute example, your Multiplan spreadsheet should look like the one shown here. You won't be able to see the entire spreadsheet at once on the screen, however. You must scroll from one portion to another.
Hands On

you type numbers and press Enter after each, cells are
selected from side to side and top to bottom until all
highlighted cells are selected.

Formatting

Although you have been entering the same text
and numbers displayed in Figure 2, they don’t appear
on the screen quite the same as in the illustration. This
is because the size and format of the cells in the illu-
stration have been changed to display the informa-
tion better. You can quickly format a single cell, a group
of cells, or an entire row or column. To format column
1 so that all the information in it is centered, you select
the entire column by clicking in the column header
(the space at the top containing the column number).
Then choose Align Center from the Format menu, and
the listed years immediately shift to the center of the
column.

You can change the width of a column even faster
than changing the format. Place the pointer on the
line that separates the header for column 1 from the
header for column 2, the pointer changes to a double-
pointed arrow, indicating that you can drag the column
divider in either direction (see Figure 3). Drag the
pointer slightly to the left and watch the entire column
get narrower. Adjust the width of column 2 in the same
manner.

Displaying numbers in a dollar format is another
easy task; select columns 3 and 4 by dragging across
their headers, and choose Dollar from the Format
menu. All values are converted automatically to the
dollar format and text is unaffected.

Figure 4

Choose Date from
Chart’s Data menu and fill in the
information for Client #1 as shown in this Date
Series dialog box.

You don’t have to wait until after you enter num-
bers to specify the format. Since you know that you
will display dollar values in columns 6, 7, and 8, drag
through the headers and change them to the dollar
format. From now on, numbers will be displayed in the
proper format.

Totaling Up

To compute the annual totals for columns 6 and 7
and add up the quarterly bills in columns 3 and 4, you
enter a simple formula. Start with 1979, which is an
easy year to do because the annual total equals the bill
for the only quarter listed. Select R3C6, which is where
the annual total for Client #1 for 1979 goes, type =, click
on the appropriate cell in column 3 (R3C3), and
press Enter. Do the same thing for the 1979 total for
Client #2, setting it equal to R3C4.

Since 1980 through 1983 have amounts listed for
all four quarters, you must use a slightly more complex
formula to compute their annual totals. Select R4C6,
type = sum ( drag from R4C3 to R7C3, type ), and press
Enter. You have set the annual total for Client #1 for
1980 to equal the sum of the contents of the cells in
rows 4 through 7 of column 3. The formula displayed
on the formula bar looks like this: = sum
(RC[-3]:R[ + 3]C[-3]).

Each series is
composed of two columns of numbers that
signify the X and Y coordinates.

This method of referring to a cell by its position
relative to the selected cell is called relative referenc-
ing. R[ + 3]C[-3] is the cell three rows down and three
to the left of the selected cell. The meaning of the for-

mula may be more obvious if you change the reference
to an absolute one. You can change the reference by
dragging through each relative reference in the for-

mula bar and then choosing Absolute Reference from
the Edit menu. If you drag through RC[-3] and choose
Absolute Reference, the formula changes to = sum
(R4C3:R[ + 3]C[-3]). You can change the other half of
the formula the same way. In this case the formula res-
ults in the same value whether it contains relative or
absolute references, but if you were to copy the for-
mula to another cell, it would make a difference which
reference you used.

Fill in the remaining formulas in columns 6 and 7
to show the annual totals for Clients #1 and #2. Apply
the same techniques you used for the 1979 and 1980 to-
tals (1984 is entered just as 1979 was because no quar-
terly figures are shown for these years).

All the values in column 8 are computed by for-
mula. The 1979 Total Bill is entered by selecting the
cell (R3C8), typing = , clicking the total for Client #1,
then the total for Client #2, and finally pressing Enter.
After you do this, the formula bar reads
= RC[-2] + [RC-1]. If you click one cell after another,
the program automatically inserts plus signs between
the references; if you drag through cells, it lists the first
and last cells, separated by a colon.

To enter the 1980 Total Bill, select the cell (R4C8),
type = , and click on the cell above. Then click on the
two cells to the left and press Enter; you are adding the
client totals for the current year to the cumulative total
for the previous year. Since the remaining years in col-

Figure 3

Multiplan’s pointer
changes to a double-
pointed arrow when you
place it on a line
that divides two col-
umns in the row of
column headers at the
top of the worksheet.

Drag the pointer to
the right or left to
widen or narrow a
column.

You type numbers and press Enter after each, cells are
selected from side to side and top to bottom until all
highlighted cells are selected.

Formatting

Although you have been entering the same text
and numbers displayed in Figure 2, they don’t appear
on the screen quite the same as in the illustration. This
is because the size and format of the cells in the illu-
stration have been changed to display the informa-
tion better. You can quickly format a single cell, a group
of cells, or an entire row or column. To format column
1 so that all the information in it is centered, you select
the entire column by clicking in the column header
(the space at the top containing the column number).
Then choose Align Center from the Format menu, and
the listed years immediately shift to the center of the
column.

You can change the width of a column even faster
than changing the format. Place the pointer on the
line that separates the header for column 1 from the
header for column 2, the pointer changes to a double-
pointed arrow, indicating that you can drag the column
divider in either direction (see Figure 3). Drag the
pointer slightly to the left and watch the entire column
get narrower. Adjust the width of column 2 in the same
manner.

Displaying numbers in a dollar format is another
easy task; select columns 3 and 4 by dragging across
their headers, and choose Dollar from the Format
menu. All values are converted automatically to the
dollar format and text is unaffected.

You don’t have to wait until after you enter num-
bers to specify the format. Since you know that you
will display dollar values in columns 6, 7, and 8, drag
through the headers and change them to the dollar
format. From now on, numbers will be displayed in the
proper format.

Totaling Up

To compute the annual totals for columns 6 and 7
and add up the quarterly bills in columns 3 and 4, you
enter a simple formula. Start with 1979, which is an
easy year to do because the annual total equals the bill
for the only quarter listed. Select R3C6, which is where
the annual total for Client #1 for 1979 goes, type =,

Each series is
composed of two columns of numbers that
signify the X and Y coordinates.

This method of referring to a cell by its position
relative to the selected cell is called relative referenc-
ing. R[ + 3]C[-3] is the cell three rows down and three
to the left of the selected cell. The meaning of the for-

mula may be more obvious if you change the reference
to an absolute one. You can change the reference by
dragging through each relative reference in the for-

mula bar and then choosing Absolute Reference from
the Edit menu. If you drag through RC[-3] and choose
Absolute Reference, the formula changes to = sum
(R4C3:R[ + 3]C[-3]). You can change the other half of
the formula the same way. In this case the formula res-
ults in the same value whether it contains relative or
absolute references, but if you were to copy the for-
mula to another cell, it would make a difference which
reference you used.

Fill in the remaining formulas in columns 6 and 7
to show the annual totals for Clients #1 and #2. Apply
the same techniques you used for the 1979 and 1980 to-
tals (1984 is entered just as 1979 was because no quar-
terly figures are shown for these years).

All the values in column 8 are computed by for-
mula. The 1979 Total Bill is entered by selecting the
cell (R3C8), typing = , clicking the total for Client #1,
then the total for Client #2, and finally pressing Enter.
After you do this, the formula bar reads
= RC[-2] + [RC-1]. If you click one cell after another,
The program automatically inserts plus signs between
the references; if you drag through cells, it lists the first
and last cells, separated by a colon.

To enter the 1980 Total Bill, select the cell (R4C8),
type = , and click on the cell above. Then click on the
two cells to the left and press Enter; you are adding the
client totals for the current year to the cumulative total
for the previous year. Since the remaining years in col-

Figure 5
When you paste Multiplan information from the Clipboard into the series window you have just created, two more series windows—for Client #2 and the billing total—are stacked on top of the window for Client #1. The cumulative sum of the bills is displayed in the topmost window.

Figure 6
This dialog box appears when you choose List from Chart's Data menu. Click on the Plot box for each series, then click on OK; the series will be plotted in the order in which they were created.

Figure 7
This combined column/line graph, selected from the Gallery menu's Combination option, overlays the three series you created. You can use various options in Chart's Format menu, as well as the Mac's standard text editing procedures, to improve the chart's appearance.

From Multiplan to Chart
Information can be transferred from Multiplan to Chart in several ways. If you are only going to move one block of numbers, the easiest way is to copy the block to the Clipboard, quit Multiplan, replace the Multiplan disk with the Chart disk, start up Chart, and paste the information from the Clipboard into Chart's New Series window.

If you have several blocks of information to transfer, store each block in the Scrapbook by copying it to the Clipboard and pasting it into the Scrapbook. When all the blocks of information are in the Scrapbook, quit Multiplan, move the Scrapbook file to the Chart disk (if you don't rename the existing Scrapbook file on the Chart disk, the Multiplan Scrapbook file will replace its contents), start Chart, and copy the information from the Scrapbook to several sets of series windows. Because you are only going to create one chart, use the first method to transfer the annual totals from columns 6, 7, and 8.

Before you select information to transfer, it is a good idea to think about the type of series you intend to create in Chart. If you're familiar with Chart, you will recall that four series types are available in the Data menu: Sequence, Date, Text, and Number. Each series is composed of two columns of numbers that signify the X and Y coordinates of the points plotted by the series. In a Sequence or Date series, Chart provides the X (category) coordinates (that appear on the horizontal axis) incremented by an amount you specify as you enter the data for the Y (value) columns (on the vertical axis). In a Text or Number series, you must provide entries for both columns.

If the information you intend to transfer is measured at regular intervals, like the information in this example, there is no need to transfer the interval labels (quarters, years, days, and so on) — Chart provides them for you. In transferring information that has text labels, or numeric labels that aren't spaced equally, you must include the labels in the block of cells that you transfer.

To transfer Annual Totals to the Clipboard, select them by dragging the pointer from one corner to the opposite corner of the block you want to transfer (in this case, R3C6 to R8C8). Choose Copy from the Edit menu; a copy of the selected cells is placed in the Clipboard, and you are now ready to move to Chart.

Creating a Chart
You want to create three series with the numbers stored in the Clipboard: two for the clients and one for the cumulative sum of the bills. Each series should have 1979 through 1984 in its category column and the appropriate values in its value column.

With the New Series window selected, choose Date from the Data menu. Type the name of the first series (Client #1) into the highlighted Series Name field of the Date Series dialog box that appears and press the Tab key to move to the Category Name field. Press Backspace to remove the default name. This category refers to the chart's horizontal axis. If you typed an entry, it would appear as a label ("year," for exam-
**Hands On**

**Figure 8**
This dialog box appears when you click on some text and choose Text from the Format menu. You can use a variety of text styles, sizes, and alignments to make your chart more readable or attractive.

<table>
<thead>
<tr>
<th>Text</th>
<th>Font</th>
<th>Font Size</th>
<th>Automatic</th>
<th>Show</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Geneva</td>
<td>Small</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>Small</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chicago</td>
<td>Medium</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bold</td>
<td>Large</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attached To</td>
<td>Unattached</td>
<td>Orientation</td>
<td>Horizontal Alignment</td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td>Category Axis</td>
<td></td>
<td></td>
<td>Left</td>
<td>Top</td>
</tr>
<tr>
<td>Value Axis</td>
<td></td>
<td></td>
<td>Center</td>
<td>Center</td>
</tr>
<tr>
<td>Series at Data Point</td>
<td></td>
<td></td>
<td>Right</td>
<td>Bottom</td>
</tr>
<tr>
<td>Series Number:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point Number:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 9**
To help you customize a chart's axes, this dialog box appears when you click on the horizontal axis and choose Main Chart Axis from the Format menu. Chart calls the horizontal axis the value axis.

**Figure 10**
This dialog box appears when you click on the horizontal axis and choose Main Chart Axis from the Format menu. Chart calls the horizontal axis the category axis.

---

To create an overlay chart, the program divides the series in half and plots the first half on the main chart (and the extra series if you have an odd number) and the second half on the overlay. After a

---

**Figure 8**
This dialog box appears when you click on some text and choose Text from the Format menu. You can use a variety of text styles, sizes, and alignments to make your chart more readable or attractive.

<table>
<thead>
<tr>
<th>Text</th>
<th>Font</th>
<th>Font Size</th>
<th>Automatic</th>
<th>Show</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Geneva</td>
<td>Small</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>Small</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chicago</td>
<td>Medium</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bold</td>
<td>Large</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attached To</td>
<td>Unattached</td>
<td>Orientation</td>
<td>Horizontal Alignment</td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td>Category Axis</td>
<td></td>
<td></td>
<td>Left</td>
<td>Top</td>
</tr>
<tr>
<td>Value Axis</td>
<td></td>
<td></td>
<td>Center</td>
<td>Center</td>
</tr>
<tr>
<td>Series at Data Point</td>
<td></td>
<td></td>
<td>Right</td>
<td>Bottom</td>
</tr>
<tr>
<td>Series Number:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point Number:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 9**
To help you customize a chart's axes, this dialog box appears when you click on the horizontal axis and choose Main Chart Axis from the Format menu. Chart calls the horizontal axis the value axis.

**Figure 10**
This dialog box appears when you click on the horizontal axis and choose Main Chart Axis from the Format menu. Chart calls the horizontal axis the category axis.
To add a grid to your chart's plot area, choose Axes from the Chart menu and click on the boxes next to Major Grid Lines under both Categories and Values.

Choose Patterns from the Format menu to select the background pattern and the border pattern, width, and style for a selected area of the chart. Using too many patterns and border styles can clutter your chart and reduce its effectiveness.

The handles define the space allowed for the label; you can change the size or the shape of the space by dragging one of the handles. You can also use normal Macintosh editing techniques to insert or delete text, or to replace the label entirely. To change the format of this piece of text, choose Text from the Format menu. The dialog box that appears offers options that can be applied to text (see Figure 8).

Click on Vertical (under Orientation) and then click on OK. The chart is redrawn with a vertical value axis label—though you may have to drag one of the corner handles to move the text into one column. The next change applies to the title, Client #1. Chart uses the name of the first series plotted as the title for the chart; this practice is reasonable if there is only one series, but in this case the title is inappropriate. To change the title, select it, then replace by dragging through the words "Client #1" and typing a new title.

To avoid more legal trouble, you can change the name of the law firm. How about calling it Chisel, Cheat, Lie, & Steal? This name is longer than the original chart title, so it doesn't fit in the available space. Type the new title and, before pressing Enter, drag one of the end handles out to enlarge the space.

You might want to give the new title more visual impact. The title is already selected, so again choose Text from the Format menu. In the same dialog box, click on Medium, Bold, and Italic in its upper-left quarter. When you click on OK, the chart is redrawn with a more impressive title, which probably will require another adjustment of the handles to fit it on one line.

An Axis to Grind
To make the chart display a dramatic change in the attorney's billing, you can reduce the range of the vertical axis. Select the axis by clicking on it (a small circle appears at each end of the axis to indicate that it is selected) and then choose Main Chart Axis from the Format menu (this option appears in the menu only when the vertical axis is selected). The dialog box shown in Figure 9 appears, allowing you to set various axis properties. Change Minimum to 140,000.

Each axis has a different properties sheet associated with it. If you select the category (horizontal) axis and then choose Main Chart Axis from the Format menu, you are presented with the dialog box shown in Figure 10.

Go ahead and select the category axis and choose Main Chart Axis. While the dialog box is displayed, click on the line titled Value Axis Crosses Between Categories. The X in the box adjacent to the line disappears and, when you click on OK to return to the desktop, the chart is redrawn with the plotted line extending from one edge of the plot area to the other. To add a grid to the plot area, choose Axes from the Chart menu and click on Major Grid Lines under both Categories and Values (see Figure 11).

Figure 11
To add a grid to your chart's plot area, choose Axes from the Chart menu and click on the boxes next to Major Grid Lines under both Categories and Values.

Figure 12
Choose Patterns from the Format menu to select the background pattern and the border pattern, width, and style for a selected area of the chart. Using too many patterns and border styles can clutter your chart and reduce its effectiveness.

Figure 13
The final chart includes a legend, shadowed borders, a vertically oriented title for the vertical axis, and grid lines, as well as a large-type, boldface, italic title for the chart itself.
Soft Start is a series of Multiplan and MacPaint tools designed to help you quickly solve your Business Analysis and Personal Finance problems. The templates include Cash Flow Analysis, Portfolio Management, Property Management, Budget Analysis, and many more. Pre-drawn Business Forms can be used with your name, or as a starting point for your own designs. To start saving time, call or write today!

$49.95 each volume.

Owl Software
79 Milk Street - Suite 1108
Boston, Massachusetts 02109
(800) 343-0664 Ext. 5500
(800) 322-1238 Ext. 5500 (In MA)

VISA, MC, Check, or Money Order
Macintosh and MacPaint are trademarks of Apple Computer, Inc. Multiplan is a trademark of Microsoft Corporation.

The key that appears at the bottom of the chart, matching column pattern to client, is called a legend. Chart provides a legend if you choose Add Legend from the Chart menu. The legend is automatically placed at the right edge of the plot area; you can move it to the bottom by selecting it, choosing Legend from the Format menu, and clicking on Bottom for Type of Legend. The legend created won't exactly match that of the original chart; if you want a closer match, you can create a legend from scratch by typing the words and adding swatches of pattern.

Notice that the legend has a frame around it. While almost every object on the chart can be individually selected and framed, the legend is the only object that is framed automatically when it is created. While the legend is still selected, you can change the style of the frame.

To do so, choose Patterns from the Format menu. You are presented with the dialog box shown in Figure 12, in which you can specify a background and a border pattern, and border weight and style. The solid black border pattern is already selected; change the border style to shadow.

As a finishing touch, you can add a matching frame to the chart. Select the entire chart by choosing Select Chart from the Chart menu, and then pick a frame style and pattern by choosing Patterns from the Format menu and clicking on the solid black border pattern and the shadow style. The finished chart looks like the one in Figure 13.

If you think the chart needs further embellishment, you can transfer it to MacPaint and apply your artistic talents. You might also paste it into a MacWrite document to illustrate a written report. It's unlikely that you'll apply Multiplan and Chart to a court battle. But charts created from spreadsheets are valuable allies when you want to analyze information and present your opinions.

You have just spent a few thousand dollars for a Macintosh™. What have you done to protect it's most vulnerable component?

Introducing ....

Mouse-Trap

Mouse-Trap is designed to protectively hold the mouse out of harms way when it is not in use. Molded of durable plastic, it can be affixed, by means of the included Velcro pad, directly to the computer housing, or to any smooth surface. Mouse-Trap is a simple accessory to help protect an essential part of your machine.

Send check or Money-Order for $10.95 to:
RAEX Enterprises
Post Office Box 327
Beloit, Wi. 53511
Wis. residents must add Sales Tax.

Multiplan
Microsoft Chart
Microsoft Corporation
10700 Northup Way
Bellevue, WA 98004
206/828-8080

List price: Multiplan $195, Chart $125

Steve Lambert is a freelance writer and the author of Presentation Graphics on the Apple Macintosh.
YOUR MOVE: SARGON III TO MACINTOSH, TOO.

SARGON III COMPUTER CHESS GAME NOW AVAILABLE FOR MACINTOSH.

Now you can play Sargon III, the world's finest microcomputer chess program, on your Macintosh.

No need to type in your moves manually. Use the mouse to move your pieces. Pull-down menus make it easy to select the game's different options and features. With just a sweep and click of the mouse you can choose one of 9 playing levels, change board size, change the colors of your squares, save a game in progress to disk, or print out your game in high-quality Macintosh graphics.

HOW MACINTOSH AND SARGON III CAN RAISE YOUR GAME TO A HIGHER LEVEL.

The intuitive operating style of the Macintosh combined with the perfect playability of Sargon III make for the best chess instruction anyone at any level of play could ask for.

Sargon III will play at precisely the level of difficulty you desire. Ask Sargon III for a hint, take back a move you've already made, replay a sequence, change sides, or set up your own board for customized learning. Sargon III lets you study in detail more than 100 great games of history or review 45 classic chess problems, all on screen. Sargon III also includes a complete library of opening moves.

SARGON III WRITES CHESS HISTORY

In a recent tournament sanctioned by the U.S. Chess Federation, Sargon III beat a master rated 2209. That makes Sargon III the only microcomputer program ever to defeat a player at that level.

Sargon III. The Macintosh version. Only $49.95. See your local software dealer, or contact Hayden Software, 600 Suffolk Street, Lowell, MA 01853, telephone 800-343-1218.

HAYDEN. AMERICA'S FIRST FAMILY OF SOFTWARE.
BUILDINGS, LANDSCAPES, INTERIORS: DA VINCI HAS GRAND DESIGNS ON YOUR MAC.

NAIL DOWN YOUR DREAM HOUSE. ONLY $49.95.

Hayden's three new da Vinci graphics packages—Buildings, Landscapes and Interiors—let you use your Macintosh to design a house or an office, landscape it, and arrange the interior.

DaVinci works with your MacPaint program. Each da Vinci package gives you hundreds of design selections. Use them as is, or alter them to suit your own ideas. Deletions or additions are no harder than a sweep and click of your mouse.

SEE THE FOREST OR THE TREES.

The da Vinci packages cost only $49.95 each. You can use them separately or in any combination.

If you're a professional landscape architect, office planner, interior designer or office manager you'll easily pay for your package in time savings with the first design you do.

If you're an amateur, you can generate and evaluate scores of interior and exterior designs without worrying about hefty consulting fees.

Or perhaps you just like to draw. DaVinci gives you the perfect opportunity to create a world of imagination.

REARRANGE YOUR FURNITURE WITHOUT HURTING YOUR BACK.

The components in da Vinci were designed by noted professional artist, sculptor and printmaker David Adamson, a Fulbright Fellow, and Professor of Art at the Corcoran School of Art in Washington, D.C. He formulated them to be both artistically pleasing and functional in construction terms.

The da Vinci components are scaled to give your designs true professional quality.

Of course you can print out your designs on your Macintosh Imagewriter.

To put da Vinci to work, see your local software dealer, or contact Hayden Software, 600 Suffolk Street, Lowell, MA 01853, telephone 800-343-1218.

HAYDEN, AMERICA'S FIRST FAMILY OF SOFTWARE.
SENSATIONAL RELATIONAL!

Hayden:Data is a fully relational database management program designed for the Macintosh.

It organizes your data, interrelates it and then lets you look at it from multiple points of view.

There's no end to the way Hayden:Data can manipulate and interpret your data. Data fields can contain single or multiple entries. Fields are of variable length and can contain alpha or numeric data, dates, times, even MacPaint™-created illustrations!

AN EASY WAY TO KEEP TRACK OF WHO, WHAT, WHERE, WHEN AND WHY.

Hayden:Data is so simple and elegant to use that you can perform the majority of your analyses without ever touching the keyboard. You manipulate your data using your pointer and pull down menus. Overlapping windows let you look at several files simultaneously.

Hayden:Data lets you easily prepare reports or custom design forms.

If you change information in one file, Hayden:Data automatically updates information in up to 15 other related files.

BASE YOUR DATA ON HAYDEN:DATA.

For information about this innovative productivity tool, contact your local computer software dealer or Hayden Software, 600 Suffolk Street, Lowell, MA 01854, phone toll-free 800-343-1218.

Macintosh and MacPaint are registered trademarks of Apple Computer Corporation.

HAYDEN, AMERICA'S FIRST FAMILY OF SOFTWARE.
WHOLESALE +8% PRICING
OUR 400 PAGE CATALOG
OVER 20000 PRODUCTS AVAILABLE
FROM 600 MANUFACTURERS
12 TO 21 DAY SOFTWARE RENTALS—
COMPLETE MACINTOSH SUPPORT
ARE JUST THE BEGINNING
FOR NETWORK MEMBERS ONLY!

For as little as $8 per year you can join the
thousands of value wise buyers who have saved
more than $8,000,000 on 25,000 orders over the
last six months and received these 15 unique benefits:

- Wholesale + 8% Pricing
- Our 400 Page Catalog—Over 20000 Products
- In-stock Delivery On Popular Products
- Experienced Sales Consultants
- Add-on Quantity Discounts
- Free Technical Support
- 12-21 Day Business Software Rentals (optional)
- 12-21 Day Game Software Rentals (optional)
- Special Savings Newsletters “The Printout”
- Discount Book Library—Over 1000 Titles
- Membership Referral Bonus
- Corporate Accounts
- Product Price Protection
- Membership Refund Guarantee
- 10 Day Hardware Return Policy

PC NETWORK Members come back to buy
PC NETWORK Members join America’s Number 1 Computer
Buying Service because they recognize a great value. So it
makes sense that sometimes our value-wise customers may
check another source before making their purchases. And it
makes sense that they come back to PC NETWORK to buy—at
just 8% over the wholesale price plus shipping.

We know of no “discount” house, computer store, retail shop,
direct mail outlet or imitator that can beat our consistently low
prices or match our tremendous selection of products!

We Invite You To Compare
Shop around. Then add up the transportation costs and time
spent on the phone or traveling from store to store. Or re-
member frustration you may have experienced asking an un-
trained order-taker or sales clerk about compatibility, language
requirements, memory capacity, price comparisons . . .

Or call us first. Our trained personnel will gladly answer all your
questions and quote you the best prices on the largest selection
of computer software and hardware in the nation! And when you
buy, it’s all delivered right to your doorstep from our multimillion
dollar inventory—quickly!

Copyright ©1984, PC NETWORK INC.
The Mouse Will Play

A simple video game puts you on the tennis court with a tough opponent

Mitchell Waite

Would you like a Microsoft BASIC (MBASIC) version of the Atari game Breakout? In the original Breakout game, players hit a ball with a paddle; the ball in turn hits and clears out three rows of bricks. You can play a new version called Mouse-Ball that works the same way, except that rows of apples replace the bricks.

You don't have to understand BASIC to make the program work or to enjoy playing it. By following a few simple instructions, you can type the listing labeled "Mouse-Ball" (which appears on the following pages) and begin to play. Open MBASIC and, beginning with line 10, type the Mouse-Ball program exactly as you see it. You don't have to worry about typing the exact number of blank spaces shown in the listing unless the spaces are surrounded by quotation marks. Always press the Enter key at the end of each line.

Correct typing errors by backspacing and retyping. If you make a typing mistake after you have entered a line, choose the List command and retype the line in the Command window, making sure to include the line number. After you make a correction, press the Enter key.

When you've typed the entire program, save it. To play the game, choose Run from the Control menu or type Run in the Command window. The game screen appears. Set the ball speed by moving the pointer to the speed rectangle and clicking. Clicking toward the left end of the rectangle makes the game run slowly; clicking at the right end makes the game run more quickly. After you set the speed, click on the dot to the left of "GAME." Or if you want to see a demonstration first, click on the dot to the left of "DEMO." When the game is over, you can stop the program by choosing Stop from the Control menu.

Once you start playing, you'll discover that the rules for Mouse-Ball are simple. You move the paddle up and down with the mouse. The ball bounces off the top, bottom, and right-hand walls or off the paddle. The program is smart enough to figure out where the ball hits the paddle and to reflect the trajectory on a proportional angle. When the ball hits an apple, the apple disappears from the screen, the score is increased by 1, and the ball is rebounded toward the paddle. If you miss the returned ball with your paddle, the ball is lost. Then the number of available balls decreases by 1, and a new ball is sent flying toward your paddle. The game is over when you use up five balls.

If the ball hits enough apples to get behind the rows, it starts bouncing back and forth between the wall and the back row of apples. Apples are erased until the ball finds an unobstructed area and moves back toward the paddle. If you clear all the apples from the screen, more apples appear and you can continue accumulating points.

The highest possible score the game allows is 32,767 points—a score that is nearly impossible to reach. Try for 200 points. If you score that many, consider yourself a skilled player.

Mitchell Waite

President of the Waite Group, a San Rafael, California, producer of computer books, including several Macintosh books forthcoming from Microsoft Press.
MACINTOSH MOUSE-BALL
by Mitchell Waite

Copyright © Waite Group, Inc. 1984

DEFINT A-Z:CLS
ON ERROR GOTO 1130
X1=465.YL1=250.XBALL=20:YBALL=20:MP=40
CIRCLE(15,15),5:X1=10:Y1=10:X2=20:Y2=20:draw ball
GOSUB 1130:DIM A%(SIZE%):create array for ball image
GET (X1,Y1)-(X2,Y2),A%:get ball image into array
PUT (X1,Y1),A%:erase ball from screen
GOSUB 590:draw speed slider and score area
GOSUB 660:draw apples
GOSUB 770:draw paddle
LINE (5,8)-(X1+20,YL1+10):draw border
GOTO 440:starts the game

loop starts 5------

XBALL=XBALL+XV:YBALL=YBALL+YY
PUT (XBALL,YBALL),A%:draw the ball
FOR I=1 TO 15:NEXT 1:delay a bit
PUT (XBALL,YBALL),A%:erase the ball
GOSUB 730: update paddle
IF (XBALL<340) OR HIT THEN 300:if not in apples area skip

check if we hit an apple
C=4*(XBALL<=372)+(XBALL<=403)+(XBALL<=433)+4*(XBALL>433)

row loc - note this is an integer division
IF DTF(C,R)=-1 THEN PUT(DX(C,R),DY(C,R)),B%:DTF(C,R)=0:BEEP:
XBALL=XBALL+XV;HIT=-1;SCORE=SCORE+1;CALL MOVETO(45,275):
PRINT STR$(SCORE):IF NODEMO=0 AND SCORE>=27 THEN GOSUB 960 ELSE IF
SCORE=27 THEN 460

check if we hit the paddle
XBALL=30;D=XBALL-MP=15;YY=D*.6:HIT=0
IF XBALL<15 OR YBALL<YL1 THEN XV=-XV;
XV=-XV;HI T=0

IF VFALL<15 OR VFALL>YL1 THEN YV=-YV
GOTO 190

loop ends 2------

missed the return

HIT=0;CALL MOVETO(190-BALL*10,275);BALL=BALL+1:PRINT "":FOR
I=1 TO 100:GOSUB 730:NEXT 1:IF BALL=6 THEN 440
IF USET THEN XV=-ABS(XV) ELSE XV=-12-(BALL*4):H=ABS((XV*9)+165.

(continues on page 103)
LINE (MOLD,266)-(MOLD+3,274),30,BF: LINE (M,266)-(M+3,274),33,BF:
MOLD=M-300: "update speed bar
420 YV=YV-RND(1)*5+2: XBALL=335: YBALL=250-RND(1)*220: GOTO 170
430 ' start new game
450 ' set up apples
460 XV=7; YY=7; BALL=0; HIT=0; NODemo=-1; USEt=0; PUT(10,1P),C,R;
MP=100: PUT(10,1P),C,R: CALL INITCURSOR
470 GOSUB 960 ' set up apples
480 CALL MOVETO(150,145): PRINT CHR$(165);" GAME "; CHR$(165);" DEMO";
490 CALL MOVETO(100,275): PRINT "BALLS:"; FOR I=1 TO 5: PRINT CHR$(165);":"
500 ' loop and wait for user to click GAME or DEMO
510 IF MOUSE(0)=0 THEN S10
520 IF MOUSE(1)<302 AND MOUSE(1)>457 AND MOUSE(2)>265 THEN USEt=-1:
M=MOUSE(1): GOSUB 690
530 IF MOUSE(2)<140 OR MOUSE(2)>150 THEN S10
540 IF MOUSE(1)>150 AND MOUSE(1)<155 AND NODemo=-1: GOTO 570
550 IF MOUSE(1)>205 AND MOUSE(1)<212 THEN NODemo=0: GOTO 570
560 GOTO S10
570 CALL MOVETO(150,145): PRINT SPACE$(22); CALL MOVETO(45,275); PRINT "0";
580 ' FOR I=1 TO 5: PRINT SPACE$(22); CALL MOVETO(45,275)
590 ' draw speed slider and score area
600 ' draw slider inside speed scale
610 CLS: LINE (300,265)-(460,275),B
620 CALL TEXTFACE(32) 'this is condensed face
630 CALL MOVETO(230,275) 'locates the text cursor
640 PRINT "SPEED"; CALL MOVETO(10,275): PRINT "SCORE: 0";
650 RETURN
660 ' draw paddle and GET it
670 ' draw slider inside speed scale
680 ' draw slider inside speed scale
690 LINE (MOLD,266)-(MOLD+3,274),30,BF: LINE (M,266)-(M+3,274),33,BF:
MOLD=M+M/2-75: XY=SGN(XV)*M/5). RETURN
700 ' draw and update paddle
710 ' draw and update paddle
720 ' draw and update paddle
730 DUMMY=MOUSE(0): MP1=MOUSE(2)-45: IF MP1<0 THEN MP1=0 ELSE IF
MP1>235 THEN MP1=235
740 IF MP1=MP THEN RETURN
750 PUT(10,1P),C,R; MP=MP1: PUT (10,1P),C,R: RETURN
760 ' draw paddle and GET it
770 ' draw paddle and GET it
780 ' draw paddle and GET it
790 L=20; J=20; K=10: CIRCLE (20,20);15,",15

(continues on page 104)
(continued from page 103)

800 FOR J=20 TO 35 STEP 2: LINE (1-K,J)-(1+K,J)
810 LINE (1-K,40-J)-(1+K,40-J); K=K-1: NEXT J
820 LINE (18,35)-(17,55): LINE -(23,35): LINE -(22,35)
830 X1=5; Y1=5; X2=30; Y2=55; GOSUB 1130: DIM C%(SIZE%) ' dimension paddle array
840 GET (X1,Y1)-(X2,Y2),C%; PUT (X1,Y1),C%; PUT (10,MP),C%; RETURN ' get into C%
850 ' draw apples
860 GOSUB 1020: X1=14; Y1=14; X2=42; Y2=42; GOSUB 1130 ' draw single apple
870 DIM B%(SIZE%): GET(X1,Y1)-(X2,Y2),B%; PUT (X1,Y1),B%; ' dimension array and get into B%
880 ' set up apple array in column, row, order
890 DIM DTF(3,9), D(3,9), DV(3,9)
900 ' set up xcoords for apples, then ycoords
910 FOR R=1 TO 9: D(X1,R)=34: D(X2,R)=37: D(X3,R)=40: NEXT
920 RETURN
930 ' make all apples true and draw them
940 FOR C=1 TO 3: FOR R=1 TO 9: DTF(C,R)=-1: NEXT R,C
950 FOR R=1 TO 9: FOR C=1 TO 3: D(C,R)=R*27-13: NEXT R,C
960 RETURN
970 ' draw single apple using poly routines
980 FOR C=1 TO 3: FOR R=1 TO 9: DTF(C,R)=-1: NEXT R,C
990 FOR R=1 TO 9: FOR C=1 TO 3: D(C,R)=R*27-13: NEXT R,C
1000 RETURN
1010 ' compute size of graphics array
1020 SIZE%=(4*(Y2-Y1+1)*2*INT((X2-X1+16)/16))/2: RETURN
1030 ' error trap to restore mouse pointer
1040 CALL INTCURSOR:
1050 ON ERROR GOTO 0

Mouse-Ball
Go ahead.
Put your two cents worth onto ThinkTank™
And watch it grow into a million-dollar idea.
Because ThinkTank is the first software
designed to process ideas. Now it's available on the
Apple's Macintosh.
ThinkTank’s flexible outline format lets you
clearly see your idea from all angles. So you can
sharpen up an inspired thought, weed out a weak
one, set priorities, weigh alternatives.
It's like a spreadsheet for ideas.
While all this structuring helps your brain-
child take shape, it won’t inhibit the natural flow
of creative juices. Because entering an idea onto
ThinkTank is as easy as scribbling it on a cocktail
napkin. All you need is simple English.
Just let your thoughts flow—from “pie in
the sky” concepts to the “nuts and bolts” details.
And build more professional proposals,
marketing plans, legal
briefs, case reports,
engineering specifications,
research notes,
action items, hot
lists and to-do lists.
Call 1-800-556-1234 Ext. 213
(in Calif., 1-800-441-2345 Ext. 213) for
the store nearest you.
And see what’s really
on your mind.

The First Idea Processor.

"ThinkTank" and "The First Idea Processor" are trademarks of Living Videotext, Inc.
© Copyright 1984, Living Videotext, Inc., 2432 Charleston Road, Mountain View, CA 94043. (415) 964-6300
Circle 50 on reader service card
Heavy feet thunder across an urban landscape. Citizens flee in terror as Panda Kong waddles through the streets of the financial district, leaving a trail of destruction and despair in his wake. Pandemonium reigns throughout the city as fighter planes circle his massive, fuzzy head. Is this the end of the legendary Panda Kong?

Creating a drawing using MacPaint doesn’t require extensive drawing skills. In fact, this electronic medium has the advantage of decreasing people’s fear of drawing. Most people are not self-conscious about doodling or improvising with a pencil on a scrap of paper; however, if you give them a set of drawing pens and expensive paper, they will often feel intimidated. The Macintosh and MacPaint encourage people to improvise and experiment (no Da Vinci or Durer is looking over your shoulder). Images are not permanently fixed on canvas; you can easily erase or modify an entire image. Although you may not be able to draw as accurately with a mouse as you can with a pen, the flexibility provided by MacPaint’s electronic easel makes some aspects of drawing easier, and certainly more fun.

To use MacPaint effectively, you’ll have to become familiar with the array of drawing tools and patterns in the MacPaint palettes. One way to gain that familiarity and increase your MacPaint “vocabulary” of drawing skills is to start up the program and follow this tutorial, which leads you step by step through the creation of a drawing.

The Panda Kong illustration demonstrates a few basic MacPaint techniques, focusing on its primary drawing tools: the pencil and the paintbrush. Panda Kong’s body was constructed with simple shapes; the pencil was used for rough, freehand sketching and for working in FatBits, and various brush shapes and patterns were used for shading and modeling Panda Kong’s features.

The figures show several stages in the construction of Panda Kong. The many false starts and detours inevitable in the creation of an image are not shown. You can follow the steps illustrated in this tutorial and create your own version of Panda Kong, or simply use the figures as a point of departure from which to explore MacPaint. For a quick reference to what is being done in each figure, check the palettes to determine which tool, border, and pattern are selected, as well as the position of the selected tool within the drawing.
The drawing was started with a circular shape for Panda Kong’s head. A MacPaint window shows about one-third of a full-page drawing, so you should scale images accordingly. Use Show Page periodically to get an idea of how much of the page your drawing takes up and to view the overall composition.

Circles were also used to create Panda Kong’s ears and eyes, and a filled polygon was used for the nose. You can “paint in white” (using the paintbrush and the white pattern) to scoop out portions of circles to sculpt forms such as Panda Kong’s ears. The variety of brush shapes and sizes allows you to work in more detail than does the eraser.

Panda Kong’s mask, nose, and mouth were drawn with a medium-sized, round paintbrush, and painting in white refined the image. The eyes were done by painting a white hole in the mask and then filling it in with a black dot. The chin was painted with a gray pattern, and the pencil was used to highlight the nose.

The body was drawn freehand, and the arms and legs were filled in with the large, round paintbrush. When working on a drawing that is larger than one screen, it is often more convenient to use Show Page, rather than the grabber tool, to move from one part of the drawing to another. Show Page enables you to position part of your drawing accurately within the drawing window.
Figure 5
This FatBits image shows a close-up detail. Although the pencil can be used for rough sketching, it is ideally suited for dot-by-dot drawing in FatBits. All the details, such as the whiskers and the highlights in the eyes, were done in FatBits, as was most of the touch-up work.

Figure 6
The first airplane was drawn in an open area, leaving room for experimentation. An ellipse was used for the propeller. When experimenting with different versions of a figure, you can make copies and try using different patterns, flipping the image, and so forth. Use Undo to cancel changes you don’t like, and erase extra images or store them in the Scrapbook for future use.

Figure 7
Since the plane is relatively small, it was finished in FatBits. You can see the image in the upper-left corner as you create it, which is useful for images that can be contained within the viewing box. With larger images, you have to leave FatBits and then see how the detail work looks in relation to the whole figure.

Figure 8
After the plane was finished, it was moved into position with the selection rectangle. Although in this case the plane was not modified, you can use the selection rectangle in conjunction with the key to shrink, enlarge, or stretch an image.
Hands On

Figure 9
The plane was copied, flipped horizontally, and dragged to the left side of the picture. If MacPaint had no Flip Horizontal feature, the second plane would have had to be drawn from scratch.

Figure 10
The fuselage of the large airplane was sketched in with the pencil. You can use the pencil's "eraser"—on a dark surface, it draws in white—for rubbing out previously drawn black lines. Because the pencil draws such fine lines, this feature is most useful in FatBits.

Figure 11
At this point, the airplane is beginning to take shape. The basic shapes and proportions are blocked out, and the drawing can be cleaned up later in FatBits. You can also draw rough sketches using the single-dot brush, which doesn't have the ability to erase but allows you to draw with patterns.

Figure 12
The outline of the plane is now more refined, thanks to FatBits. The propeller was drawn freehand (since it's a tilted ellipse, the oval tool couldn't be used, as it was with the small planes; MacPaint will only flip or rotate shapes in increments of 90 degrees). This part of the drawing illustrates some of the problems involved in rendering an object that can't be drawn using the standard shapes from the tool palette.
Figure 13
Patterns were added to the plane with the paintbrush, and the line tool was used to create the spray of bullets as well as the lines that give the illusion of motion (these lines were broken up in FatBits). Horizontal or vertical straight lines can be drawn using the Shift key with the pencil or the brush, and diagonal lines can be drawn with the line tool.

Figure 14
This figure shows the jet trail of the airplane coming around Pandemonium. It was drawn with one of the gray patterns using the small, diagonal paintbrush. If you experiment with different brush shapes and pattern combinations, you'll find MacPaint an extremely flexible medium.

Figure 15
One of the square brushes was used to paint in the skyline. This technique is more fluid than producing shapes with the rectangle from the tool palette. When you're drawing with a square, you can make angled lines, giving the drawing a freehand quality.

Figure 16
The small, square brush was used to paint the smoke rising from the ruined city. You can also use the spray can to create smoke or clouds, but this tool comes in only one size. The lighted windows in the buildings were done with the small, square brush in white.
Figure 17
Horizontal lines were added to give the illusion of receding space. These lines should have been put in first, but you can’t always foresee what your finished drawing will look like. Now the lines that cross portions of the drawing must be erased.

Figure 19
The sky was created using the spray can with various shades of gray, as well as a custom pattern. Custom patterns add variety to your Mac paintings. Patterns you create with the Edit Pattern option are saved along with your MacPaint document.

Figure 18
The horizontal lines that crossed Panda Kong were removed in FatBits. Then the details that were erased in the process were patched up. It’s fairly easy to repair a pattern in FatBits, since the arrangement of the dots that make up the pattern is readily visible.

Figure 20
The final stage is cleaning up and refining the drawing—taking out stray dots and, in this case, putting a highlight in Panda Kong’s eye. You can save your drawing and return to it any time you want to make further modifications. The next version could show the demise—or the triumph—of the mighty Panda Kong.

Mick Wiggins is the Art Director of PC World.
Coming Soon from Chang Labs:

Big News for Small Business.

There are twelve million businesses in this country with fewer than ten employees. They've been called the backbone of the nation's economy. They've been promised that new computer technology will give them a new competitive edge—eventually.

Apple has delivered the computer to fulfill that promise. And now Chang Labs has the software.

Chang Labs
The family of software solutions

(800) 972-8800 In California (800) 831-8080
5300 Stevens Creek Boulevard, San Jose, CA 95129
Open Window

An exchange of Macintosh discoveries

Edited by Daniel Farber

Open Window offers tips to help you use your Macintosh more efficiently. Submitted by readers, industry experts, and the Macworld staff, items in this department address all facets of Mac work, from applications to programming routines to capabilities of the Mac and software not covered in the documentation.

This issue's Open Window presents hints for using Macintosh application programs, desk accessories, and a few Microsoft BASIC programs, and some helpful items on recovering files, saving disk space, and using the Mini-Finder.

Applications

Quicker Key Caps

I've found a way to speed up use of the Key Caps option. Open a MacWrite document, select Key Caps, and move the window down to the bottom of the screen. Next, resize the MacWrite window to cover all but the keys (see the figure labeled "Quicker Key Caps"). Now type in your document, and Key Caps shows what you type. This simple procedure is useful when you are entering optional characters; it is much quicker than opening the Key Caps window every time to find the character you want. This technique can also be useful when you are using the Note Pad or the Calculator.

David Dunham
San Antonio, Texas

Paint Type

I came up with a couple of MacPaint type-size enhancements while designing a brochure cover. Because even 9-point letters were too large for the front control panels I was illustrating, I used FatBits to create an alphabet of letters only 5 dots high (a 9-point Geneva capital letter is 7 dots high) and saved it for future use (see the figure labeled "Tiny Letters").

My second idea evolved because the cover's large title looked too rough. Again using FatBits, I smoothed the angles of the letters to 45 degrees. Of course, some experimenting was necessary to produce the best-looking copy (see the figure labeled "Clean Up").

Robb Culp
Fresno, California

Pasting the Calculator

I have found a way to use the Calculator to operate on figures and equations in the Note Pad or a MacWrite document. For example, you may have a column of figures in a MacWrite document that must be totaled. Create the column using decimal tabs to align the numbers. In order to prepare the column for the Calculator, end each number with the character that represents the desired calculation (+, -, *, /, or =). Other Calculator keys can also be used: C for clear; E for an exponent, and period (.) for the decimal point.

The following is an example of this technique, using a sample column of figures (with spaces inserted in front of the 3 to lengthen the underline):

<table>
<thead>
<tr>
<th>Figure</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>123.45</td>
<td>+</td>
</tr>
<tr>
<td>678.90</td>
<td>*</td>
</tr>
<tr>
<td>2.00</td>
<td>/</td>
</tr>
<tr>
<td>3.00</td>
<td>=</td>
</tr>
</tbody>
</table>

- Set the decimal tab in the ruler above the calculation.
- Enter the numbers using the Tab key to space the decimal tab, and end each line with Return. After the last number, enter the equal sign so that the final result is calculated. Underline the last number if you wish to set off the result from the other numbers in the traditional manner.
- Select the entire calculation and then copy it to the Clipboard.
- Select the Calculator and paste the calculation into it. You
Tiny Letters
If MacWrite's smallest type size is still too big for your needs, you can create even smaller letters using MacPaint.

Pencil Into Pen
MacPaint users may find that the line produced by the pencil is rather lifeless. Although it faithfully follows movements of the hand, its width is fixed, even though variations of thickness and density of lines lend vitality to a pencil drawing.

MacPaint can become a more pliant sketching tool in the following way, which turns the pencil into what I call the pen.

Create a point with the pencil or the paintbrush, lasso the point, and move the cursor onto it. Press the Option and ⌘ keys simultaneously, hold down the mouse button, and start drawing (the two keys may be released). Because the point is reproduced at a constant rate, the density of the line is determined by the rate of mouse movement. You can alter the speed at which the point is generated by changing the width of the border palette selection; the wider the border, the slower the point is reproduced. You can also vary the mouse tracking speed in the Control Panel.

To move the point without marking the screen, release the mouse button and press it again when the cursor is over the point, and then drag the point. To reactivate the pen, release the mouse button, press Option and ⌘, then hold down the mouse button and draw. See the figure labeled "Pen Point" for an example of a "pen" sketch.

Alan Kay
Galveston, Texas
Open Window

![Open Window window](image)

Spreadsheet Tabs

To preserve a spreadsheet format when transferring it from Multiplan into MacWrite, set the appropriate tabs in MacWrite before pasting.

Spreadsheet Tabs

I had difficulty pasting part of a spreadsheet from Multiplan into MacWrite. The format consistently came up wrong. It turns out that this flaw occurs because the only tab already set when you open MacWrite is at 5½ inches. When you set tabs at appropriate locations (in this case, every inch) before you paste, the format looks like it did in Multiplan (see the figure labeled “Spreadsheet Tabs”).

John Damian
Lynnfield, Massachusetts

Large Circle

Although I enjoyed Jeffrey Young's article about MacPaint in your premier issue, I have to disagree with him on one point. He says that "it is impossible to draw a circle larger than one drawing screen." In fact, you can draw a large circle (or any symmetrical shape) using the following technique.

Draw a circle that fills the MacPaint window (select the circle tool and press the Shift and ⌘ keys while creating the circle). Use the straight line tool to segment one quarter of the circle. Erase everything but the quarter, surround it with the selection rectangle, and stretch it while pressing the Shift and ⌘ keys to keep the proportions intact. Then copy the quarter-circle, paste the copy onto another portion of the page (use Show Page to position the shape correctly), and flip it appropriately.

Repeat this process for the remaining two quarters, then lasso the segments and join them into a complete circle.

You could use this process to create a full-page pie chart for a presentation or to place a large shape in a full-page MacPaint illustration.

Pete Hansen
Everett, Washington

Programming

More Secret Characters

Your May/June issue's "Open Window" inspired me to tell people about three other secret characters I found while hacking around in Microsoft BASIC (MBASIC). The characters are: ⌘ ⌘ ⌘. I had seen them on the keyboard and in menus but never in a character chart or Key Caps. As far as I know, there is no way to input them from the keyboard, and they exist only in the Chicago font.

To get the characters, you must have MBASIC (another programming language will work, but you'll have to rewrite the program provided here). Start up MBASIC, key in the listing entitled "Special Characters," and type run. The characters are written to the Clipboard. To save them permanently, open the Scrapbook Clipboard and paste them from the Clipboard.

Because the Scrapbook displays text in 9-pt Geneva, the characters will appear there as □ □ □. Don't worry;

when you copy the characters into a document and change their font to Chicago, they reappear as themselves. The Clipboard saves the font of characters, so once you change them in a document you can copy them back to the Clipboard and paste them elsewhere in your document. Since the Note Pad uses the Geneva font, you can't have these hidden characters in it. But they can be used in a Get Info window, which shows text in Chicago.

David Dunham
San Antonio, Texas

Screen Map

In attempting to program some screen displays for a current project, I was having trouble estimating where on the screen the calls to the User Interface Toolbox would place boxes, lines, or text. If the screen coordinates I used inadvertently placed the object off the screen, the object would vanish; more often, it took much trial-and-error positioning to get everything placed correctly. I needed a screen map of the pixel positions.

Using MBASIC and the "64K treasure chest," I found it simple to construct such a map. After you enter, debug, and run the program in the listing entitled "Screen Map Code," take a snapshot of the screen using ⌘-Shift-4. If you move the command window off the bottom of the screen before running the program, less of the map gets erased when the output window is resellected before printing (see the figure labeled "Screen Map"). In MBASIC, any window that is placed over the output window erases the portion it overlays.

I found that putting a photocopy of the screen map on a clear plastic sheet allowed me to measure screen positions directly. This technique in turn enabled me to program both placement and mouse selection of text quite efficiently.

Andrew Dizon
San Diego, California
The office and personal management system that does everything...even windows!

Stash that clutter of pens, paper, pads, telephones, phone books and desk calendars. With MacPhone, a totally new TeleManagement System, THOSE OFFICE AND PERSONAL MANAGEMENT TOOLS GO INSIDE YOUR MACINTOSH. The result is an incredible combination of telephone utility and Macintosh power.

Write memos and file them. Enter and schedule appointments in your electronic calendar. Make a permanent record of your activities ready for print out at a moment’s notice.

Just select from a wide range of time management options with a simple click of the ‘mouse.’ Store up to 200 names and telephone numbers for easy computer dialing. Quick-dial frequently called or emergency numbers with up to 80 pull down names. Easy-to-use MacPhone makes efficient phoning a breeze. Calling long distance? MacPhone tells you which state, region and time zone the number is in, then it dials the call for you. After, you get a complete record of who you called and when. You even get a computation of the call’s cost, a recording of the charges and a record of all your notes right on your telephone log! Also, a time-billing feature automatically computes consulting fees at your specified rate during the time of the call.

The MacPhone TeleManagement System includes a touch-tone telephone, complete software, an operating manual and 90-day warranty. In high-tech design and colored distinctly Apple beige, MacPhone goes with Macintosh in beauty as well as function. An incredible value at a suggested retail price of $199.95.

*MacPhone is a trademark of Intermatrix
*Maccintosh is a trademark licensed to Apple Computer Inc.
Screen Map Code
You can create a map of the Mac screen for help in measuring screen positions.

```
10 CLS
20 X=1
30 FOR R=10 TO 260 STEP 10
40 FOR C=10 TO 500 STEP 10
50 IF (R MOD 100=0) OR (C MOD 100=0) THEN X=2 ELSE X=1
60 CALL MOVETO(C-X,R):CALL LINE(2*X,0)
70 CALL MOVETO(C,R-X):CALL LINE(0,2*X)
80 NEXT C
90 NEXT R
100 CALL MOVETO(300,200):PRINT "text starts at 300,200"
```

Screen Map
This screen map is produced by taking a snapshot (Alt-Shift-4) of the screen after running the "Screen Map Code" program.

System

Recovering Files
I made a discovery about salvaging files on a disk that displays the alert box with the bomb and will not reboot. Remove the crashed disk by holding down the mouse button and switching the Mac off and on, as the owner's manual suggests.

Load a working disk that has the application program that corresponds to the files on your damaged disk. Open an application—MacWrite, for example. When the blank page with its Untitled heading appears, use the Close option in the File menu to exit from the file. Immediately use the Open option and when the dialog box appears, click Eject. Put the crashed disk into the drive again. The file related to the application you closed on the other disk should now appear. You can load the files and use the Save As option to place them on another disk.

```
Warren Barbour
Buffalo, New York
```

Saving Printer Paper
I was getting tired of losing a clean sheet of paper in between every printing. I eliminated this waste by filling in the From and To boxes in the Print dialog box with the beginning and ending page numbers. That way the printer always stops at the end of the printed work and doesn't kick out an extra page, nor does it skip any blank pages during printing.

```
Andrea Subaka
Englewood, Colorado
```

Paper Clip Fix
The following procedure allows you to erase a disk that the Finder can't recognize. Start with a good disk such as Write/Paint. Choose Erase Disk from the Special menu. A dialog box then prompts you to click OK (to erase) or Cancel (to stop the operation). Do not respond to the box yet. Instead, straighten a paper clip and insert it into the little hole at the lower-right corner of the disk drive. This procedure ejects the disk while leaving the dialog box on the screen. Now insert the bad disk and click the OK button. The Mac erases the bad disk and it is ready to use again.

```
Richard and Barbara Rettke
Appleton, Wisconsin
```

Type-Selecting the Mini-Finder
I discovered an undocumented feature of the "Mini-Finder," the dialog box that lists the files you have created within a particular application. If you have several MacWrite files (enough files to make the scroll bar active, for example), usually you must scroll the directory window to find the file name you want. However, you can also select a specific file or the first file beginning with a particular letter by typing the first letter of the desired file name when the Mini-Finder dialog box is displayed. If a file doesn't exist for a letter typed, the Mini-Finder selects the first file name beginning with the letter that occurs after the typed letter. For example, if you have a file that begins with the letter C and one that begins with L, and there are none in between, typing the letter D selects the file beginning with L.

If you use the numeric or symbol keys to select file names, the Mini-Finder responds appropriately when you type in the corresponding character. If you don't have file names that use a particular numeric or symbol key and you type one of those characters, the Mini-Finder selects the file according to its location in the ASCII collating sequence. It selects the first file name beginning with the character that occurs in the sequence after the character typed.

A note to the programmers at Apple: it would be useful if people could scroll horizontally to read the full names of files. This feature would allow more information to be kept in the Mini-Finder.

```
Anna Katz
Davenport, Iowa
```

More Space Saving
MacWrite permits you to save documents either with or without formatting (rulers, special fonts, pictures, and other enhancements). However, the MacWrite manual doesn't mention that saving documents without all the formatting specifications—by using the Text Only option in the Print dialog box—can save you up to 30 percent of your disk space.

I compared the disk and memory usages of two typical documents in their entirety and as text only. The first document was a standard one-page letter with one additional ruler and two boldfaced words. The second was a longer, fancier re-
port that included large fonts, shadowing, lots of italics, and several tables using multi-tabbed rulers. Here’s what I found:

<table>
<thead>
<tr>
<th>Entire Text Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter: memory</td>
</tr>
<tr>
<td>disk</td>
</tr>
<tr>
<td>Report: memory</td>
</tr>
<tr>
<td>disk</td>
</tr>
</tbody>
</table>

The memory savings are negligible, but the comparison shows that after you’ve printed your letters, it makes a lot of sense to store your backup copies of them as Text Only. About the only time you’d want to save an entire document with formatting would be when it contained pictures or multiple rulers that would be hard to reconstruct.

Bill Johnstone
Victoria, British Columbia

Perhaps you’ve come up with a nifty routine, gained some insight into how the Mac or an application program works, or even written a short program that performs a useful function or creates an interesting diversion. Tell us about it, and we’ll pass your discovery along. We’ll also pay $25 to $100 for each Open Window item published. Please send your Macintosh discoveries on disk (which we will return) to Open Window, 555 De Haro St., San Francisco, CA 94107, or electronically to CompuServe 74055,412 or The Source STE908. All submissions become the property of Macworld.
Computer games are the most colorful and popular kind of software for personal computers. In the Macintosh's relatively brief life, however, only a few of the games that have excited thousands of players have been transported to the new computer. But fear not—many designers are hard at work, and the near future will bring a veritable parade of well-known games dressed in the Mac's own flashy wardrobe.

Many game designers and programmers view the Mac's user interface as a special challenge. Because a game's playability hinges on its player interface—how you relate to and interact with the game scenario—the Mac may turn out to be one of the best game computers ever.

Andrew Greenberg, coauthor of Sir-Tech's popular fantasy role-playing game, *Wizardry* (in which explorers work their way through elaborate mazes), explains: "It's not so much the windows, the mouse, the pull-down menus, and other elements, but the way the features fit together that will allow us to present games in a new light. With the Mac, we'll be able to create more complex, detailed, and strategic games with better player interfaces than we've had before." Greenberg says that he and Robert Woodhead are rewriting *Wizardry* from top to bottom for a Mac version.

Greenberg's uninhibited enthusiasm is shared by game wizards around the nation. The Mac's speed and high-resolution graphics offer new dimensions for high-tech fun and games. "I love it!" grins Tom Snyder, author of educational favorites such as the mystery/adventure *Snooper Troops*, which runs on the Apple II and others. Snyder heads an independent game development company whose resident "Macgenius" is already designing a Mac-specific game.

Francis Pandolfi, whose Scarborough Systems markets many of Snyder's games, also admires the Mac. But Pandolfi shows caution that typifies the attitude of the industry's other half, the people who market the games. "Our programmers have expressed a lot of interest in working on Mac software, but do we spend $10,000 to $15,000 to convert a game that runs on another computer?" he wonders. "With a new machine, you always run the risk of overspending without being sure of the market. Developing games for the Mac may be risky at this stage." Nevertheless, Scarborough is releasing a Mac version of *Run for the Money*, Snyder's animated business simulation game. "We're uncertain about where people will use the Macintosh, at home or in the office, but we're confident about the appeal of *Run for the Money*," Pandolfi explains.

**Adventuring on the Mac**

Most major game makers have anted up with at least one or two conversions of hit titles. They can't afford to lose a seat at the table in the high-stakes game of entertainment software. Penguin Software placed an early bet when they released *Transylvania* in May. The novel presentation of this adventure exemplifies how the Mac's high-resolution graphics enhance playability.

Instead of using the traditional method of filling the screen with a picture and putting the command line and the text on the bottom four lines, *Transylvania* displays the illustration in a window that fills the upper-left quarter of the screen. A line or two of descriptive text below the picture tells the player's current location. In a vertical window that takes up the right half of the screen, the player's typed commands and the game's responses appear, making it easy to re-

Tom Snyder is caught up in his business simulation game, *Run for the Money*. A sample of the Mac version of its animated graphics is shown at the left.
Andrew Greenberg (top) and Robert Woodhead claim that their fantasy role-playing game, Wizardry, has a hypnotic effect on players. They are rewriting it for the Mac.

development system, which saves many hours of programming. Programmers can concentrate on fleshing out characters, situations, and alternatives in a game, rather than spending time creating graphics.

Bob Hardy, who translated the Apple II version of Transylvania for the Mac, considers the computer best suited for adventures, especially graphics games. He points out that the Mac usually has enough memory to retain data for at least two illustrations. When a player moves from one room to another in the game, for example, the program can quickly sketch a new scene so the player doesn't always have to wait while it searches the disk for the data to create the scene.

In Matters of Text
Because their adventures are all text, the programmers at Infocom, developer of the Zork series and other games, don't have to utilize the QuickDraw graphics routines. However, they have incorporated many of the Mac's other features into their games. Infocom programming supervisor Dan Horn says that the company's first wave of Mac games will substitute an Infocom logo for the "Welcome to Macintosh"
greeting and will employ pull-down menus for commands such as those to save and restore games, quit, and start or stop printing. "Players can select fonts from a menu; we'll include most of the Mac fonts, though in one size only," Horn reports. "You can copy game text into the Note Pad, Clipboard, or Scrapbook for later study, or paste it into another portion of the game."

Faster than a Bullet

No matter where game designers stop, adventure and strategy game players stand to profit most from the Mac's gaming potential. Shoot-'em-up fans will appreciate the fast-moving action that results from the speedy 68000 microprocessor. Bill Budge designed Electronic Arts' Pinball Construction Set (PCS), in which players build and then play customized pinball games. Budge, who had a plexiglass-encased Mac two years ago, thinks that the Mac's speed gives it a substantial edge over other machines in allowing him to develop games that require rapid visual changes and therefore might run too slowly on other computers.

This speed will facilitate ease of play for users in strategy and war games. Hayden Software Company's chess game Sargon III, for example, reportedly runs two to three times faster on the Mac than on the IBM PC.

Budge says that QuickDraw is "fast enough for the Space Invaders kind of action/combat games to be written entirely in Pascal, instead of in assembly language. But commercial games will have to be done in assembly language to push the Mac to the max." Quick-Draw's powerful routines are too slow for moving around lots of fast-moving independent graphics objects.

Speeding spaceships and exploding laser bursts will sound genuine, thanks to the Mac's built-in sound effects. The Mac's potential for producing four-part harmony will serve it well as sound technology, spurred by the audio features of the Commodore 64, becomes more complex and increasingly important in the computer games of the Eighties.

The Great Mouse Controversy

Most game players find that the mouse is sharp at jetting diagonally across text or numbers, but they may wonder how it will perform under fire, facing an onslaught of Galaxian nightfighters. Sierra On-Line programmer Kevin Hunt converted the best-selling arcade-style game Frogger (in which players move a frog through perilous adventures) from the Apple II to the Mac. Hunt isn't happy with the mouse. "The mouse interferes with a certain intuitive feel that you need for what you want to do," he says. "You click the mouse to move an object on the screen in the direction the mouse is pointing. But since you can't tell which way the mouse is pointing as easily as you can with a joystick, the process is more difficult. That's why I'm including both keyboard and mouse controls in the Mac version of Frogger."

Budge, a self-described "mouse fan," argues that the mouse action is so fast that wiping out aliens will be as easy as "squishing ants with a shovel." He's right, at least for certain games; essentially, the mouse is an upside-down track ball, a controller that excels at guiding a "spaceship" rapidly back and forth across the screen. Carrying out such maneuvers will be a snap on the Mac, unless the game's programmer intentionally slows down the mouse. Other maneuvers, like turning corners and making short movements in maze games, won't work so well with the mouse.

Many joystick manufacturers haven't made up their minds about producing controllers (input devices such as mice, joysticks, and keypads) for the Mac. But Budge envisions software-generated controllers: "You could create a steering wheel for a driving simulator, controlled by dragging the wheel around the screen with the mouse." Regardless, some exciting, competitive games that require individual joysticks for two players (Electronic Arts' Arcbron and Gamestar's... (continues on page 127)
Games for the Macintosh

Most of the following games will be available by the end of this year. This list is merely a sample of what to expect in the coming months. Stay tuned to Macware News for further information.

Adventure

Infocom, Inc.
55 Wheeler St.
Cambridge, MA 02138
617/492-1031
• Zork I $39.95
• Zork II $49.95
• Zork III $49.95
• Deadline $59.95
• The Witness $39.95
• Suspended $59.95
• Starcross $59.95
• Planetfall $39.95
• Enchanter $49.95
• Sorcerer $49.95
• Infidel $49.95
• Seastalker $39.95
• Cutthroats price unavailable

Penguin Software
830 Fourth Ave.
P.O. Box 311
Geneva, IL 60134
312/232-1984
• Transylvania $39.95

Pryority Software, Inc.
P.O. Box 221959
Carmel, CA 93922
408/625-0125
• Forbidden Quest $44.95

Sentient Software, Inc.
P.O. Box 4929
Aspen, CO 81612
303/925-9293
• Cyborg $39.95

Role-playing

Origin Systems
1545 Osgood St. #7
North Andover, MA 01845
617/681-0609
• Exodus: Ultima III $59.95
• Ogre price unavailable

Penguin (listed above)
• Xyphus $39.95

Sierra On-Line, Inc.
3675 Mudge Ranch Rd.
Coarsegold, CA 93614
209/683-6858
• Ultima II price unavailable

Sir-Tech Software, Inc.
6 Main St.
Ogdensburg, NY 13669
315/393-6633
• Wizardry series price unavailable

Strategy

Apple Computer, Inc.
20525 Mariani Ave.
Cupertino, CA 95014
800/538-9696, in California
800/662-9238
• Alice price unavailable

Blue Chip Software
6744 Eton Ave.
Canoga Park, CA 91303
818/346-0730
• Millionaire $59.95
• Baron $59.95
• Tycoon $59.95
CBS Software
One Fawcett Pl.
Greenwich, CT 06836
203/622-2615
• Murder by the Dozen $34.95

DataPak Software, Inc.
14755 Ventura Blvd. #1-774
Sherman Oaks, CA 94103
818/905-6419
• Mac-Jack $39.95

Hayden Software Company
600 Suffolk St.
Lowell, MA 01853
800/343-1218, 617/937-0200
• Sargon III $49.95

Lewis Lee Corporation
1646 Portola Ave.
Palo Alto, CA 94306
415/853-1220
• Bank President $74.95

Penguin (listed above)
• Pensate $39.95

Soft-Life Corporation
2950 Los Feliz Blvd. #103
Los Angeles, CA 90039
213/660-7940
• Mac-Slots $77.77

Human Engineered Software
150 N. Hill Dr.
Brisbane, CA 94405
415/468-4111
• Project Space Station
  price unavailable

Scarborough Systems
25 N. Broadway
Tarrytown, NY 10591
914/332-4545
• Run for the Money $49.95
• Master Type price unavailable

Think Educational Software
16 Market St.
Potsdam, NY 13676
315/265-5636
• Mind Over Mac $49

Ann Arbor Softworks, Inc.
308/2 S. State St.
Ann Arbor, MI 48103
313/996-3838
• Laser Hopper $39.95
• Lunar Explorer $39.95

Broderbund Software
17 Paul Dr.
San Rafael, CA 94903
415/479-1170
• Lode Runner price unavailable

Electronic Arts (listed above)
• Pinball Construction Set
  price unavailable

Sierra On-Line (listed above)
• Frogger price unavailable
• B.C.'s Quest for Tires price unavailable

Educational

Electronic Arts
2755 Campus Dr.
San Mateo, CA 94403
415/571-7171
• Music Construction Set
  price unavailable
Star League Baseball, for example) won't be available because the Mac has only a single controller port. And many arcade-style action games, such as Penguin's Minit Man, depend on a joystick with three firing buttons. Duplicating this arrangement with a mouse/keyboard combination would make it difficult and awkward for a player to maneuver.

The Black-and-White Blues

Game companies and programmers groaned when they heard that the Mac would have no color graphics, which are considered essential for action games' vivid explosions, varicolored spaceships, and lush backdrops. Lack of color is the reason that Sierra On-Line is not converting some of its high-resolution graphics adventures, which depend on color to supplement their simple line drawings. However, this has not stopped Sierra from producing a Mac version of its tremendously popular Frogger.

On the other hand, Trip Hawkins, president of Electronic Arts, whose games such as Archon (a chess-type game that includes combat between pieces) are among the most colorful and exciting, believes that no color is "not that big a drawback." Sierra programmer Hunt thinks that "the virtually artistic resolution of the Mac will force people to be more creative with details and shapes because they won't have color to distract players with." According to Infocom's Horn, "Even without color, the Mac might be the best game machine on the market. If the quality of a game is solid, you don't need color—especially with the outstanding resolution."

Bill Budge finds the Mac's lack of color a handicap for some games. "For flight simulators, a black-and-white display isn't bad if you use line shading and half-tones. But I was discouraged about the Mac having no color until I added new details, shadows, and other pinball objects made possible by the high-resolution graphics. Now I think PCS could look better on the Mac than on the Apple II, and certainly Mac owners won't be disappointed."

A New Species of Game

All the games discussed here are conversions of existing personal computer games. The only Mac-specific game to date is Apple's Alice (created by Steve Capps). This three-dimensional, chess-type game, which is viewed from one side of the board rather than from overhead, will influence future Mac games. Three-dimensional graphics will gain emphasis, especially in "first-person" arcade-style games that display a view like what the pilot of a spaceship or a race car would see from the driver's seat (as opposed to "third-person" games in which the player directs a character on the screen). The arcade game Star Wars is a typical first-person shoot-'em-up, the type of action game for which the Mac is best suited due to its speedy, high-resolution graphics. Sierra's Hunt intends to work on a game for the Mac that is similar to Star Wars in his spare time.

Because game manufacturers are waiting to see how many Macintoshes end up in homes before they invest in programming Mac-specific games, it could be a year or more before many games show up in stores. But this caution ensures that developers will convert only the best existing games. Ultimately, games that run only on the Mac will emerge from designers and programmers, whose avant-garde ideas snowballed into today's multimillion-dollar computer game industry. If you think the Mac's a fun machine to work on, wait until you see how much fun it can be when fun's the name of the game. ☐

Kevin Hunt gets ready to croak a few toads while racing through the streets of his action game, Frogger. The black-and-white Mac version uses both keyboard and mouse.

Bill Budge did the work of three programmers in writing Pinball Construction Set. The Mac version of his action game is not ready yet.

Shay Addams is Managing Editor of Computer Games magazine. He is currently working on two books about computer games for Simon & Schuster.
Introducing

MACWORLD

The Macintosh Magazine

The Exciting New Magazine for the World's Most Creative Personal Computer—the Macintosh

At Special Charter Subscriber Rates
Save Up to 54% Off the Newsstand Price*
(*when you subscribe for 3 years)

Personal computing took a giant leap into the future when Apple introduced the Macintosh. We've created Macworld as your passport into this incredible new realm of computing. Each issue we'll bring you everything you need to explore and get the most out of your Macintosh. From the latest product news to innovative business applications, from amazing graphics to personal productivity tools and games, each issue of Macworld will be packed with interesting, practical, readable information written by skilled, perceptive writers.

Each month we'll be creating a Macworld community; sharing ideas, problems, and creative solutions while we explore the world of Macintosh together.

So why take a chance on missing a single exciting issue? For a limited time only you can subscribe to Macworld at special Charter Subscriber rates of only

$24 for 1 year (12 issues)
That's a savings of 20% off the regular $30 subscription rate and 50% off the newsstand price!

And you can save even more by subscribing for 2 or 3 years at Special Charter Rates. Don't Wait...Subscribe Today and Save!
Special Charter Subscription Offer

Save 50% off the Newsstand Price!

Newsstand

Regular Subscription Rate

$24 Special Charter Offer

Order Now to Take Advantage of This Limited Time Offer! VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

YES! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me ☐ Payment Enclosed

Please Send Me: ☐ 12 issues/$24 ☐ 24 issues/$46 ☐ 36 issues/$66

Name ____________________________________________________________

Company _______________________________________________________

Address _________________________________________________________

City, State, Zip __________________________________________________

Please allow 6-8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $12 per 12 issues for surface mail or $60 per 12 issues for airmail.

Macworld will be published in May, July, and September 1984 and will begin monthly publication in November 1984.
Introducing a pocketful of miracles.

It's the new BASF Qualimetric™ 3.5" Micro FlexyDisk®. Its name is a lot bigger than its size, and a lot smaller than its capacity—one astounding megabyte. Our new Micro fits into more than shirt pockets. It fits into several of the hottest new small portable personal computers—like Apple™ Computer's new Macintosh™ and Lisa™ 2 and Hewlett-Packard's HP-150 Touchscreen PC.

The Qualimetric part is what makes our Micro FlexyDisk different from the others that will inevitably follow. It indicates a new standard in design, production, inspection, and testing. This standard enables us to warranty the Micro for a lifetime*. No more, no less. In addition, we certify that each bit of every byte on or between every track on each Micro FlexyDisk is 100% error-free. That's because we know, while each Micro FlexyDisk may only cost a couple of bucks, the hours and brain cells you put into it are priceless.

For those occasions when you need more than a pocketful of miracles, we provide a handy and virtually earthquake-proof 5-pack. It's sized to slip easily into your briefcase, handbag, or backpack.

For a plethora of technical details about our new Micro FlexyDisk and even more important information on where to buy it, call toll-free. 1-800-343-4600.

*Contact BASF for a copy of our warranty.
Macworld and Apple Computer are sponsoring an art contest for MacPaint artists. Beginning in the December issue of Macworld, each month we will award a first prize of $500 and two runner-up prizes of $250 for original artwork created with MacPaint. A committee of five judges—members of Macworld's editorial and art departments, as well as Susan Kare, Apple's resident artist—will view the entries and select the winners. Gallery exhibitors who do not win a prize will receive the standard $25 payment for each drawing used.

Once a year the first-place entries from each issue will again be judged, and a grand prize of $5000 and two runner-up prizes of $2500 will be awarded. The first grand prize will be announced in the November 1985 issue of Macworld.

To enter the contest, send a paper copy of your artwork and a detailed description of the techniques you used to create it to Macworld Gallery, 555 De Haro St., San Francisco, CA 94107. Please include your address and phone number with each submission. If your drawing is selected, we will ask you to send a copy of it on disk. All disks become the property of Macworld.
Lorenzo de' Medici

This is a fourth-generation artwork: it's a copy of a pen-and-ink drawing I did of a photograph of Michelangelo's sculpture. The picture was drawn entirely freehand. I outlined the various shaded areas with the single-dot brush, then filled them in using the paint bucket. I removed the outlines in FatBits. Because only part of a full-page drawing appears on the screen at any one time, it is difficult to get proportions right (although the Show Page option helps). After I finished sketching the figure, I could see that I had made the legs too long. But I was able to do something I couldn't have done to my original drawing: I simply compressed the legs (with the key) until their proportions were correct.

Bob Donald
Grand Forks, North Dakota
Old Town/Silhouettes
I've been using the Macintosh for two weeks and I've found MacPaint easy to use, although I've never used a computer before. As a second-year fine arts student, I see possibilities for using MacPaint to do preliminary sketches, draw trial perspectives, and move objects around to produce a pleasing composition before starting a painting. Old Town was drawn freehand with the single-dot brush, except for a few of the vertical lines, which I drew with the straight line tool. I did most of the shading with the spray can but filled a few of the smaller areas with the paint bucket. I outlined the buildings in Silhouettes with the single-dot brush and the straight line tool, then filled in the black areas with the paint bucket. I used the filled rectangle to block out the windows and the doors, then added the white areas in FatBits.

Esther R. Travis
Vancouver, British Columbia
Iron Lady
This picture was drawn from a photograph and covers almost two MacPaint windows. In order to keep the proper perspective, I used two grids. First I drew a grid on clear plastic and placed it over the photo. Then I used a felt-tip pen to sketch an outline of the train's basic shapes onto the plastic. I drew another grid of the same size on the screen. Looking from one grid to the other, I copied the outline into the grid squares on the screen, then erased the displayed grid. I filled the outlined areas with various patterns using the paint bucket, then added shadows and highlights with the paintbrush and worked on details in FatBits. I found that raising the Mac to eye level by placing it on a small stand made it easier to do this type of detailed artwork.

Gerald V Clement
Lafayette, California
Idol/The Girls
I work as a freelance illustrator. Although I've had my Mac for only a short time, I certainly enjoy drawing with MacPaint. I drew the face in Idol with the pencil and added shading with the brush. The hair, the background, and the shirt were done with the solid freeform shape in various patterns. To create The Girls, I drew a figure, selected it with the lasso, and smeared it across the page by holding down ⌘-Shift-Option. I added patterns to the dresses and to the background with the paint bucket.

Janet Watt
Providence, Rhode Island
<table>
<thead>
<tr>
<th>Reader Service Number</th>
<th>Advertiser, Page</th>
<th>Reader Service Number</th>
<th>Advertiser, Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>67</td>
<td>Amaray, 58</td>
<td>40</td>
<td>Hayden Software Company, 97-99</td>
</tr>
<tr>
<td>71</td>
<td>Applications Unlimited, 140</td>
<td>35</td>
<td>Hippopotamus Software, 65</td>
</tr>
<tr>
<td>68</td>
<td>Applied Creative Technology, Inc., 139</td>
<td>43</td>
<td>ICON Concepts Corp., 142</td>
</tr>
<tr>
<td>21</td>
<td>ASSIMILATION PROCESS, 5, 75</td>
<td>8</td>
<td>Infocom, 40</td>
</tr>
<tr>
<td>59</td>
<td>BASF, 129</td>
<td>73</td>
<td>I-O Tech, 142</td>
</tr>
<tr>
<td>33</td>
<td>The Brown Line, 140</td>
<td>11</td>
<td>Kensington Microware, 16</td>
</tr>
<tr>
<td>46</td>
<td>Brock Software Products, 38</td>
<td>50</td>
<td>Living Videotext, 105</td>
</tr>
<tr>
<td>20</td>
<td>The Casemaker, 141</td>
<td>4</td>
<td>MacConnection, 19</td>
</tr>
<tr>
<td>12</td>
<td>Chang Labs, 113</td>
<td>28</td>
<td>MACPACK, 137</td>
</tr>
<tr>
<td>53</td>
<td>Club Mac, 143</td>
<td>51</td>
<td>MacStation, IFC</td>
</tr>
<tr>
<td>62</td>
<td>Co-Du-Co, 65</td>
<td>23</td>
<td>Magnum Software, 138</td>
</tr>
<tr>
<td>66</td>
<td>Computer Software Design, 29</td>
<td>2</td>
<td>Manhattan Graphics Corporation, 130</td>
</tr>
<tr>
<td>64</td>
<td>Creighton Development, Inc., 138, 141</td>
<td>72</td>
<td>Microcom, Inc., 86-87</td>
</tr>
<tr>
<td>1</td>
<td>Cuesta Systems, 65</td>
<td>24</td>
<td>Micro-Design, 94</td>
</tr>
<tr>
<td>15</td>
<td>Davong Systems, IBC</td>
<td>3</td>
<td>Micro Flash Computer Systems, 143</td>
</tr>
<tr>
<td>52</td>
<td>DNA, Inc., 143</td>
<td>63</td>
<td>Micron Technology, Inc., 83</td>
</tr>
<tr>
<td>69</td>
<td>Dow Jones, 84-85</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>ExperTelligence, Inc., 136</td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Empress Technology, Inc., 142</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Habas Systems, Inc., 12-13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Miles Computing, Inc., 46</td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>Mirage Concepts, Inc., 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>Novation, Inc., 66</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Odessa, 16a</td>
<td>34</td>
<td>Optimum Computer Luggage, 47</td>
</tr>
<tr>
<td>38</td>
<td>Organizational Software Corp., 41</td>
<td>74</td>
<td>Owl Software, 96</td>
</tr>
<tr>
<td>74</td>
<td>Palantir, 144</td>
<td>4</td>
<td>PC Connection, 19</td>
</tr>
<tr>
<td>45</td>
<td>PC Network, 100</td>
<td>44</td>
<td>Raex Enterprises, 96</td>
</tr>
<tr>
<td>49</td>
<td>Real Data, Inc., 142</td>
<td>39</td>
<td>Replitek, 143</td>
</tr>
<tr>
<td>29</td>
<td>T/Maker Graphics, 20</td>
<td>14</td>
<td>Tecmar, Inc., 1, 1, BC</td>
</tr>
<tr>
<td>55</td>
<td>Telesoft, 4</td>
<td>54</td>
<td>Telos Software Products, 21-23</td>
</tr>
<tr>
<td>58</td>
<td>Totem, Inc., 138</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Videx, Inc., 49</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ExperLogo for the Macintosh™ is a powerful, many faceted version of the Logo computer language originally introduced in the late 1960's. ExperLogo excels as the patient tutor for those being introduced to computers for the first time, while at the same time it serves as a powerful development tool for the skilled programmer. Taking full advantage of the simplified user-interface characteristics of the Macintosh, ExperLogo is easier to use than any previous Logo.

Graphics is a great place to start exploring, and ExperLogo is loaded. In addition to standard Turtle graphics, ExperLogo introduces Bunny Graphics™ where bunnies scamper on the surface of spheres and cubes and even through 3D space. Incidentally, we call them bunnies because they are incredibly fast, moving at speeds up to 100 times that of the turtle in other Logos. The speed is attained because ExperLogo is the only compiled version of Logo available.

The speed, combined with other advanced features that eliminate memory constraints and provide for sophisticated data file manipulation, are some of the reasons ExperLogo is now ready to assume the additional role as a serious program development language.

ExperLogo embodies power and versatility while retaining Logo's original virtues of being easy and fun to use. Have an ExperLogo experience. Ask your local Apple dealer for a demonstration today.
Reader Inquiry Service

Would you like further information on a product that's advertised in Macworld? Well, it's easy and best of all—FREE!

Just follow these simple instructions:

- Print or type your name and address on the attached card. One card per person, please.
- Circle the number(s) on the card corresponding to the Reader Service number in the Advertiser Index.
- Drop the card in a mailbox and wait to receive the literature that will be mailed to you free of charge from the manufacturer.

The address on the attached card is for product information only.

Send editorial comments or inquiries to: Macworld, 555 De Haro St., San Francisco, CA 94107.

---

Survey

Will you please take a few minutes to answer the following questions? Your answers will be kept in strict confidence and used only in combination with others to develop a profile that we will use to learn more about our readers.

A. Please check whether you are:
   - Male
   - Female

B. What is your age?
   - Under 18
   - 18-24
   - 25-34
   - 35-44
   - 45-54
   - 55-64

C. Please state your title and industry:

D. What was the last level of education you completed?
   - Completed high school
   - Some college
   - Completed college
   - Post-graduate work
   - Post-graduate degree

E. What category best describes your family's total annual income before taxes?
   - Under $15,000
   - $15,000-$24,999
   - $25,000-$34,999
   - $35,000-$49,999
   - $50,000-$64,999
   - $75,000 or more

F. Do you currently own a Macintosh?
   - Yes
   - No

   Are you thinking of purchasing one?
   - Yes
   - No

   If yes:
   - For your home
   - For your business
   - For use in both

G. Do you own another computer or use one at work? Please indicate the system(s):

H. Computer experience:
   - Less than a year
   - 2-3 years
   - 4 or more years

I. What kind of software programs do you find most useful?
   - Word processing
   - Spreadsheets
   - Integrated packages
   - Graphics
   - Accounting
   - Database management
   - Games/Entertainment
   - Other

J. Programming:
   - BASIC
   - FORTH
   - PASCAL
   - COBOL
   - FORTRAN
   - OTHER(s)

K. What kind of articles interest you?
   - Software reviews
   - Hardware reviews
   - Games/Entertainment
   - Communications
   - New product news
   - Personal/Home management
   - Education
   - OTHER(s)
MacPak
The ideal campus and travel bag. Compact, but still room for extra-disk drive, modem and padded pouch for numeric keypad. Pockets for cords & disks. Large zippered pocket for papers, books & manuals. Cordura® Masonite and high density foam make this quality pack shock and weather resistant. Can be carried 3-ways: like a suitcase, shoulder-sling or by hideaway backpack straps. Black, Navy Blue, Grey, Burgundy. $89.00 (add $5.00 for shipping)

MacBag
The same in size and construction as the MacPak, but without the backpack strap. Black, Navy Blue, Grey, Burgundy. $79.00 (add $5.00 for shipping)

MacCover - Home:
Beautiful vinyl, cloth-backed dust cover. Aids in static prevention and kid protection. Black or Brown

MacCover - Office:
Easy storing dust cover, perfect for office or small space. Black or Brown
3 piece $29.00 (add $3.00 for shipping)
5 piece $37.00 (add $3.00 for shipping)
(numeric key pad & extra disk drive)

PrintPak
Cordura® and high density foam make this case essential for transporting the Imagewriter® printer. Can be carried by shoulder sling, like a suitcase or attached to the MacPak while carried as a backpack. Black, Navy Blue, Grey, Burgundy. 11" $49.00 (add $3.00 for shipping) 15" $54.00 (add $3.00 for shipping)

MacFreighter
A super case for shipping. If you travel a lot this is the way to take it. A recent magazine review stated "there was none better made." Suggested retail is $295.00 but we're selling this direct at $199.00 (add $10.00 for shipping)

PrintFreighter
Same exact construction as MacFreighter for carrying Imagewriter® Printer. 11" $169.00 (add $10.00 for shipping) 15" $179.00 (add $10.00 for shipping)

To order call 1-800-227-3800, ext. 241, or mail check, money order, MC or VISA to: MacPacks, P.O. Box 3928, Kent, WA 98032 (WA residents add 7½ sales tax)

For more information call: (206) 839-0432

PROMPT SHIPPING

Satisfaction Guaranteed. If for any reason, you are not satisfied with any item purchased, you may return it within 30 days for a complete refund. Guaranteed against rips or tears for the life of the bag.

MacPacks
Carriers, Packs and Covers for the Macintosh®

Circle 28 on reader service card
Classic Transportation

with a Lifetime Guarantee!

The TOTEM™ carrying case for the Mac has more deluxe features than any other pack, including Apple's. Where else can you find:

- Compartments to carry Mac, mouse, keyboard, 2nd disk, modem, disks, cables, and documents
- Collapses for easy storage
- Comfortable Backpack option
- Leather bottom

Comes in blue, beige, red, green, camouflage, & black

TOTEM, INC.
207 Gough St. #38
San Francisco, CA 94102 (415) 761-7920 $110

ProPrint

announces...

YOU CAN NOW USE A LETTER QUALITY PRINTER WITH YOUR MACINTOSH™

- **ProPrint** is a printer driver program that will output text directly to your letter quality printer.
- Compatible with your favorite Mac word processor; uses pull-down menus.
- Prepare professional letters, reports and documents that look like this

Dear Mr. Smith; We would like to welcome you to

rather than this

Dear Mr. Smith, We would like to welcome you to

- **ProPrint** supports all popular serial letter quality printers

<table>
<thead>
<tr>
<th>ABATI*</th>
<th>BROTHER*</th>
<th>COMREX*</th>
<th>DIABLO*</th>
<th>JUKI*</th>
<th>QUME*</th>
<th>SILVERREED*</th>
<th>STAR*</th>
<th>NEC*</th>
<th>SMITH CORONA*</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMDEK*</td>
<td>C. ITOH*</td>
<td>DAISYWRITER*</td>
<td>DYNAX*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Fully Warranted
- Available with or without Cable
- Complete Instruction Manual
- Available for Immediate Shipment
- Order Direct Today or See Your Local Dealer

**ProPrint** ...... $74.00
**ProPrint** W/CABLE ...... $99.00

Creighton Development, Inc.
4931 Birch St., Newport Beach, CA 92660 (714) 476-1973

Creighton Development, Inc.
4931 Birch, Newport Beach, California 92660

ProPrint is a registered trademark of Creighton Development, Inc.

TM-Macintosh is a trademark licensed to Apple Computer, Inc.

ProPrint is a registered trademark of Creighton Development, Inc.

*Registered trademarks of respective companies.

Visa/MasterCard accepted. Add 12.00 shipping/handling.

California Residents add 6 1/2% sales tax.

Creighton Development, Inc.
4931 Birch, Newport Beach, CA 92660

(714) 476-1973

Circle 59 on reader service card

Over 130 Pictures, Ready to use!

No art ability needed. Each picture is totally usable "as is" and totally useful for business, home, school, clubs!

Plus, with MacPaint* / MacWrite* you can take a MacPicture and... Clone it. Change it. Combine it. Enlarge it. Shrink it! And, the special Hint Manual gives you step-by-step graphic examples of how to customize the pictures in a thousand different ways.

At Macintosh** dealers now!

$49.95 + Disc + terrific Hint Manual

Circle 51 on reader service card

Magnum

YOU CAN NOW USE A LETTER QUALITY PRINTER WITH YOUR MACINTOSH™

- **ProPrint** is a printer driver program that will output text directly to your letter quality printer.
- Compatible with your favorite Mac word processor; uses pull-down menus.
- Prepare professional letters, reports and documents that look like this

Dear Mr. Smith; We would like to welcome you to

rather than this

Dear Mr. Smith, We would like to welcome you to

- **ProPrint** supports all popular serial letter quality printers

<table>
<thead>
<tr>
<th>ABATI*</th>
<th>BROTHER*</th>
<th>COMREX*</th>
<th>DIABLO*</th>
<th>JUKI*</th>
<th>QUME*</th>
<th>SILVERREED*</th>
<th>STAR*</th>
<th>NEC*</th>
<th>SMITH CORONA*</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMDEK*</td>
<td>C. ITOH*</td>
<td>DAISYWRITER*</td>
<td>DYNAX*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Fully Warranted
- Available with or without Cable
- Complete Instruction Manual
- Available for Immediate Shipment
- Order Direct Today or See Your Local Dealer

**ProPrint** ...... $74.00
**ProPrint** W/CABLE ...... $99.00

Creighton Development, Inc.
4931 Birch St., Newport Beach, CA 92660 (714) 476-1973

Creighton Development, Inc.
4931 Birch, Newport Beach, California 92660

ProPrint is a registered trademark of Creighton Development, Inc.

*Registered trademarks of respective companies.

Visa/MasterCard accepted. Add 12.00 shipping/handling.

California Residents add 6 1/2% sales tax.

Creighton Development, Inc.
4931 Birch, Newport Beach, CA 92660

(714) 476-1973

Circle 64 on reader service card

138 September/October 1984
The Complete Macintosh System

The Printer Optimizer is a complete printing control-center for the Apple Macintosh, combining all the desirable printing related functions in a single easy-to-use unit. It provides connections for several printers, pushbutton and automatic switching between these printers, data translation to ensure printer compatibility (even to the point of letting you use any letter-quality printer with MacWrite), and most importantly, it's a print-buffer.

With available options, up to three printers can be connected, and they can be a mix of RS232 Serial and lower-cost Parallel types - of any brand and any model, including laser-printers, daisywheels, electronic type-writers, plotters and color printers. Total flexibility.

As a print-buffer, the Printer Optimizer is the best there is. Its capacity ranges from 64K to 256K - and that's vital with a computer that sends so much data to its printer. Without a Printer Optimizer you'll lose hours of productive time and endure long interruptions because your Macintosh is held back by the printer. It can pay for itself in time savings alone!

Combine this with our other features like "Mul i-copy", "Print Windows", "Random Access", "Job Control" and "Data Translation" capabilities; you can't buy a more useful and cost-effective tool for your Macintosh. And note that it will work with any other computer too! It's available now from dealers worldwide.

Applied Creative Technology, Inc.
2156 W. Northwest Hwy
MS 303
Dallas, TX 75220 USA
(800) 433-5373
(214) 556-2916
**NEW! Microline 92**

It was inevitable: someone had to come out with a new printer for the Macintosh. Okidata's Microline 92 is an exceptional choice for this distinction. It's fast (180 cps), rugged (24-hour duty cycle) and produces excellent 120 x 144 dots/inch graphics. Best of all, it works on the Mac right out of the box. No drivers, no patches, no hardware fix— even the cable's included. If you've been waiting too long for an imagerewriter, call us. Your printer has arrived.  

Microline 92 (Mac) ........... $ 579.88

---

**GAMES**

Frogger .................. $ 29.88  
InfoCom Games ............... CALL  
MacSlots ................  54.88  
Millionaire .................. 44.88  
Murder by the Dozen ........ 29.88  
Sargon III .................. 39.88  
Pensate .................. 29.88  
Transylvania ............... 29.88

---

**FINANCIAL**

Dollars & Sense ............... $ 114.88  
Home Accountant ........... 79.88  
Management Edge ........... 179.88  
MultiPlan .................. 139.88  
Sales Edge .................. 179.88

---

**LANGUAGES**

Microsoft BASIC ............... $ 109.88  
MacForth (Level I) ........... 119.88  
MacForth (Level II) ....... 189.88

---

**WORD PROCESSING**

Daisywheel Printer Driver .... $ 39.88  
Microsoft Word ............... 139.88  
Typing Tutor .................. 39.88  

---

**DATABASE MANAGERS**

Habadex DB ................ 139.88  
Habadex Adapter ............... 39.88  
Main Street Filer ............ 179.88  
MegaMerge .................. 89.88  
Microsoft File ............... 139.88  
Odesta Helix .................. 279.88  
PFS Report .................. 89.88

---

**GRAPHICS**

Click Art .................. 39.88  
McPic .................. 39.88  
Microsoft Chart ............... 89.88

---

**HARDWARE**

BASF 3½" Diskettes (5 pkg) .... 24.88  
FieldPro Carrying Case ....... 79.88  
Kensington Starter Pak: Includes Swivel Stand, Surge Protector and anti­static Dust Cover ........... 69.88

---

**HIGH TECHNOLOGY AT AFFORDABLE PRICES**

**THE BOTTOM LINE**

MILFORD, NH 03055-0423 ☎ TELEPHONE (603) 881-9855

---

**MacGAS™**

The First Glossary And Spellchecker for the Macintosh. (includes Antonyms & Synonyms) Easy to use, whether you are a novice or an expert. MacGAS™ has the answer when you're searching for just the right word. Check documents with a click!! For use with MacWrite and other word-processors.  

To ensure early delivery ... order NOW!! Available/late fall '84

---

**MacGAS™**

Fuel For Thought...

---

**DEALER INQUIRES WELCOME**

303-699-0441 SourceMail STX383

---

Circle 71 on reader service card

---

Circle 33 on reader service card

---

September/October 1984
**The Scottie MacCase**

- **Holds**: Macintosh*, keyboard, mouse, disk drive, power cords, manuals and paperwork.
- **HIGHEST PROTECTION**: insulated with 6" of dense dye-cut foam nested inside a plastic corrugated shell (for shock absorption) making the case a hard case.
- **COMFORT**: a soft leather hand-grip and adjustable shoulder strap. Lightweight, rugged protection.

**THE ALTERNATIVE ANSWER TO MINIMUM PROTECTION**

Available at quality computer stores including:
- ACP: San Jose, CA — BEACON'S MICRO CENTER
- Mason, Ames, Des Moines — COMPUTER STORE OF OAKLAND
- Oakland, CA — COMPUTER PLUS
- Sunnyvale, CA — LOGIC TREE COMPUTERS
- Whittier, Anaheim, Los Alamitos, CA — MSC COMPUTERS
- Store of Oak
- Ames, Des Moines — COMPUTER STORE
- Salt Lake City, Sandy, Overm — ON LINE COMPUTERS
- In CA: Fresno, Modesto — QUANTUM COMPUTERS
- Tacoma, WA — WABASH COMPUTERS
- Phoenix, AZ — In CA: Oceanside, El Toro, San Diego, LA.

FOR THE DEALER NEAREST YOU, CALL (408) 971-8711

THE CASEMAKER  ■ 1757-BJunction Avenue, San Jose, CA 95112
 ■ In CA Toll Free (800) 287-824 X-415
 ■ Toll Free (800) 287-825 X-113

---

**YOU CAN NOW USE A LETTER QUALITY PRINTER WITH YOUR MACINTOSH**

- **ProPrint** is a printer driver program that will output text directly to your letter quality printer.
- Compatible with your favorite Mac word processor; uses pull-down menus.
- Prepare professional letters, reports and documents that look like this

  Dear Mr. Smith; We would like to welcome you to rather than this
  Dear Mr. Smith, We would like to welcome you to

- **ProPrint** supports all popular serial letter quality printers
  - ABATI
  - BROTHER
  - COMREX
  - DIABLO
  - DAI SYWRITER
  - DYNAX
  - NEC
  - SILVERREED
  - STAR
  - SMITH CORONA

  * Fully Warranted
  * Available with or without Cable
  * Complete Instruction Manual
  * Available for Immediate Shipment
  * Order Direct Today or See Your Local Dealer

**ProPrint** ....... **$74.00**

**ProPrint** w/CABLE ....... **$99.00**

Creighton Development, Inc.
4931 Birch St., Newport Beach, CA 92660
(714) 476-1973

Creighton Development, Inc.
4931 Birch, Newport Beach, California 92660

Circle 64 on reader service card
IEEE 488 Bus Control for Macintosh

IO tech’s MAC 488™ Bus Controller is designed especially for the Macintosh. It gives you full IEEE 488 Bus implementation with 31 commands. MAC 488 connects to the serial port on the Macintosh, and can share that port with a printer.

Designed to be easy to use, MAC 488 accepts simple high-level commands, and comes with programming aids to get your system up fast.

- Full 1 year warranty
- Macintosh ↔ MAC 488 cable provided
- Auxiliary port for printer
- Immediate delivery
- $595.00

*Trademark of Apple Computer, Inc.

Circle 73 on reader service card

ICONEPTS
The Macintosh User’s Monthly Newsletter

The first and only owner’s/user’s newsletter devoted exclusively to the Mac and its support software/hardware: product reviews, articles, applications, features, news, ideas, tips, and followup. No waiting, it’s available NOW.

INTRODUCTORY SUBSCRIPTION SPECIAL

Please send me 12 issues of ICONEPTS at the special introductory rate of $18.00 per year; my check is enclosed.

Name ____________________________
Address __________________________
City ______ State ______ Zip ______

Mail to ICONEPTS, 916 Bradley Drive, P.O. Box 1936, Athens, Texas 75751 214/677-2793

Circle 35 on reader service card

INTRODUCING
The EMPRESS

MAINFRAME DECISION SUPPORT SOFTWARE FOR THE MICROCOMPUTER

- English Language Front End
- Mainframe Computing Capability
- Command/Menu Driven

The Empress Database Management System is available for the Lisa 2, the 512K MAC, and other Motorola 68000 based machines

EMPRESS TECHNOLOGY INCORPORATED
510 KING STREET
LITTLETON, MASSACHUSETTS 01460
617/486-9601

Circle 48 on reader service card
Micro Flash Computer Systems is waiting (along with the rest of the world) for new software and peripherals being developed for the Mac. To keep you informed, we're keeping track of what products are coming in—and when. And it looks like it will be well worth the wait!

For product information, price quotes, technical support and California orders, please call 415/680-1157. To order from outside California, call 800/458-2433.

COMPUTER SYSTEMS, INC.
1110 Burnell Avenue, Suites J & K
Concord, CA 94520

Circle 3 on reader service card

Unleash the extraordinary graphic capabilities of your Macintosh® with MacGraphics™

It's easy to create attractive, interesting and unique invitations, greeting cards, stationery or even your own electronic masterpiece with MacGraphics! Our extensive library of more than 300 exciting and professional spot illustrations, covering a wide range of topics, are just waiting to be cut and pasted into your MacWrite™ and MacPaint™ Documents

Only $24.95
plus $2.00 shipping/handling
Checks, Visa, and MasterCard accepted
For Macintosh with MacWrite/MacPaint
One Disk, including Instructions and Examples

DNA, Inc.
(713) 778-9270
9207 McAfee Drive • Houston, TX 77031

Circle 52 on reader service card

Macintosh™ 3 1/2" Diskette Duplication

• Complete Duplication Capability
• Software Protection Available
• 100% Quality Control

REPLITEK’s™ complete duplication service includes: protection, serialization, packaging, and kit assembly. Other supported formats, for systems using 3.5" media, are also available. Additional formats available upon request.
All 5.25" formats are available at competitive prices. Call today for further information.

Macintosh is a registered trademark of Apple Computer, Inc.

Replico Technologies Corporation
834 Charcot Avenue
San Jose, California 95131
408/945-1697

Circle 39 on reader service card

Club Mac
The national Macintosh user group.

$35 annual dues include... Member Startup Disk: MacAck communications software, goodies, certificate and more. Electronic Bulletin Board: share graphics, programs and fixes on powerful database. The Help Line: a real live person to answer your burning questions. The Club Mac News: new programs, products, reviews and Macintosh news every month.

Send your $35 annual membership fee (check, Visa or MasterCard) to:

Club Mac
735 Walnut, Boulder, CO 80302 303/449-5533

Name
Address
City, State, Zip
Phone
Visa/MC Number
Expiration Date

Club Mac 735 Walnut, Boulder, CO 80302 303/449-5533

Circle 53 on reader service card

Macworld 143
MACTYPE FROM PALANTIR. THE TYPING TUTOR THAT IS

FIRST
Palantir knows that if your Macintosh* is to be fruitful, you must first conquer the keyboard. And for many, that means learning how to type. So, Palantir created MacType. It's the first typing tutor for the Macintosh to put to use benefits of proven teaching techniques that speed up learning. Simply, MacType uses mental patterning to reinforce manual exercises. It teaches your fingers and your brain rather than your eyes, and you learn more quickly. If one of your first tasks on the Macintosh is to learn how to type, think of MacType first.

ADVANCED
Palantir designed MacType to be the most advanced typing tutor for the Macintosh that is available today. MacType takes full advantage of Macintosh's flexible screen displays and the simple functioning of its mouse to teach you how to type. All the know-how that has gone into the most complex Palantir Software was used in the development of MacType. You're getting state-of-the-art technology even in this basic program. It takes advanced skill to create a fundamental program that is both fun and mental for the user. And you get MacType's advanced features at a price that is very competitive.

SIMPLE
Palantir has also designed MacType so that it is amazingly simple to learn and use. Because of the teaching principles inherent in the program, you will get up to an effective typing speed in a very short time. You can also use the skills you learn on MacType to operate any typewriter keyboard, not just the Macintosh. Compared to the other typing tutors, MacType will actually let you enjoy learning. You may like it so much that even after you've mastered its touch-typing technique, you'll go back to the MacType exercises to sharpen your skills and increase speed. MacType shows that working smart can be working simple.

TESTED
Palantir thoroughly tested MacType to insure that it will work for you. With it you will learn to type fast. MacType should be your first choice. It is based on advanced programming technology and is still simple to learn. MacType is another quality, “No Bull” product from Palantir. If you want to learn more, contact

PALANTIR SOFTWARE
MACINTOSH IS A TRADEMARK LICENSED TO APPLE COMPUTER, INC. PALANTIR AND MACTYPE ARE TRADEMARKS OF PALANTIR, INC.

PALANTIR SOFTWARE · 7701 WILSHIRE PLACE · SUITE 110
HOUSTON, TEXAS 77040 · CALL TOLL FREE 1-800-368-3797
IN TEXAS CALL 713-939-1488

Circle 74 on reader service card
Apple’s new Macintosh™ is the most exciting development in personal computing since the original Apple started it all.

Teamed with Davong peripherals, the incredibly easy to use Macintosh becomes a powerful, flexible and expandable business tool.

Available at more than 1,000 Davong dealers nationwide is the new Davong Mac Disk system, providing from 5 to 32 megabytes of hard disk storage. Mac Disk gives you the increased capacity and enhanced functionality you need for your business applications. All at a very reasonable price and with no sacrifice in the speed and ease of use built into your Macintosh.

And coming very soon from Davong are a 28 megabyte streaming tape backup system, for fast and secure backup of your files, and a multi-tasking local area networking system to allow all of the Macintoshes in your organization to share information, programs, and the advantages of Mac Disk.

See your local Davong Dealer today for details.

Davong Systems, Inc.
217 Humboldt Court
Sunnyvale, CA 94089
(408) 734-4900
Telex: 176386

Apple and Macintosh are trademarks of Apple Computer Inc.
TECMAR SWEETENS APPLES

Tecmar supports the Macintosh with a full line of Candy™ Apple peripherals. See page 1 for further information.

*Trademark of Apple Computer, Inc.

TECMAR

Tecmar Inc.  6225 Cochran Road  Solon (Cleveland), Ohio 44139-3377  Phone: (216)349-0600  Telex:466692

Circle 14 on reader service card